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About This Manual
The TTWin User Guide is a comprehensive document designed to help you work easily and efficiently with 
Turbosoft's TTWin terminal emulation package.

Organization of this Manual

The TTWin User Guide is divided into four parts:

Part One - Basic Concepts
Chapter 1	 Introduction. A brief description of the TTWin product, system requirements and instal-

lation process.

Chapter 2	 Getting Started. How to connect your machine to a remote host and the basic steps 
required to work with TTWin.

Part Two - Advanced Operation
This section offers more detail on the menus and options that make up the TTWin package. It provides a 
detailed reference guide for these components.

Chapter 3	 File menu. The standard operations: opening and saving session definition files, print and 
print setup utilities.

Chapter 4	 Edit menu. Selecting, copying, clearing and pasting regions.

Chapter 5	 View menu. Operations related to the TTWin screen and interface.

Chapter 6	 Actions menu. All the operations carried out by TTWin: connecting, disconnecting cap-
tures and terminal control.

Chapter 7	 Scripts Menu. Running and Editing TTWin Basic scripts.

Chapter 8	 Help Menu. User help, licensing and related functions.

Part Three - Configuration
This section covers all features available under the Configure menu.

Chapter 9	 Global Preferences. Configuring program wide preferences.

Chapter 10	 Session Preferences. Configuring session related preferences.

Chapter 11	 Display. Setting up the TTWin window format and scroll history parameters.

Chapter 12	 Menus and Toolbars. Configuring and customizing TTWin's menus and toolbars.

Chapter 13	 Fonts. Configuring the display fonts.

Chapter 14	 Mouse. Defining the mouse operation.
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Chapter 15	 Printer. Specifying how the printer handles a print job.

Chapter 16	 Working with Macros. Macro format, host initiated macros, examples.

Chapter 17	 Communications. Setting up the type of communications (transport) module.

Chapter 18	 Emulations. Configuring your required emulation.

Chapter 19	 File Transfer. Using TTWin to transfer files to and from a host system.

Chapter 20	 Keyboard. Remapping the keyboard.

Chapter 21	 Colors. Creating and changing the color scheme.

Chapter 22	 Miscellaneous. Other TTWin configuration options.

Chapter 23	 Hotspots. Creating mouse driven terminal events.

Part Four - Appendices
Appendix A	 Glossary

Appendix B	 Customer Support

Appendix C	 Program Files and Paths

Appendix D	 Sample Scripts

Appendix E	 APIs and External Controls

How to use this Manual

The structure of this manual is based on the organization of the TTWin menus. For example, Chapter 3 File 
Menu, covers all the options on the File menu, with each option under a main heading. All the menus are doc-
umented in this manner in Part Two - Advanced Operation, with the exception of the Configure menu. 

The Configure menu is described in Part Three - Configuration. Each chapter in Part Three covers one 
section of the Configure menu.

The information provided in Parts Two and Part Three is closely linked to the options available under the 
TTWin menu. Chapter order mirrors that of the options available under each menu.

The first-time user of TTWin will probably find it necessary to read the complete section related to the opera-
tion that they are performing. Users who wish to get started quickly with the basics of TTWin may wish to 
refer to the TTWin 4 QuickStart guide. This PDF document is included with your TTWin installation and 
may be found in the TTWin 4 program group.

This manual assumes familiarity with the version of Windows you are using. The screenshots in this document 
are taken from Windows 11. If you have any suggestions regarding this guide, please contact Turbosoft. Refer 
to Appendix B for contact details.



Conventions

To assist you to read and understand this guide we have used a number of conventions:

Conventions	 TTWin 4 is Turbosoft's terminal emulation product for Windows®.

Windows® refers to Microsoft Windows, Windows 10®, Windows 11®, Windows Server 2025®, 
Windows Server 2022®, Windows Server 2019® and Windows Server 2016®.

Device refers to any hardware device capable of running Microsoft Windows®

Tile is TTWin’s term for a dialog box.

Lower case bold courier typeface indicates things you need to type, such as a:\setup.

Upper case courier typeface indicates a filename or directory name, such as C:\TTWIN4\
TTWIN4.EXE.

All keys are shown in upper case courier typeface and bracketed. For example, the Shift key 
is shown as [shift]; the Escape key is [esC].

Tips, warnings and other important pieces of information are displayed on a gray back-
ground with an icon as shown below.

Hints, tips and other important pieces of information are displayed like this.

A sequence of simultaneous keystrokes is indicated with an underscore. For example, 
[ALT_F8] is the sequence generated when the [ALT]key is held down while [F8] is 
pressed.

Bold typeface indicates menus, menu options, tile titles, tile options, tile fields and buttons. 
For example, click on the Colors... button on the Configure IBM 5250 tile then select 
Blink.

Where a step by step procedure is presented each action will be sequentially numbered 1, 
2, 3 and so on.

Where a configuration option is described it's default value is given in brackets. For exam-
ple: Horizontal scroll bar (Auto hide)

An underscore in a bolded word such as, File, refers to a menu item which can also be 
called using the short cut key sequence [alt_F]. This feature is not available on every 
option but a large number of relevant menu locations do offer a short cut key.

A multi- level menu option is displayed with an angle bracket between items, for example 
File > Exit indicates that the Exit option is available as a sub item of the File menu. 
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Online Resources

This manual is a dynamic document which is constantly evolving. While we do our best to ensure this manual 
contains the latest and most accurate information you may wish to use our online support center to find the 
latest tips and problem solving documentation. You can access support resources, installation downloads and 
other resources online at:

https://www.ttwin.com/support

http://www.ttwin.com/support


Chapter 1: Introduction

A brief overview of TTWin 4, system require-

ments and installation process.
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What is TTWin?
TTWin is Turbosoft's offering for superior Terminal Emulation software. Supporting over 80 terminal types 
and numerous communications protocols, it is a complete host connectivity solution.

Features Highlights

Single Product Terminal Coverage
TTWin includes Terminal Emulations for more terminals within one package. No need to switch products to 
get different emulations.

Reduce Keystrokes with Keyboard Macros
Single keystrokes can do complex tasks. TTWin allows you to map macros to keys (including alpha keys in 
various shift states). These macros will do the work for you. Reduced keystrokes means less time to do the job, 
and a more accurate result.

Scroll History
TTWin increases productivity in many ways. Its Scroll History allows you to review information that has rolled 
off the screen, and use cut and paste to move this into and out of other applications such as spreadsheets and 
word processors.

Multiple Sessions
TTWin allows you to run as many sessions as you need to the one host system or to many.  What's more each 
session can be configured independently to your requirements.

32 and 64 bit
TTWin 4 is available in 32 bit and 64 bit versions.

Data security
Security to be an essential part of a terminal session and as such, TTWin supports industry standard 
encryption.

Screen enhancing features 
Give your system a 'make-over' and extend it's life through the use of 'hot spots', scripting and toolbars.

OCX Interface
Utilize TTWin's OCX interface to make TTWin a part of an external application. Adding terminal emulation 
functionality to your application has never been simpler.

Powerful scripting language
TTWin offers a powerful built in scripting language based on Visual Basic for Applications, allowing the 
advanced user to perform complex processes on data. TTWin 4.8 introduced language updates and a new 
Integrated Development Environment (IDE) featuring syntax highlighting, auto complete and debugger.



System Requirements

TTWin supports the following operating systems

>> Windows 10
>> Windows 11
>> Windows Server 2016 
>> Windows Server 2019 
>> Windows Server 2022
>> Windows Server 2025

64 bit versions of TTWin are available from version 4.6 and onwards.

Hardware Requirements

>> Approximately 50MB of free disk space.
>> A network connection or serial port for COM type connections.

Installation

1	The TTWin installation package is available as a download from https://www.ttwin.com. Ensure you have 
the correct version for your operating system and environment as separate 32 bit and 64 bit installation 
packages are available. On your Windows PC, run the downloaded installation file.

2	The Software License Agreement is displayed. Please read the License Agreement and check the box at the 
bottom of the tile noting your acceptance of the agreement to continue the installation process.

3	You are prompted to select which user account(s) you wish to install TTWin for. Available choices are 
installation for every user on the computer or just for the current account. 

4	You are prompted for a destination folder. This is where TTWin will be installed. To change the 
destination folder, click on the Browse... button. By default TTWin is installed in C:\Program Files\
Turbosoft\TTWin4

5	Select or create a start menu folder for TTWin.

6	Accept the Setup Complete tile by clicking on the Finish button. Optionally, the program may be 
launched on exiting the installer. The new program group will be visible and a TTWin icon can be seen 
within the folder. 

7	You are now ready to begin working with TTWin.

Evaluation Mode

An unlicensed version of TTWin defaults to an evaluation mode. The evaluation license is restricted to 30 days 
of usage. If you find this time limit inadequate for your evaluation purposes please contact your reseller or 
Turbosoft directly.

TTWin can be easily converted into a licensed, unrestricted version without the need for re-installation simply 
by importing the appropriate license certificate. 

https://www.ttwin.com
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When initially launched TTWin attempts to connect to a host automatically using its default configuration. If 
you have not yet applied a license to TTWin you will see the Evaluation Notice tile shown (Figure 1.1) each 
time a connection attempt is made. If you do not want to connect at this point click Cancel. This will allow 
you the opportunity to modify or load another configuration or to apply a license.  

Figure 1.1. TTWin Evaluation Notice Tile

Licensing TTWin

When you purchase TTWin a license certificate file (.TCF) will be issued. Enabling your copy of TTWin 
is a two step process involving firstly the import of that certificate file into the program, and secondly, the 
activation of that certificate by Turbosoft.

To import the license certificate follow these steps:

1	Start the program and select Help > About... from the main menu.

2	Select the License Tab

3	Click the Import certificate... button and select the certificate file from your local hard drive.

You will see a message box stating “The license has been updated. This license needs to be activated”. Each time 
you  start TTWin you will be informed that you need to activate the software. You have 7 days to complete this 

activation.

Activating the License
License activation stamps your license certificate with a unique identifier and completes the licensing process.

There are two activation methods, online (the default) or manual activation.

Online Activation 
For this option to work TTWin needs to be able to connect to the Internet.

When prompted to activate TTWin select the Activate online option then click the Activate button.

TTWin will then connect to the Turbosoft Activation Server and automatically import a new certificate unique 
to the PC you are installing on. Your software is now activated.



If you receive a connection error please wait a moment and try again. If you 
continue to receive this message check if firewall or proxy server settings 
are preventing TTWin accessing the Activation servers. In this situation we 
recommend manual activation.

Manual Activation
If TTWin is unable to connect to the internet from the PC it is installed on you may activate your software using 
the manual activation process:

1	Select the Save the request to a file option and click the Activate button.

2	Save the resulting TTACT.XML file

3	Copy this file to a PC that has internet access.

4	Open a browser to https://mercury.ttwin.com/request

5	Fill out the activation form selecting the TTACT.XML from your local PC.

6	Optionally, enter an email address where you would like the newly activated certificate to be sent.

7	Select the Retrieve Certificate File button.

You will then be presented with a link to download a new certificate file and, if you chose to enter an email address, 
the file will also be sent to you via email. Transfer this file to the PC containing your TTWin installation and do the 
following:

1	Start TTWin and select Help > About... 

2	Select the License tab, click the Import certificate button and load your new certificate file.

3	Restart TTWin.

Uninstalling TTWin 

To uninstall TTWin you should follow the standard software uninstallation process for your operating system. 
Typically this operation is performed by selecting Start menu > Control panel > Uninstall software.

TTWin retains any extra setting files you may have copied or created whilst using the software including the 
following file types:

>> Session files (.TWC)
>> Color files (.CLR)
>> Keyboard mapping files (.KEY)
>> History Files (.THF)
>> TTWin Basic Scripts (.TSL, .BAS) Scripts created as private scripts are retained. Public scripts are not.
>> License Files (.TCF)

Refer to Appendix C for information on program file paths and the location of these files.

https://mercury.ttwin.com/request
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Command Line Installation Options

/S  
Turns on the Silent Install feature. TTWin will perform the installation process without prompting the user.

/LicenseFile <Path to LicenseFile>
Specify a .tcf license file which TTWin will copy to the Global directory. If only a file name is given the 
install package will look in the same directory as it is run from. You can also include a full or relative path to 
the install executable directory.

For more information on program file paths refer to Appendix C.

/SilentActivation
Turns on the Silent Activation feature. If the license file specified with the /LicenseFile option requires 
activation TTWin will automatically connect to Turbosoft's license server and activate the license without 
prompting the user. The feature requires internet access.

/Language <Language>
The /Language option allows a specific language version of TTWin to be installed. If this option is not 
specified TTWin defaults to an English (US) install. The following languages are supported.

>> en-us - English (US)
>> en-uk - English (UK
>> fr - French
>> es - Spanish

/ConfigPath <Path to your Config files>
Sets a path for the install package to search for configuration files specified by the /ConfigFiles command 
line option. If not set the directory that the install executable was run from is used. A full or relative path from 
the executable directory can be specified.

/ConfigFiles <FileName> <FileName>
This option copies the listed files to the Global directory. You may list as many space separated names as 
needed. Wild cards are supported eg. *.* will copy all files from the ConfigPath option. You may also 
specify a full path to a file can also be used if a file is not in the ConfigPath. Use quotes if the path has 
spaces 

/NoDesktopShortcut
This option will instruct the installer NOT to create a desktop shortcut to the newly installed TTWin.

/ScriptPath <Path to your Script files>
Sets a path for the install package to search for script files specified by the /ScriptFiles command line 
option. If not set the directory that the install executable was run from is used. A full or relative path from the 
executable directory can be specified.

/ScriptFiles <FileName> <FileName>
This option copies listed files to the Global Scripts directory, you can specify as many space separated names as 
needed. Wild cards are supported eg. *.* will copy all files from the ScriptPath. A full path to a file can also 
be used if a file is not in the ScriptPath. Use quotes if the path has spaces 



Command Line Example
The following command line will install a French language version of  TTWin silently, import the specified 
license certificate and activate it silently. It will also copy two session files (one replacing the default.twc) 
from the mycfgs directory.

TTWin4-32Bit-4.7.0.1942.exe /S /LicenseFile mylicense.tcf /Language fr »		
/SilentActivation /ConfigPath mycfgs /ConfigFiles default.twc my.twc

If you wish to specify a custom .twc file you will need to install TTWin on a test machine and configure with 
the settings required for your standard deployment. You will then need to ensure that the .twc file is saved to 
retain these settings. Refer to Chapter 2 for more information on configuration and saving your settings.

Installing for Multiple User Environments

When using TTWin in multiple user environment such as Citrix, Terminal Server or a single PC with several 
users, there are a few things that can be done to streamline the setup process.

TTWin has a global directory where you can place configuration and licence files. When a user starts TTWin 
for the first time their user profile is populated with files from this global directory.

By placing an activated licence file in the global directory users will not be required to activate TTWin 
individually. 

Please use the following steps as a guide to setting up TTWin.

1	As Administrator install and licence TTWin, for more information please refer to the Licensing TTWin 
section earlier in this chapter.

2	Configure TTWin as required for your standard users. 

3	When you are happy with the setup, save the configuration changes and close TTWin. Refer to Chapter 2 
for more information on TTWin configuration and saving your settings.

4	Copy the following files to the global directory located at %ALLUSERSPROFILE%\Turbosoft\TTWin4

Copy the file default.twc located in %APPDATA%\Turbosoft\TTWin4

Copy any other configuration files created including additional twc files and files such as Key Mappings or 
Color Schemes. For more information on additional TTWin file types refer to Appendix C - TTWin 4 File 
Types and Paths.

Finally, while logged in as the user that licensed TTWin, copy the file ttwin.tcf from the following 

directory: %LOCALAPPDATA%\Turbosoft\TTWin4

Please note that the resolved paths will differ depending on your operating system 
version. For more information refer to Appendix C - TTWin 4 File Types and Paths 
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Chapter 2: Getting Started

How to connect your machine to a remote host 

and the basic steps required for getting started 

with TTWin.
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Getting Started
TTWin uses TTWin Configuration (.TWC) files to specify users preferences and settings. When first run 
TTWin loads a number of default settings from its DEFAULT.TWC configuration file. The default emulation is 
set to DEC VT Series (VT220) and communications are set to Telnet. Additionally, the DEFAULT.TWC is set 
to autoconnect meaning that upon loading TTWin will present a Telnet Connect tile and prompt for host 
details before attempting to initiate a VT220 session. Unless VT220 and Telnet are your required settings it is 
suggested that you select Cancel to dismiss the prompt and configure TTWin to suit your requirements. 

Note than an unlicensed copy of TTWin will default to an evaluation mode and, prior to attempting to con-
nect, the program will display a tile notifying you of the number of remaining days usage available under the 
evaluation license. For more information on the limitations of the evaluation license please see Chapter 1.

Figure 2.1 Evaluation Notice Tile.

Quick Configuration

Please refer to Part Three of this document for more in depth detail on how to 
configure TTWin.

Before initiating a connection there are a few pieces of information you need in order to complete a successful 
connection to a host system. 

Firstly, you need to know what sort of terminal you wish to emulate. TTWin supports numerous emulations 
and you will need to know which one to choose in order to successfully interact with your host applications. 

Next, you need to know how you are going to communicate with the host system. You will need to know what 
method of communications your host is expecting, as well as your host address and any related settings that 
you require. 

This information, along with any other settings that you require, should be available from your System 
Administrator. 



Access to different configuration options is available via the Configure menu.

Figure 2.2 Program Configure Menu 

To select and modify the emulation settings of TTWin open Configure > Emulation from the main menu. 
This will display a tile similar to that shown in Figure 2.3.  By default TTWin is configured to use a VT220 
emulation. 

Figure 2.3 Configure Tile (showing the DEC VT Series emulation.) 

Figure 2.3 consists of a tree list of configurable emulation options together with an edit box through which 
the currently highlighted item may be modified.
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To switch to a different emulation select the Change Terminal button  in Figure 2.3. This will display the 
Module Selection tile (Figure 2.4) from which a different emulation may be selected.

 

Figure 2.4 The Module Selection tile displays a list of available emulations.

Upon selecting a different emulation TTWin will load this emulation and return to the Configure tile with 
the configurable options for the new emulation. 

The communications module may be modified in a similar manner to the emulation by selecting Configure 
> Comms from the main menu. 

Figure 2.5 The configure comms tile (telnet).



Saving Your Settings

Once emulation and communication settings are selected, be sure to save the configuration file for future 
use. Select File > Save configuration (default.twc) to overwrite the current configuration (this will be the 
DEFAULT.TWC file initially) or File > Save configuration as to retain your settings in a new .TWC file.

If you select File > Save configuration as, you will be prompted for a file name, and once this has been 
entered, you can save the configuration file. By default the configuration file will be given a .TWC file exten-
sion and stored in the Turbosoft\TTWin 4 directory in your user profile (see Appendix C for more detail 
on program file paths).

Specifying a Predefined Session at Startup

By default TTWin opens the session configuration found in DEFAULT.TWC. To load TTWin with an alternate 
single predefined configuration, create a shortcut to TTWin and add a command line option pointing to your 
chosen twc file. For example:

1	Right click on your Windows desktop and select New > Create shortcut 

2	Locate TTWin, typically the output will be similar to this example: "C:\Program Files\
Turbosoft\TTWin 4\ttwin4.exe"

3	Append the name of your twc after the command line. If your twc file is NOT located in the default user 
directory (see Appendix C) you will need to provide an absolute path. Your shortcut line will be something 
like this "C:\Program Files\Turbosoft\TTWin 4\ttwin4.exe" my5250.twc

Alternately, to launch TTWin with one or more predefined sessions opened use the File > Save as Startup 
menu option to save your TTWin session layout and automatically create a desktop shortcut which will launch 
TTWin with these sessions open. Follow these steps.

1	Run TTWin as normal and open as few or as many sessions to various hosts systems as required. Each ses-
sion must have its own saved configuration (TWC) file.

2	Select File > Save as Startup and save a .TTSTARTUP configuration file. A desktop shortcut will also be 
created using the same name as given to the .TTSTARTUP configuration file. 

This desktop shortcut will launch TTWin and all sessions specified in step 1 will automatically be opened 
when the program is started.

Other command line parameters

TTWin supports several command line parameters:

>> <session_file>			   Optional TWC file 
>> -i <Path to ini file>   		  Specify the INI file
>> -l <Path to layout.ini>		 Force TTWin to use specified layout INI file
>> -f					     Start in full-screen mode
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Connecting

To initiate a connection, choose the Action > Connect menu function. 

Figure 2.6 Initiate a connection. 

If you are running an evaluation version of TTWin you will, at this point, see a tile informing you of the 
limitations and remaining time limits associated with this license. To continue with the connection accept the 
notice by clicking OK. TTWin will now attempt to connect to the host or, where applicable, prompt you for 
more details before connecting.

Disconnecting

A TTWin session may be disconnected from the host computer in a number of different ways, usually as a 
result of the user logging out from the host computer. 

To manually disconnect, you may select the Action > Disconnect function from the TTWin menu as shown 
in Figure 2.7.

Figure 2.7 Disconnecting. 



Chapter 3: File Menu

The standard operations: opening and saving 

session definition files, print and print setup.
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File Menu
The File menu contains commands associated with loading and saving configuration files and printer operations.

Figure 3.1 TTWin File Menu

New session

Selecting this option will open a new session using the DEFAULT.TWC. Pressing [CTRL+TAB] will cycle 
through open session windows when multiple session are running.

New session...

Selecting the New session... menu option activates the Choose a configuration file tile. From this tile you 
can choose one of the available predefined sessions to be loaded for this new session.

File name
Enter the name of the predefined session file that you want to use. The default extension is .TWC, TTWins 
custom format for session configuration data. Available predefined session files, from the current directory, are 
displayed in the files box.

Look in
This box displays the current directory from which the file will be loaded. This may be changed through the 
Look in: box down arrow, which shows a list of drives and directories. By selecting entries from here, the 
drive and directory from which the predefined session will be loaded may be changed.



Files box
This box displays the files that match the file extension specified in the Files of type: box. To load the required 
predefined session from this list either enter the file name in-full in the File name: field then select the Open 
button or double click on the filename in the list.

After opening a predefined session (e.g. SAMPLE1.TWC) all session parameters are reprogrammed to the set-
tings defined in the newly loaded session.

Open configuration…  

Selecting the Open configuration... menu option will activate the Open a configuration file tile. From this 
tile you can choose one of the available predefined sessions to be loaded. A predefined session is a file contain-
ing TTWin configuration settings created with the Save configuration as... option.

File name
Enter the name of the predefined session file that you want to use. The default extension is .TWC, TTWins 
custom format for session configuration data. Available predefined session files from the current directory are 
displayed in the files box.

Look in
This box displays the current directory from which the file will be loaded. This may be changed through the 
Look in: box down arrow, shows a list of drives and directories. By selecting entries from here, the drive and 
directory from which the predefined session will be loaded may be changed.

Files box
This box displays the files that match the file name entered in the File name: box. To load the required pre-
defined session from this list either enter the file name in-full in the File name: field then select OK or dou-
ble click on the filename in the list.

After opening a predefined session (e.g. SAMPLE1.TWC) all session parameters are reprogrammed to the set-
tings defined in the newly loaded session.

Save configuration (default.twc)

Selecting the Save configuration (default.twc) option saves all the configuration settings of the current pre-
defined session to the .TWC file specified within the brackets.

Save configuration as… 

Selecting the Save configuration as... option will activate the Save configuration as... tile. Use this option 
to save the current session settings to a new session file.

File name
Enter the name of the file to which you wish to have all TTWin configurable settings saved into.
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Save in
This box displays the directory to which the file will be saved. This may be changed through the Save in: box 
down arrow, which shows a list of drives and directories. By selecting entries from here, the drive and directory 
to which the predefined session will be saved may be changed.

When the required file name has been specified, click the Save button.

Save as Startup

The Save as Startup menu option saves a configuration file which records the current session(s) a user has 
open and creates a desktop shortcut which can be used to launch TTWin and reopen these same sessions. Note 
that each session must have it's own saved configuration file (TWC file).

Selecting this option opens a Save startup file... dialog with options to save a .TTSTARTUP file to a local or 
network location. On saving this file, a desktop shortcut file will also be created using the name the 
.TTSTARTUP file was given. Opening this shortcut will launch an instance of TTWin which automatically 
opens the related sessions. 

Figure 3.2 The Save as Startup menu option is used to create a desktop shortcut which can launch TTWin with 
specified sessions opened.

Close Session

Selecting this menu option will close the current active session.



Print… 

Selecting the Print... menu option activates the Print Screen tile. The Current Printer is displayed at the 
top of the Print Screen tile.

Text to print
>> Entire screen (default): The entire contents of the current screen are sent to the defined printer.
>> Selected text only: This option is only available when a region of the screen has been selected. 

You can select text by left clicking and dragging the mouse across a region. The selected area will be visible by a 
shaded background.

Close print run

Selecting the Close print run option closes any active print run.

This is used when 'print through' is employed in an emulation. The Close print run command sends any out-
standing, buffered data to your printer and then closes down the print job. 

Unless Configure > General > Printer > Keep print job open (on) is used, this option is grayed out. 
See Chapter 15 for more detail on this setting.

Print setup… 

Selecting the Print setup... command activates the Printer Setup tile. This directly interfaces with the 
Windows print setup and allows you to specify and configure your preferred printer.

Print to File (off)
Select this option to direct all print jobs to a file output. This option is also configurable by selecting 
Configure > General > Printer. 

Print output to ()
When Print to File is set to on, this setting defines the name and location of the file output.

Exit TTWin4 

Selecting the Exit option closes the TTWin program.

Once you have completed your work on the remote host, it is good practice to 
log out FIRST or close down the connection to the remote host before exiting the 
TTWin program.
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Figure 3.3. Print Setup Tile



Chapter 4: Edit Menu

Selecting, copying, clearing & pasting regions.
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Edit Menu
The Edit menu covers commands dealing with the manipulation of terminal content.

Figure 4.1 Edit Menu

Copy

The Copy command will copy a selected region to the Windows clipboard for later use by the Paste com-
mand. The region to be copied is selected by dragging the mouse while either the left or right mouse button is 
held down.

Cut

When using IBM block mode terminals, this option allows text to be cut from unprotected fields directly to 
the clipboard. 

Copy append

The Copy append command performs the same operation as Copy but appends the selected text to text 
already stored in the clipboard.

Cut append

The Cut append command performs the same operation as Cut but appends the selected text to text already 
stored in the clipboard.



Copy to file…

Selecting the Copy to file... command activates the Copy selected text to a file tile.

File name
Enter the name of the file to which you wish to have the selected text saved into, the default is SCREEN.TXT. 

Save in
This box displays the directory to which the file will be saved. This may be changed through the Save in: box 
down arrow which shows a list of drives and directories. By selecting entries from here, the drive and directory 
to which the file will be saved may be changed.

When the required file name has been specified, click the Save button.

Paste

The Paste command will insert, at the current position of the cursor, the contents of the Windows clipboard. 
Alternately, when using an IBM 3270 terminal, the Paste command will insert into the selected area.

Paste next

Paste next is a menu option for use with an IBM 3270 emulation. It's used to paste data from the Windows 
clipboard that is greater in size then the available space in an IBM3270 field.

Use the Paste menu option to paste data into a field as normal - once the field is full TTWin will stop. The 
Paste next may then be used to continue pasting the remaining clipboard data in another field. 

You can continue using Paste next until the clipboard buffer is empty. Using Paste will reset the Paste next 
buffer.

Configuring Paste Next

Paste next is a specialized menu command relevant to a single emulation. By default it is not enabled in the 
program menu. To enable follow these steps:

1	With an IBM3270 emulation selected, open the configuration options for Configure > Emulation > 
Clipboard > Paste.

2	Turn on Enable Advanced Pasting.

3	Ensure that both Wrap Text to next field and Wrap to field below are set to Off.

4	Click OK.

5	Also ensure that Configure > General > Clipboard > Marking/Copy > Enable internal copy for-
mat is set to Off.
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To create a main menu item for Paste next follow these steps:

1	Select Configure > Menus & toolbars...

2	Select the menu or toolbar you want to edit. Select Main menu to add to the program menu.

3	Select the location you would like to add the new item and click Insert. You may wish to expand the exist-
ing Edit menu, select the existing Paste item and click Insert after.

4	Set the Item type to Menu action.

5	Set the action to EditPasteNext.

6	Click OK.

For more information on editing or creating custom toolbars and menus in TTWin 
refer to Chapter 12. Menus and Toolbars.

Select display

The Select display command will select the full contents of the currently displayed TTWin session window.

Select all

The Select all command will select the contents of the current TTWin session window and the entire scroll 
history buffer.

Clear display

To clear the contents of the current display region, use the Clear display command. After the display area is 
cleared the cursor is positioned at the top left corner of the screen.

Clear all

To clear the entire contents of the current scroll history buffer along with the current display region, use the 
Clear all command.

After the display is cleared the cursor is positioned at the top left corner of the screen.

Clear history

To clear the contents of the scroll history buffer only, use the Clear history command.



Find...

Selecting the Find... command activates the Find Text tile, as shown in Figure 4.2.

Entering text in the Text to find: box and selecting the various options including case of the text string, direc-
tion for the search and the area to be searched, once you have selected from the available options pressing the 
Find button will execute the search.

Find next		

The Find next command will continue the search for the next occurrence of the string as entered in the cur-
rent Text to find box in the Find Text tile.

Figure 4.2. Find Text options.
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Chapter 5: View Menu

Operations related to the TTWin screen and 

interface.
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View Menu
The View menu controls aspects of the program appearance.

Figure 5.1. View Menu

Toolbar (on): 

Controls the display of the program Toolbar. Uncheck if you do not wish to display the Toolbar

Status bar (on): 

Controls the display of the program Status bar, displayed at the bottom of the program window. Uncheck if 
you do not wish to display the Status Bar.



Session panel (on): 

The Session panel displays small graphic versions of each currently open session allowing you to easily switch 
between active sessions. By default the panel is docked to the left-hand side of the program window however 
by clicking the panel title it can be dragged, repositioned and resized as required.

Figure 5.2 Session Panel highlighted. 

Page tabs (on): 

Controls the display of the Page tabs as shown in Figure 5.3. Uncheck if you do not wish to display the session 
Page tabs. Pressing [CTRL+TAB] will cycle through the available tabs when multiple session are running.

Figure 5.3 Page Tabs highlighted.
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Full screen: 

Select Full screen to enable full screen mode, this will expand TTWin's terminal display area to entirely fill 
you device screen. Once you have selected Full Screen this becomes the default mode. 

To deselect full screen mode right click your mouse on the screen to display a pop up menu and uncheck the 
Full screen option.



Chapter 6: Actions Menu

All the operations carried out by TTWin: 

connecting, disconnecting, captures and termi-

nal control.
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Actions Menu
The Actions menu controls terminal activity such as connecting to and disconnecting from a host system.

Figure 6.1 Actions Menu

Connect

Selecting the Connect menu item will initiate an attempt to connect to a host (either a tile requesting host 
details will appear or the host detail specified in your session configuration will be used). If a connection is suc-
cessful, the Connect menu item toggles to read Disconnect.

Ensuring Clean Disconnections
To prevent a user from closing the TTWin program or the active session without first logging off from the host 
set the following parameter in the session configuration file (.TWC)

AllowDisconnect=0

This will not allow the program or session to be closed whilst a host connection remains active. Note that this 
feature requires the host to support a disconnection as opposed to, for example, simply re-displaying a login 
prompt, and failure to do so may prevent the user from closing the TTWin program or session. For this reason 
AllowDisconnect is not a standard user configuration option and is only configurable by directly editing a 
TWC file.

For more detail on file locations such as .TWC files, refer to Appendix C - Program 
File Paths



File transfer...

Before issuing a request for a file transfer, ensure that the appropriate file transfer module is loaded and con-
figured for your system. To change or configure the current file transfer module, you must use the File trans-
fer... menu option found under the Configure menu. Refer to Chapter 19 for details on the selecting and 
configuration file transfer options.

Selecting the File transfer... menu item activates the File Transfer tile shown in figure 6.2. The File 
Transfer tile for the currently selected file transfer protocol is displayed.

Several file transfer modules, such as XModem/YModem and Zmodem require 
a connection to the host system to already be established through Actions > 
Connect before any file transfer can be initiated. When these modules are select-
ed, should a host connection not be previously established the File transfer..., 
Send a File... and Receive a File... menu options will be unavailable. 

 

Figure 6.2 The File Transfer tile

The display of the File Transfer window will vary depending on the capabilities of the selected protocol.
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Send and Receive Files
To send one or more local files to the remote host, select the file(s) from the Local window and click the 
Send button on the window tool bar. To change the destination filename you may edit the file name shown in 
the text box on the Local window.

To receive one or more file to the local device, select the file(s) from the Remote window and click the 
Receive button on the window tool bar. To change the destination filename you may edit the file name shown 
in the text box on the Remote window.

Creating, Deleting Files and Directories
To create and delete directories select the window of either the Remote or Local systems and click the Make 
Dir. button on the window tool bar. TTWin will prompt you for the new directory name. 

To delete a local or remote file(s) select one or more file and click the delete button on the window tool bar. 
TTWin will prompt you to confirm the deletion. 

These options are dependent on appropriate file permissions on the target system. 

Connecting and Disconnecting
If login details have been entered in the file transfer configuration (see Chapter 19) then a connection attempt 
is automatically made on opening the File Transfer window. If no details were entered the Remote window 
will contain fields for entry of login details. Once these details are filled select the Connect button on the win-
dow tool bar to initialize a remote host connection. This will replace the content of the Remote window with 
a default directory listing on the remote host.

Once connected the Connect button will toggle to read Disconnect. 

Send a file...

Selecting the Send a file... menu item activates the Send a File tile. 

Local file
Enter the name and path of the file to be sent. Select the ... button at the end of the input field to browse to the 
desired file.

Remote File
Enter the destination path and filename for the file to be saved to on the remote host. 

When the required file name has been specified, click the OK button to initiate the transfer. When using FTP/
SFTP TTWin will prompt for a username and password. 

Receive a file... 

Selecting the Receive a file... menu item activates the Receive a File tile. 

Local file
Enter the name and path of the file to be saved. Select the ... button at the end of the input field to browse to 
the desired location.



Remote File
Enter the destination path and filename for the file to be retrieved from the remote host. 

When the required file name has been specified, click the OK button to initiate the transfer. When using FTP/
SFTP TTWin will prompt for a username and password. 

Capture…

Selecting the Capture... menu item activates the Capture tile. Capturing is the process where data received 
from your remote host is sent to a nominated file or to the Windows clipboard. 

Capture configuration options are detailed in Chapter 22 - Misc. Configuration.

Capture mode
>> Diagnostic (default): The entire data stream is written to the specified file along with configuration infor-
mation. This is for use by Turbosoft support. 

>> Visual: Only ASCII printable characters are written to the specified capture file or the Windows clipboard.
>> Raw: The entire data stream from the host is written to the specified capture file or the Windows clipboard.

Capture to 
>> File (default): Specify the name of the file to which TTWin will capture PC-host connectivity data. The 
default filename is TTWIN.CAP. Pressing the ... button opens the Start TTWin Capture tile which allows 
you to select the location to which the file will be saved

>> Clipboard: The entire data stream from the host is written to the specified capture file or to the Windows 
clipboard.

The capture file is buffered and is not immediately written to disk. Attempting to 
capture a problem which causes your PC to hang or reboot may not be successful.

File Mode 
>> Append: Appends the capture details to the end of the file named in the Filename box. If the file name 
given does not exist, a warning message will be displayed, and a new capture file will be created. 

>> Compressed (default): Creates a compressed file, effectively a Zip file, ensuring the integrity of the data. 
The default state of this item is determined by the Capture configuration options described in Chapter 22.

Upon selecting OK to start the capture the Capture... menu option toggles to Stop Capture... To close the 
capture file select the Stop Capture... option.



49TTWin 4 User Guide : Chapter 6 - Actions Menu

Figure 6.3 The Capture tile

Break

Selecting Break sends a break signal to the remote host. A break is a time delay signal transmitted to the 
remote host used to interrupt the remote computer, overriding any other task it may be executing.

The Break duration can be varied by opening Configure > Comms... and selecting Serial Comms (see 
Chapter 17 - Communications for more detail). The default setting for a Break signal is 100 milliseconds.

Unlock flow control

Selecting Unlock flow control unlocks flow control between your PC and the remote host. Occasionally 
your PC and the remote host can lose synchronization of their flow control status. This stops the screen from 
updating. Unlock flow control overcomes this problem.

Flow control problem can be the result of incorrect settings of the XON/XOFF parameters, if unlocking does 
not resolve the problem, you should examine these settings. Refer to the section of Chapter 17 dealing with 
serial communications configuration for more detail.

Reset terminal

Selecting Reset terminal option resets the terminal. This is to clear garbage characters that appear on screen, 
due to line noise etc. The Reset terminal command clears the screen, puts the cursor in the home position 
and resets the emulation parameters to their default settings.



Chapter 7: Scripts

Working with TTWin's built in scripting language.
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Scripts
TTWin's built in scripting language offers a wide range of possibilities for automating tasks, improving the user 
experience and enhancing legacy applications. The language is compatible with Microsoft's Visual Basic for 
Applications (VBA) to allow users with scripting experience to begin working with TTWin quickly and easily.

Changes in TTWin 4.8

Version 4.8 of TTWin introduced significant updates to the programs scripting capabilities. In particular a new 
Integrated Development Environment (IDE) featuring syntax highlighting, auto complete and debugger, along 
with a switch to an enhanced, VBA compatible scripting language. 

Scripts created using TTWin 4.8 and above have a .BAS extension are not compatible with scripts created in 
earlier versions of TTWin, which use a .TSL extension and are written in TTWin Basic. However, to ensure 
backward compatibility for existing scripts both formats can be executed within TTWin and continue to be 
supported. Should you wish to create and maintain scripts in the older TTWin Basic format you can continue 
to do so in TTWin 4.8 and above.

This chapter covers only the operation of the Scripts menu which allow you to create, edit, compile and run 
scripts. Detailed discussion of the language syntax is beyond the scope of this document and is provided 
through in program help documentation. 

Figure 7.1 Scripts menu.

TTWin versions 4.0 through 4.7 utilize a native scripting language called TTWin 
Basic, closely modelled on Microsoft Visual Basic. For further information on writ-
ing scripts in TTWin Basic and the particulars of the language itself please refer to 
the TTWin Basic User Guide available from www.ttwin.com

www.ttwin.com


Run/edit...

The Run/edit... command allows you to create, edit, compile, test and run scripts. When selected this menu 
options displays the Scripts tile as shown in Figure 7.2. 

Figure 7.2 The Scripts tile.

The Scripts tile displays a list of all known TTWin scripts in your environment.  The two icons to the left of 
each script row indicate whether the script is firstly Public or Private and secondly, whether the script item 
appears in the main program Scripts menu as a shortcut.  A description of each script and the corresponding 
filename also appear.

Legacy, older style scripts have a filename with a .TSL extension while newer scripts end with .BAS. Scripts 
may be added, deleted or modified via this tile.

Included Sample Scripts
>> Sample Login Script - A Telnet login script which prompts the user for a login and password and then 
connects to the host providing those details at login and password prompts.

>> Sample IBM Login Script - A sample login script for IBM 3270 and 5250 emulations. This script requires 
a small amount of editing to configure details to suit the intended host. 

>> Sample File Transfer Receive Script - This script prompts the user for a remote file which it will attempt 
to download from the remotely connected host using the X/Y/ZModem or Kermit protocols.

>> Sample File Transfer Send Script - This script prompts the user for a local file which it will attempt to 
upload to the remotely connected host using the X/Y/ZModem or Kermit protocols.

For detailed information on the sample scripts included with a standard TTWin 4 
installation please refer to Appendix D - Sample Scripts.
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Creating a New Script

There are two methods for creating a new script. Macro Recording will convert some user activity and host 
interaction into TTWin scripts. For more information on Macro Recording refer to Chapter 16 - Macros. 

Alternately, to manually create a new entry in the script table, click on the New... button. The New Script 
Entry tile is displayed.

 Figure 7.3 New Script Entry tile.

Type
Available options are Private and Public. A Private script is only available to the user that the script was cre-
ated by, the Public script is available to all TTWin users.

By default both Private and Public scripts can be created. Should you wish to allow only Private scripts, 
select Configure > General > Global Preferences > Scripts and deselect Use public scripts. To retain 
these settings be sure to save your session configuration by selecting File > Save (default.twc.) For further 
information on script preferences refer to Chapter 9 - Global Preferences.

File name
Enter the filename for the script, the default extension is .BAS. To select an existing file from a local or net-
work location click the ... button to the right of the text field. The default directory is the directory specified in 
the Configure > General > Global Preferences > Scripts tab. For further information refer to Chapter 
9 - Global Preferences.

Description
Enter a description for the script.

Show in the 'Scripts' menu
The description is displayed under the Scripts menu when Show in the 'Scripts' menu option is selected. 
This enables scripts which are frequently executed to be easily accessed. 

A script will not be accessible from the Scripts menu unless you select this option.



Editing a Script

Click on the Edit script... button to edit an existing script, as shown in Figure 7.2. 

If you script is the newer, .BAS format the internal TTWin scripting integrated development environment will 
launch with your script loaded. 

Legacy .TSL scripts will launch the external editor nominated in Configure > General > Global 
Preferences > Scripts > TTWin Basic script editor, with your selected script as a parameter. By default 
this is the Windows Notepad application, for further information on specifying an alternate editor please refer 
to Chapter 9 - Global Preferences.

 If the File name you selected when creating the entry in the script list does not exist, you will be prompted to 
create it. Should the script already exist it will be opened for editing.

Changing the Details of a Script

Clicking on the Edit item... button displays the Edit Script Entry tile, allowing easy modification of the 
script source file, description, as well as whether the script will be displayed as a menu item under the Scripts 
menu. The Edit Script Entry tile contains the same fields as shown on the New Script Entry tile in Figure 
7.3.

Deleting a Script

Clicking on the Delete button, removes the currently selected script from the list.

Deleting a script only removes the file from the TTWin script list. The file is NOT 
deleted from your hard drive.

Running a Script

Click the Run button to execute a script. For frequently used scripts, it is recommended that you use the 
Show in the 'Scripts' menu option. The script will then be displayed as a menu item under the top level 
Scripts menu for easy access.

Testing a Script

Once you have completed writing or editing a script you will need to test it. For best results it is suggested that 
.BAS scripts are tested using the scripting IDE to take advantage of debugging features included such as break-
points and variable inspection. See the following pages for information on debugging using the IDE.

To test a legacy .TSL script click on the Verify button to confirm the validity of the currently selected item. 
If the verify parse is not successful, then a Script Compile Errors tile is presented indicating the problem(s) 
within the script. The Verify button is unavailable for .BAS scripts. 
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Cancel...

Selecting the Scripts > Cancel... option will terminate a running script. This menu item will be only be 
available when a script is running.

Start Macro Recording...

The Macro Recorder records certain host and program interactions and generates standard TTWin scripts 
which can be run to replay the interaction.

For more information on the capabilities and limitations of Macro Recording refer 
to Chapter 16 - Macros. 

Selecting the Start Macro Recording... menu item initiates the recording of certain menu commands and 
host interactions to a script file. Actions will continue to be recorded until the Stop Macro Recording... 
menu item is selected.

Stop Macro Recording...

This menu item is selectable when a Macro Recording is in progress. Selecting it will halt the Macro 
Recording process and TTWin will display a New Script Entry dialog as shown in Figure 7.3. The script cre-
ation process then continues as described on the preceding pages.



Scripting IDE
TTWin's scripting IDE is launched when creating a new .BAS script or editing an existing script. The IDE 
offers a number of useful features which are more fully covered in online help. These include:

>> Syntax highlighting - Appropriately color script content depending on relevant function and category.
>> Auto complete - Suggests function names and parameter details. 
>> Graphical editing for dialog objects - Simplify UI element design with WYSIWYG tools.
>> Debugging  - Set and continue from breakpoints, watch and inspect variables.   

Figure 7.4 Graphical editing for dialog boxes.

TTWin API, Methods and Properties

A list of available methods and required parameters can be exposed through the IDEs auto complete function 
(type TTWin. as shown in Figure 7.5 on the following page) or by selecting the Browse Object icon on the 
program toolbar. Additionally, when typing the opening bracket of a function call, parameter information will 
be displayed. 

Please visit www.ttwin.com/support_downloads to download the TTWin VBA Scripting Quickstart guide and 
sample scripts.

http://www.ttwin.com/support
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Figure 7.5 Scripting IDE, showing auto-complete.

Debugging a Script

Before running a script within the IDE you may wish to add breakpoints to allow you to pause or step through 
an execution and examine the scripts operation. There are several ways to enable a breakpoint within TTWin, 
for example by right-clicking a particular line of script and selecting Toggle Breakpoint from the pop up 
menu, left clicking in the gray bar to the left of the line number column or by selecting a line of script and 
pressing either F9 or clicking the hand icon on the program toolbar.

To execute a script run click the play icon on the program toolbar. Your script will execute and halt at any set 
breakpoints, whereupon you can step through or over code blocks. You may also watch variables by right click-
ing any variable in the script body, or evaluate an expression directly in the Watch area.

Figure 7.6 The TTWin scripting IDE halted at a breakpoint, showing a watched variable.



Chapter 8: Help Menu

Product version, licensing and related functions.
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Help Menu
The Help menu provides access to in-program help documentation as well as product version and license 
detail.

About...

Selecting this menu option displays the program about tile. This provides access to detailed information on the 
program version and the licensing options.

About:
The About tab provides information on the overall program version and a link to the Turbosoft website. This 
version information should be quoted in dealings with Turbosoft support staff.

Figure 8.1 TTWin 4 About Tile.

Version:
The Version tab provides more in-depth product version information including version information on vari-
ous program components. This version information should be quoted in dealings with Turbosoft Support staff.

Figure 8.2. TTWin 4 Version information.



License:
The License tab displays information about the status of TTWin's current license. By default an unlicensed 
version of TTWin will be in evaluation mode. 

A licensed version of TTWin will display the licensee name, a serial number and a status entry of 'valid' as 
shown below. 

Figure 8.3 TTWin 4 License information, in evaluation mode.

For information on how to license TTWin please refer to Chapter 1.
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Chapter 9: Global Preferences

Configuring program wide features.
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Global Preferences
Global preferences are accessible by selecting Configure > General... from the main menu, then selecting 
the Global Preferences heading on the Configure tile.

Figure 9.1 Global Preferences configuration.

File Preferences

Backup configuration files (off)
If selected, then, whenever changes are made to any operation files, such as .TWC files, TTWin creates a back-
up. Backup files have a .BAK extension.

Query save on exit (on)
If selected, TTWin will prompts the user to save a session file (.TWC ) when exiting the program if a change 
has been made 

Directory for SSH authentication keys (C:\Users\{User}\AppData\Roaming\
Turbosoft\TTWin4\sshkeys)
A file directory where TTWin will access SSH Keys. 



Scripts

TTWin Basic script include directories () 
This setting is relevant to legacy TTWin Basic scripts only and specifies a list of directories where a .TSL 
script will search for external files referenced with an '$include: "file.ext" directive. 

Directories are supplied as a comma separated list and may be absolute or relative to the directories specified in 
the Location of public script files and Location of private script files settings. When editing scripts cre-
ated in TTWin version 4.8 and above directory locations for external resources are specified from within each 
individual script.

Location of public script files (C:\ProgramData\Turbosoft\TTWin4\scripts)
All TTWin's publicly available scripts are held in a common directory accessible by all users. The default direc-
tory is SCRIPTS, a sub-directory of the TTWin4 directory. 

Location of private script files 
(C:\Users\{User}\AppData\Roaming\Turbosoft\TTWin4\scripts)
All TTWin's private scripts are held in the user's own profile directory. The default directory is SCRIPTS, a 
sub-directory of the TTWin4 directory.  

Use public scripts (on)
If deselected, then only private scripts may be created by the user. 

TTWin Basic script editor (notepad.exe)
The external text editor to be launched when editing legacy TTWin Basic scripts. When editing non TTWin 
Basic scripts created in TTWin version 4.8 and above, the internal editor is used. 

VBA Scripting IDE
Save on run (Query)
The default action save action to perform when a script is executed from within the IDE. Options are:

>> No - do not save when a script is run.
>> Query - prompt the user to save when a script is run.
>> Always - always save before running the script.

For further information on scripting in TTWin refer to Chapter 7 - Scripts.
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Keyboard shortcuts

Use Ctrl-Tab to switch sessions(on)
When selected the key combinations of [CTRL+TAB] and [CTRL+SHIFT+TAB] cycle through the open ses-
sion windows.

Action ctrl/shift/alt key mapping on key up (off)
When selected key mappings made to [CTRL], [SHIFT], and [ALT] keys are not actioned until the key is 
released and only if the key is not used in combination with another key. 

This allows you to map to a shift state key and still use it as a shift state key.



Chapter 10: Session Preferences

Configuring session based preferences.
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Session Preferences
Session preferences control connect and disconnect options along with other session dependent options such 
as Title and Status Bar text.

To access the session options configuration select Configure > General from the main menu and select 
Session Preferences from the list on the Configure tile.

Title and Status Bar Text 

The TTWin Title Bar and Status Bar texts are configurable and appear as shown in Figure 10.1. 

Figure 10.1 Session preferences configuration.

TTWin has a number of built-in variables for use in the Title and Status Bar text.

Code Description

%T Inserts the text string 'TTWin' into the title or status bar.

%S Inserts the name of the session file into the title or status bar.

%E
Inserts the current emulation module into the title or status bar. This 
variable is updated in the title if the emulation module for that ses-
sion is changed.



Code Description

%C
Inserts the current comms module into the title or status bar. This 
variable is updated in the title if the comms module for that session 
is changed.

%D Inserts the current date into the title or status bar.

%F Inserts the name of the currently selected file transfer module into 
the title or status bar.

%O

Inserts the current connection status into the title. If the session is 
connected to a host this will read Connected. If the session is discon-
nected from the host it will read Not Connected. This variable is 
updated in the title bar whenever the connection status changes.

%P Inserts the current printer status into the title or status bar.

%N
Inserts an integer representing the instance of TTWin when the 
session was started. The number is 1 if no previous sessions are run-
ning.

%H
Inserts the current state of the visible TTWin window into the title 
or status bar. If history is being viewed then 'Viewing history' will be 
displayed.

%I Inserts the current 'Script running' into the title or status bar if a 
script is currently being executed.

%M
Inserts the current state of TTWin macro language into the title or 
status bar. If a TTWin macro is currently executing then 'Macro run-
ning' will be displayed.

%B
Inserts the current state of the pasting mechanism into the title or 
status bar. If TTWin is pasting from the clipboard to the emulation 
window, then 'Pasting' will be displayed.

%R Inserts 'Macro Recording' into the title or status bar when the Macro 
Recorder is operating. See Chapter 16 - Macros for more detail.
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Code Description

%U
Inserts the current state of the emulation into the title or status bar. 
If TTWin enters a pause state either by user input or host action the 
'paused' will be displayed.

%A Inserts the current state of the TTWin capture mechanism. If TTWin 
is currently capturing data then 'capturing' will be displayed.

%L
Inserts the current date of TTWin text selection mechanism into the 
title or status bar. If the mouse is being used to select text within the 
TTWin emulation window then 'Region Selected' will be displayed.

%,
Inserts a comma between the currently displayed option and the pre-
viously displayed option. The comma is removed when the currently 
displayed option ceases displaying.

%Z Inserts the host name into the title or status bar.

%%

Inserts the text character % into the title or status bar. This is 
required as a separate entry as the % symbol is used by TTWin to 
represent title variables. This variable adds a '%%' to ensure it is read 
as a text character.

Title Bar text (%T Session %N - %S - %E %O via %C)
Resolve to something like: TTWin Session 1 - default.twc - DEC VT Series Not connected via Telnet

Short title text ()
This will override the default text displayed on the session tab.

Status bar text (%H %P %M %B %U %A %L %I %R)
This will output status-based information such as 'Viewing history' or 'Printing' in response to user activity.

Action on disconnect (Notify)

When a session is disconnected from the host (logout, [CTRL_D], exit, quit) TTWin can do several things: 

No action 
The connection is quietly closed. The Top Status Bar displays Disconnected. On disconnection the user 
stays in TTWin.  

Notify 
A tile will appear stating that the connection has been closed. The Top Status Bar toggles to Disconnected. 
The user stays in TTWin.  



Reconnect 
Causes TTWin to reconnect to the host.

Exit 
Closes and exits TTWin without any notification.  

Auto connect on startup (on)

Deselect this if you do not want TTWin to automatically connect to the host when launched.

Startup string () 

As soon as TTWin is loaded, prior to attempting to initiate a connection to a nominated host, the Startup 
string, a macro, is executed.

Connect string ()

If the Auto connect on startup option is selected AND a connection to the remote host succeeds, the 
Connect string is then executed. E.g. the string \p010username\r\p010password\r equates 
to \p010: pause 1 second, username\r: send the username and enter/return, \p010: pause 1 second, 
password\r: send the password and enter/return.

How to Automate Login

You can use the connect string session preference and a macro to automate the login process. If combined with 
an Auto connect on startup setting of on, TTWin will automatically connect and login to your host when 
launched. To automate the login process complete the following steps:

1	From the menu select Configure > General then select the Session Preferences > Connect String 
option.

2	 In the Connect string enter the login details follow by the emulation keys in braces, a pause at the begin-
ning will give the host time to respond. For example:

\p010UserName{Return}\p010Password{Return}

The above string will pause for 1 second, send the username, send the [Return] key, then pause for another 

second, send the Password, then send a second [Return] key. For a list of macro options refer to Chapter 16.

The name of the {Return} key may change depending on the emulation being 
used.

3	Select File > Save configuration to retain these settings. Refer to Chapter 2 for information on saving 
session settings.
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Reset emulation on connect (off) 

Selecting this clears the screen prior to connecting to your host.

Reset emulation on disconnect (off) 

Selecting this clears the screen on exiting your host session.

Allow manual disconnect (on) 

Allows user to disconnect without logging off from the host first.

Disconnect string () 

Runs a macro string when the user presses the disconnect button. This macro needs to include a disconnect 
command otherwise the disconnect will be aborted.

Shutdown string () 

Runs a macro string when the user closes TTWin. This macro needs to include a close command otherwise 
the close will be aborted.

HLLAPI

High Level Language Application Programming Interface, an API which provides the ability to screen scrape 

Automatically assign HLLAPI short name (off)
Select this if you do not wish to assign your own short name, ideal for multi-session.

HLLAPI short name ()
Enter your required short name, a single alphabetic character (A to Z) used to identify the session with which 
the HLLAPI application is communicating.

HLLAPI long name ()
Enter a descriptor for the short name defined (optional).

Macro Recording

Include command sequences in the recorded macro (on)
By default when recording a macro TTWin will include text escape sequences received by the host as part of a 
WaitForString command. In some instances this can cause problems if the control sequences are not the 
same each time the script is run. This can be resolved by setting this option to off which uses only the text that 
is displayed on the screen.



Chapter 11 : Display

Configuring the TTWin window format and scroll 

history parameters.
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Display
Display options can be configured to change the appearance of TTWin's terminal display characteristics.

To access the display configuration options select Configure > General... from the main menu and open the 
Display heading as shown in Figure 11.1.

Figure 11.1 TTWin display configuration.

History 

The scroll history facility enables information that has scrolled off the top of the screen to be viewed. 

History enabled (on)
Deselect to disable the scroll history feature.

Copy to history on a screen clear (on)
Copies the content of the screen to history once a clear screen has been sent.

Keep colors and attributes (off)
When deselected, information once scrolled off the screen is only saved as ASCII text. When selected, all 
screen colors or attributes are retained through the scroll history.

Save history to a file (off)
If you wish to save the history to a file set this option to on.



History file name (history.thf)
To change this name enter the new name into the History file name field or browse to select another file 
name. The history file has a .THF extension.

Max. history size (128k)
The size can be modified by simply clicking on the Max. history size and then selecting the appropriate value 
that you require. Available values are: 

>> 8k
>> 16k
>> 32k
>> 64k
>> 128k
>> 256k
>> 512k
>> 1MB

Cursor

Cursor visible (on)
Deselect this option if you have an application where the cursor must be invisible.

Cursor blink (on)
Sometimes locating your cursor on the screen can be a daunting task. Setting the cursor to blink makes finding 
it easy.

Cursor shape (standard mode) (Full Block)
The actual shape of the cursor can be set to suit particular applications running on your remote system.  The 
cursor styles available for normal operation are: 

>> Small Block: A half height block filling the lower half of a character.
>> Full Block: A full character solid block. 
>> Horizontal Line: An underscore character. 
>> Vertical Line: A centred horizontal full character height line.

Cursor shape (insert mode) (Horizontal Line)
The actual shape of the cursor can be set to suit particular applications running on your remote system.  The 
cursor styles available when in insert mode are: 

>> Small Block: A half height block filling the lower half of a character.
>> Full Block: A full character solid block. 
>> Horizontal Line: An underscore character. 
>> Vertical Line: A centred horizontal full character height line.
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Options

Enable blink (on):
This toggles the blink attribute for text. 

Enable invisible (on): 
This attribute enables or disables the visibility attribute for text.

Enable blink in config (on):
This toggles the blink attribute in the Configure > Colors... configuration tile.

Enable invisible in config (on): 
This toggles the invisible attribute in the Configure > Colors... configuration tile.

Display busy refresh (ms) (100)
The time in milliseconds between screen refreshes.

Draw underline characters (off)
Use the graphical underline character rather than underscore characters.

Hide cursor when not in focus (off)
The cursor is hidden when TTWin is not the active application.

Bell Sound (Windows Default) 
>> Disabled: No bell sound will be used.
>> Windows Default: Uses the default Windows sound.
>> Windows OK: Uses the default Windows OK sound.
>> Windows Question: Uses the default Windows question sound.
>> Windows Hand: Uses the default Windows hand sound.
>> Windows Exclamation: Uses the default Windows exclamation sound.
>> Windows Asterisk: Uses the default Windows asterisk  sound.
>> Sound File: Use the Bell sound file defined in the Bell Sound File option defined below.

Bell Sound File () 
Selecting Browse… will open the File Browse tile. Use this to navigate to the location of the sound file you 
wish to use.  The sound file must be in .WAV format.

Lock status line (off): 
xxx

Use the I-beam mouse pointer (on)
Set the mouse pointer to utilize an I-beam pointer when hovering over the terminal display area.



Scroll

Jump scroll (Unlimited)
Select from the drop-down menu to set the scroll rate. For example, a setting of 4 lines, for example, will 
cause the display to be updated whenever four lines have been scrolled. Available options are:

>> Unlimited
>> Page
>> 1 line
>> 2 lines
>> 4 lines
>> 8 lines
>> 16 lines
>> 32 lines
>> 64 lines

Vertical scroll bar (Auto hide)
>> Always off: The vertical scroll bar is disabled.
>> Always on: The vertical scroll bar is enabled.
>> Auto hide: The vertical scroll is only displayed if sufficient history is available.

Horizontal scroll bar (Auto hide)
>> Always off: The horizontal scroll bar is disabled.
>> Always on: The horizontal scroll bar is enabled.
>> Auto hide: The horizontal scroll is only displayed if the emulation window is smaller than the default emu-
lation width.

Follow cursor (Follow) 
Controls how the data is displayed when the TTWin window is smaller than the emulation work area. 

Follow cursor is only used if auto scaling is disabled.

>> Off: The display does not follow the cursor.
>> Follow: The display scrolls with the cursor, the cursor is always in the visible work area.
>> Centered: The cursor is centered within the visible work area.

Grid

Places a grid over the emulation screen with the entered horizontal and vertical grid spacing.

Active (off)
No grid is displayed.

Color (Major lines) (RGB=000000)
Select color for major grid lines.
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Color (Minor lines) (RGB=000000)
Select color for minor grid lines.

Line width (major) (1)
Width of major grid lines in pixels.

Line width (minor) (1)
Width of minor grid lines in pixels.

Vertical line spacing (major) (5)
The number of rows between major vertical lines.

Vertical line spacing (minor) (0)
The number of rows between minor vertical lines.

Horizontal line spacing (major) (10)
Number of columns between major horizontal lines.

Horizontal line spacing (minor) (5)
Number of columns between major horizontal lines.

Ruler

Style (Off)
The style of ruler to be used.

>> Off: No ruler will be displayed.
>> Vertical line: A vertical ruler will be displayed.
>> Horizontal line: A horizontal ruler will be displayed.
>> Cross: A cross hair ruler will be displayed.

Color (RGB=000000)
Choose the ruler color. Clicking the edit button brings up a color selection tile.

Line width (1)
Select the width of rule in pixels.



Chapter 12 : Menus & Toolbars

Configuring and customizing the TTWin program 

menus and toolbars.
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Menus and Toolbars Configuration
TTWin offers the ability to customize and completely configure existing in-program menus and toolbars as 
well as to create new, custom toolbars. This can be particularly useful when you wish to give users easy access 
to custom commands or when locking down and limiting menu options for your end users.

To access the menu and toolbar configuration options select Configure > General... from the main menu 
and open the Menus and Toolbars tile as shown in Figure 12.1.

Figure 12.1 Menus and Toolbars configuration tile.

This tile lists the default menus and toolbars within TTWin as well as any user created custom toolbars. The 
three default items are the Popup menu (Figure 12.2), which is displayed on a right click in terminal display 
window, the Main toolbar (Figure 12.3) and the Main menu (Figure 12.4). All three are completely custom-
izable and additional toolbars can also be created. 

Figure 12.2. The popup menu is shown on right clicking in the terminal display area.



 

Figure 12.3. The default toolbar.

 

Figure 12.4. The main program menu with the Actions sub-menu open.

Creating a New Toolbar

New toolbar 

Selecting the New toolbar button will create an empty toolbar item, ready for editing. This item can be edited 
to add toolbar items.

Deleting a Toolbar

Delete...

Selecting the Delete... button will delete a user created toolbar. Note that the default program menus and 
toolbars may be customized but cannot be deleted. 

Reset... 

The Reset... button returns a menu or toolbar to its default state, restoring any previously deleted menu items 
and removing any additions. This option is only available for the default program menus and toolbars and will 
be unavailable on user created items.
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Editing a Menu or Toolbar
To edit an existing toolbar or menu select the item you wish to edit from the list of available toolbars and 
menus and click the Edit... button. This will display the Edit Menu/Toolbar tile.

Figure 12.5 The Edit Menu/Toolbar tile showing the default main menu opened for editing.

The left hand side of the tile lists the existing menu or toolbar structure and the right hand side of the tile con-
tains the caption and action associated with each menu item.

When a new menu or toolbar item is first created this list will contain only the root item.

Expand All

Expand all items on the current menu. This button only applies to menus as a toolbar can only accommodate a 
single level of items whereas menus may contain additional sub-menu levels.

Collapse All

Collapse all items on the current menu or toolbar.  This button only applies to menus as a toolbar can only 
accommodate a single level of items whereas menus may contain additional sub-menu levels.

Delete

Remove a menu item. Deleting a sub-menu item will also delete it's child menu items.



Insert

Inserts a new menu item. The initial position of the item in relation to the currently selected menu item is 
determined as either Insert before, Insert after or, where available, Insert child. Toolbars are only able to 
accommodate a single level of items while menus may contain additional sub menu levels.

To change the order of a menu item you may drag and drop an item to the desired location.

Item Caption(s)

The item caption field contains the text label to be used for the menu item. 

There is also a second field which is used for the item caption when in a toggle state. A limited number of 
menu actions contain a toggle state in which the menu caption will change when the action is initiated. An 
example of this is Actions > Connect which toggles to Actions > Disconnect once a host connection is 
established. Should an Item Type and Action with a toggle state be selected, this second caption field will 
become available for editing.

Keyboard Shortcuts for Menu Items
Placing an ampersand symbol (&) in the caption text denotes that the character which immediately follows the 
symbol will be used as a keyboard shortcut. For example caption text of &About.. is accessed by pressing A 
on the keyboard. At the root menu level this keyboard shortcut is combined with the [ALT] key. Ampersands 
are not displayed in the menu caption output.

Reset Button
The reset button restores an Item Caption to it's original default value. This option is only available on one of 
the default program menus or toolbars.

Item Type

Defines the type of menu item and the action performed on selection. Available options are 

Menu action:
When selected the menu item triggers one of TTWin's built in default menu actions. When this item is select-
ed an Action field is displayed containing a drop-down list of all available TTWin menu actions.

Separator:
The menu item is a horizontal (menu) or vertical (toolbar) graphical separator. It is not selectable and performs 
no action.

Sub-menu:
The menu item is a sub-menu heading.

Text/Macro:
The Text/Macro item allows the creation of custom menu items which send text to the host or perform a 
function defined by a TTWin Macro. When selected a text/macro to send box is displayed along with a ... 
button which launches the Macro Assistant. See Chapter 16 for more information on TTWin macros.
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Text/Macro menu items that are created for toolbars may also be configured with custom hints and image 
icons. The following options are available.

Hint:
A Hint (or 'tooltip') is a text message that appears when the mouse hovers over a custom toolbar item. Typically 
this is used to explain the item's function in greater detail than the label defined in Item Caption allows.

Image file:
An icon image may optionally be specified for the custom toolbar item. This image will replace the text specified 
in Item Caption and can be in PNG, GIF or BMP format. Click the ... button to display a file browser window. 

Scale image to the standard size (16x16): 
Images should be sized at 16x16 pixels if they are to match the default TTWin toolbar icons. Alternately, select 
this option to resize a specified image to the standard dimensions.

Figure 12.6 Configuration of a custom 'Select All' toolbar item. When clicked the toolbar item will execute a 
TTWin macro to select the terminal screen content. See Chapter 16 for more information on TTWin Macros.

.

Figure 12.7 The 'Select All' toolbar item, showing the Hint.



Chapter 13: Fonts

Selecting and configuring display fonts.
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Fonts
To configure TTWin's font options select Configure > General... from the main menu and open the Fonts 
heading as shown in Figure 13.1.

Figure 13.1 TTWin font configuration.

Options for font configuration are as follows:

Auto scale (on)

Whenever the TTWin program window is resized by the user, the font is scaled to best fit the new active win-
dow region.

Smooth scaling (on)

Scales the font to make use of the full emulation window.



Dynamic emulation display size (off)

This option allows you to fix the font size used on the terminal display and dynamically adjusts the number of 
rows and columns on the terminal display based on the size the TTWin program window.

This option requires the Auto Scale setting to be set to off and uses settings specified in CharHeight and 
CharWidth to set the font size.

Should Auto Scale be set to on, it will take precedence over this setting.

Resize window to fit text (off)

When selected the TTWin window will resize when the screen size changes instead of the display font resizing. 
This option requires the Auto scale option to be set to off.

Standard text font (Lucinda Console)

This font is used if the required character is not available in the font specified under the Unicode/DBCS font 
item. Editing this item will activate the Font Selection tile. Select the desired item from the list of monospace 
fonts and click OK. Non fixed width fonts are not available for selection.

Unicode/DBCS font (Lucinda Console)

The font specified for this item is the default font used by TTWin. Editing this item will activate the Font 
Selection tile. Select the desired item from the list of monospace fonts and click OK. Non fixed width fonts 
are not available for selection.

CharHeight (20)

Character height in pixels if Auto Scale is off.

CharWidth (10)

Character width in pixels if Auto Scale is off.
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Chapter 14: Mouse 

Defining the mouse operation.
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Mouse Configuration
Mouse configuration controls the way in which the mouse is used to select text on the display.  Mouse actions 
can be assigned to single and double clicks for both the left, middle and right mouse buttons.

Assigning Mouse Actions

Mouse configuration options can be found under general preferences options. Select Configure > Mouse to 
open the to open the Configure Mouse tile. 

Figure 14.1 TTWin mouse configuration.

The following actions are available for the left, middle and right mouse buttons and can optionally be com-
bined with any of the following shift states. 

>> None 
>> Shift 
>> Ctrl 
>> Alt 

Combinations of the above are also acceptable as are single and double clicks. For example, an action could be 
assigned to the following:  [CTRL_SHIFT] + left mouse button double click.



Mouse Actions

Not assigned
Do not associate an action with a mouse click. 

Rectangular Highlight
Allows the selection of a rectangular screen region.

Continuous Highlight 
This highlights a continuous line of text from the display area. The selection starts at the row and column loca-
tion corresponding to the mouse pointer location when the command was issued and includes all partial and 
complete lines of text up to the location at which the mouse button is released.

Drag Screen 
By holding down the mouse button and dragging the pointer you can scroll the TTWin terminal display.

Select word
TTWin will highlight the word directly under the mouse pointer.

Send word
TTWin will copy and paste the word directly under the mouse pointer into the terminal.

Popup menu
TTWin will display a popup menu under the mouse pointer.

Move Cursor
Moves the cursor to the selected position in block mode emulations e.g. IBM3270.

Copy word to clipboard
TTWin will copy the word directly under the mouse pointer to the clipboard.

Rectangular highlight & move cursor
Allows you to select a rectangular screen region and moves the cursor  to the selected position in block mode 
emulations e.g. IBM3270.

Continuous highlight & move cursor
This highlights a continuous line of text from the display area and moves the cursor to the selected position in 
block mode emulations e.g. IBM3270. The selection starts at the row and column location corresponding to 
the mouse pointer location when the command was issued and includes all partial and complete lines of text 
up to the location at which the mouse button is released.

Send text/macro
If selected a Text/macro box is displayed where you can enter either text or a macro string. Once the selected 
key or combination is pressed the text or macro string will be displayed/performed directly under the mouse 
pointer. Pressing the ... button will launch the Macro Assistant. For more information on macros refer to 
Chapter 16.
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Run a Script
If selected a Script box is displayed where you can enter or select a script. Once the selected key or combina-
tion is pressed the defined script will be executed directly under the mouse pointer into the terminal. 

Rectangular highlight & send text/macro
If selected a Text/macro box is displayed where you can enter either text or a macro string. Once a rectangular 
screen region is selected the text or macro string will be displayed/performed at the cursor location. 

Continuous highlight & send text/macro
If selected a Text/macro box is displayed where you can enter either text or a macro string. Once a screen area 
is selected the text or macro string will be displayed/performed at the cursor location 

Figure 14.2 Continuous Highlight.

Restore default Settings

This button will reset the current mouse settings and actions to the TTWin default settings.



Chapter 15: Printer

Specifying how the printer handles a print job.
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Printer Configuration
In order to simplify printing operations, TTWin's printer configuration provides the facility to send print con-
trol sequences over and above that which is offered in Windows.

To access the printer configuration select Configure > General... from the main menu and click on the 
Printer heading on the Configure tile.

Figure 15.1 Printer configuration.

The printer options are as follows:

Suppress printing (off)

Select this option to disable printing.

Print to File (off)

Select this option to direct all print jobs to a file as defined in Print to File Settings.



Print to File Settings

Print File ()
Selecting Browse... opens the file selection tile, allowing you to nominate a file and location to which the print 
job output will be saved. 

Print to Serial Port (off)

Select this option to direct all print jobs to the serial port as defined in Serial Port Settings.

Serial Port Settings

Port Name()
Select a COM port from 1-32.

Baud Rate
Select a Baud rate from 300-256000.

Data Format
Options for handling serial port data.

Parity (None)
Parity options are:

>> None
>> Odd 
>> Even
>> Mark 
>> Space

Byte Size (8)

Stop Bits (1)
Stop bit options are:

>> 1
>> 1.5 
>> 2

Default Printer Overrides

These settings enable default configuration options to be overridden for the target printer.

Printer (Default printer)
Selecting Edit... opens the Printer Setup tile, allowing you to select from the printers you have configured on 
your workstation. Selecting Default… will use your Windows default printer as the TTWin default printer.
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Orientation (default): 
Printer orientation options are:

>> Default: Uses the orientation as configured for that printer by default.
>> Portrait: Overrides the printer default orientation to portrait.
>> Landscape: Overrides the printer default orientation to landscape.

Fit to page (on)
When set to on, screen content will be resized to fit the printed page. Note that if Fit to page is employed set-
tings listed below under Column dimensions and Row dimensions are ignored.

Margins (millimeters)
Left margin (25)
The page left margin in millimeters.

Right margin (25)
The page right margin in millimeters.

Top margin (25)
The page top margin in millimeters.

Bottom margin (25)
The page bottom margin in millimeters.

Page Options (Screen Print)
These printing options relate specifically to screen printing, that is, printing initiated in TTWin by selecting 
File > Print... from the program menu. They do not apply to pass through (host-initiated) printing.

Use printer default font (off)
When set to off, TTWin will ignore the printer default font and use the on-screen font(s) for printing.

Print reverse video (off)
When this setting is off, reverse video content is printed as normal content.

Fit to page (on)
When set to on, screen content will be resized to fit the printed page. Note that if Fit to page is employed 
settings listed below under Column dimensions and Row dimensions are ignored.



Note that if Fit to page is set to on, settings listed below under Column 
dimensions and Row dimensions are ignored.

Column dimensions
Columns per row (80 columns)
Manually set the number of columns to be printed on each page. Select from the following options.

>> 80 columns. Note that any screen content appearing after the 80th column will be truncated.
>> 132 columns
>> Use Selected. When this item is specified then the number of columns to be printed is taken from the 
Selected columns per row setting below.

Selected columns per row (80)
Enter a custom number of columns to be printed on each page.

Row dimensions
Rows per page (Best fit)
Manually set the number of rows to be printed on each page. Select from the following options.

>> Best fit
>> Use selected. When this item is specified then the number of columns to be printed is taken from the 
Selected rows per page setting below.

Selected rows per page (25)
Enter a custom number of rows to be printed on each page. TTWin will send a form feed to the printer 
after the number of rows specified.

Print in raw data mode (off): 

Printing raw data involves the print job data stream being sent directly to your selected printer with no TTWin 
intervention. When printing in raw data mode, the Process LFs, Process CRs and Wrap lines longer than 
the page width options will have no effect.

Wrap lines longer than the page width (off)

Lines longer than the width of the print page are not wrapped onto a new line.

Keep print job open (off)

There may be times when you need to close the print job manually.  This can be done through TTWin. If this 
option is selected, the Close print run... becomes available option on the File menu to close the print job. 
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Print Start/End uses tokens (%D%T) (off)

When selected this options allows the use of %D and %T tokens in the String to print at start of job and 
String to print at end of job strings. Adding %D and %T will allow you to print the current Date and Time at 
the beginning or end of your print job.

For example, you may use a string like: \r\n\n%D - %T\r\n

String to print at start of job ()

The string entered here is sent to the printer prior to the print job being sent. This is typically used to initialize 
the printer. 

String to print at end of job ()

This string is sent to the printer on completion of the print job.

Printer font (Courier New)

Selecting Edit... opens the Font tile, allowing you to select from the fonts you have installed on your worksta-
tion.

Process CRs (Normal)

This parameter determines how TTWin handles carriage returns sent by the host.

>> Normal: Carriage returns are processed normally.
>> Strip them: Carriage returns are removed.
>> To LFs: Carriage returns are replaced with linefeeds.
>> To CR-LFs: On receipt of a carriage return, a linefeed is performed as well as a carriage return.

Process LFs (Normal)

This parameter determines how TTWin handles linefeeds sent by the host.

>> Normal: Linefeeds are processed normally.
>> Strip them: Linefeeds are removed.
>> To CRs: Linefeeds are converted to carriage returns.
>> To CR-LFs: On receipt of a linefeed, a carriage return is performed as well as a linefeed.



Chapter 16: Macros

An overview of the extended macro 

language in TTWin.
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TTWin Macro Language
Macros can be simply described as a string that provides the ability to execute several operations consecutively 
from one initiating action. This is done by constructing the macro from a combination of text and "tokens", 
these "tokens" representing such functions as ASCII control codes, emulation keys, predefined TTWin func-
tions and so on.

Format

A TTWin macro consists of standard text which is sent to the host, with embedded tokens. The tokens are 
either translated into text (e.g. \r) or perform an action (e.g. pause). 

Macro Tokens
Tokens can be grouped into three main categories:

>> C-Style text replacements
>> Brace enclosed tokens
>> TTWin Version 3 compatibility tokens

C-Style Replacement Tokens
These tokens start with a backslash and translate to a single character value.

Token Character Code

\r 13, 0x0D (CR)

\n 10, 0x0A (LF)

\t 9,  0x09 (TAB)

\b 8,  0x08 (BS)

\f 12, 0x0C (FF)

\xnn Translates to the hex code nn. Can be 2 to 4 digits, giving values 
from 0 to 0xFFFE

\c

Removes any special meaning from the character c. E.g.

\\ = The backslash character

\{  = The character { rather than the start of a brace token.



TTWin Version 3 Compatibility Tokens
These tokens are implemented for compatibility with version 3 of TTWin.

Token Action

\e’name’ Replaced with the value of the environment variable name	 For 
example, \e PATH would return your current PATH settings.

\E'notepad.exe'
Execute an external command. If no absolute path is provided 
TTWin will use the system path.

\pnnn Pause the macro where nnn is in tenths of a second.

\m Move the terminal cursor to the current mouse position.

\S'myScript.bas'
Runs a TTWin Basic or VBA script. If no absolute path is provided 
the default directory will be used. Refer to Appendix C for more 
detail.

\v’name’ Replace 'name' with Password or LoginName, the variables from 
the User Details parameter described in Chapter 22. 

\U'url' Launch the default browser with the given url.

Brace Enclosed Tokens
These tokens are enclosed in curly braces {}. They are can be further broken down into one of the following 
types:

>> Function calls  (e.g. {.Connect()} )
>> Flow control statements (e.g. {%if(r=0)} )
>> Emulations keys (e.g. {F1} )

Function Calls
The following are in addition to numerous macro functions which replicate program menu items.

Function Parameters Action

{.CaptureStart()} Open capture start menu option.

{.CaptureStop()} Stop capture menu item.

{.ClearScreen()}
Clears the screen. 

‘r’ register left unchanged.

{.Close()} Close the application.
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Function Parameters Action

{.CloseAll()} Prompts the user to close all open 
sessions.

{.ClosePrint()} Close Print menu option.

{.ConfigColours()} Config > Colors menu option.

{.ConfigComms()} Config > Comms menu option.

{.ConfigEm()} Config > Emulation menu option.

{.ConfigFt()} Config > File transfer menu option.

{.ConfigGeneral()} Config > General menu option.

{.ConfigHotspots()} Config > Hotspots menu option.

{.ConfigKeyboard()} Config > Keyboard menu option.

{.ConfigMenus()} Config > Menus menu option.

{.ConfigMouse(} Config > Mouse menu option.

{.Connect()}
Attempts to connect.

Result placed in ‘r’ register.

{.Copy()} Copies the selected text to the clip-
board.

{.CopyToFile()}
Saves the selected text to a file, 
prompting the user for a filename 
and location.

{.CursorToMouse()} Moves the terminal cursor to the 
current mouse position.

{.Cut()} Edit > Cut menu option.



Function Parameters Action

{.Disconnect()}
Attempts to disconnect.

Result placed in 'r' register

{.EditClearAll()} Edit > Clear All menu option.

{.EditClearDisplay()} Edit > Clear Display menu option.

{.EditClearHistory()} Edit > Clear History menu option.

{.EditFind()} Edit > Find menu option.

{.EditFindNext()} Edit > Find Next menu option.

{.EditSelectAll()} Edit > Select All menu option.

{.EditSelectDisplay()} Edit > Select Display menu option.

{.EmBreak()} Action > Break menu option.

{.EmReset()} Action > Reset menu option.

{.EmUnlockFlow()} Action > Unlock Flow menu 
option.

{.EnvVar(var)} var = name of an environment 
variable

Sends the value of the environment 
variable.

‘r’ register left unchanged.

{.FileNew()} Opens a new session using the  
default.twc file.

{.FileNewDefault()} Opens a new session, prompting the 
user for a session file to load.

{.FileNewFilename("var")} var=filename.twc
Opens a new session using the spe-
cific configuration file.
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Function Parameters Action

{.FileOpen()} File > Open menu option.

{.FileReceive()} Action > File Receive menu option.

{.FileSave()} File > Save menu option.

{.FileSaveAs()} File > Save As menu option.

{.FileSend()} Action > File Send menu option.

{.FileTransfer()} Action > File Transfer menu option.

{.Find("text")} text = text to be found Finds the specified text.

{.HelpAbout()} Help > About menu option.

{.HelpComms()} Help > Comms  menu option.

{.HelpEm()} Help > Emulation  menu option.

{.HelpFt()} Help > File transfer menu option.

{.HelpIndex()} Help > Index  menu option.

{.HotspotURL()}

This macro is for use with Hotspots. 
(see Chapter 23 for more detail). 
When set as a Hotspot action this 
macro launches the default browser 
using the Hotspot text as a URL.

{.MsgBox(text)} text = text message

Shows a message box with OK & 
Cancel buttons. Cancel button exits 
the macro.

‘r’ register left unchanged.



Function Parameters Action

{.NextSession()} Window > Next Session menu 
option.

{.Paste()} Edit > Paste menu option.

{.PasteNext()} Edit > Paste Next menu option.

{.Pause(period)} period = pause time in tenths 
of a second

Pauses macro execution.

‘r’ register left unchanged.

{.PlaySound("file")} file = path to file Plays WAV file.

{.PrevSession()} Window > Prev Session menu 
option.

{.Print()} File > Print menu option.

{.PrinterSetup()} File > Printer setup menu option.

{.Reload()}

Reloads the current configuration 
file (.twc).

When TTWin is connected the 
communications module cannot be 
changed.

{.Script("file")} file = script file name, for 
example: Login.tsl

Executes TTWin Script file.

{.ScrollDownLine()} Scroll Down one line in History.

{.ScrollDownPage()} Scroll Down one page in History.

{.ScrollBottom()} Scroll to bottom of History.

{.ScrollLeft()} Scroll left.

{.ScrollLeftEdge()} Scroll to the left edge of the display.
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Function Parameters Action

{.ScrollRight()} Scroll right.

{.ScrollRightEdge()} Scroll to the right edge of the 
display.

{.ScrollTop()} Scroll to top of History.

{.ScrollUpLine()} Scroll Up one line in History.

{.ScrollUpPage()} Scroll Up one page in History.

{.SetProp(name,value)}
name = property name,

value = property value

Set the value of a configuration 
property.

{.ShellCmd("exe","param")}
exe = path to executable 

param = parameters to pass 
to exe

Runs external command.

{.Undo()} Undo last action. Valid for Block 
Mode terminals only.

{.URL("url")} url = URL to launch
Launch the default browser with the 
given URL.

{.UserVar("var")}

var = 'Password' or 
'LoginName', the variables 
from the User Details param-
eter described in Chapter 22..

Sends the value of the property.

‘r’ register left unchanged.

{.ViewFullScreen()} Toggle View > Full Screen menu 
option.

{.ViewMenu()} Toggle View > Menu option.

{.ViewPageTabs()} Toggle View > Page Tabs menu 
option.

{.ViewSessionPanel()} Toggle View > Session Panel menu 
option.



Function Parameters Action

{.ViewStatusBar()} Toggle View > Status Bar menu 
option.

{.ViewToolbar()} Toggle View > Toolbar option.

Flow Control Statements
Label {:name} Action

goto {%goto :label}

if
{%if(expr)} .. 
{%endif}

expr = a restricted boolean 
expression. See below.

while
{%while(expr)} ... 
{%wend}

expr = a restricted boolean 
expression. See below.

exit {%exit} Exits a macro.

Restricted Boolean Expressions
A limited boolean expression restricted to the form

<ident><op><const_value>

where

<ident> = a variable identifier. Currently only the result register ‘r’ is recognized.

<op> = One of =, <>, <, >, <=, >=

<const_value> = a numeric constant.

Emulations Keys
Brace enclosed tokens consisting of a single identifier are interpreted as emulation keys. 

{F1} {Enter}

Macro Examples

	Tries to connect and shows a message box if successful.

{.Connect()}{%if(r=0)}{.MsgBox("Connected!")}{%endif}

	Continually displays a message box until the cancel button is pressed.
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{:start}{.MsgBox("Hello")}{%goto :start}

	Connects and logs in.

{.Connect()}{%if(r<>0)}{.MsgBox("Connect failed"){%exit}{%endif}mylogin\
n{Pause(20)}mypassword\n

Host Initiated Macros

This section only applies if you are able to modify applications or write programs 
for your host. 

It is possible to automatically trigger events in TTWin in response to sequences sent from the host. One way to 
do this is to use a host initiated macro.

The first step is to set up a macro trigger sequence in TTWin. Sending the trigger sequence from the host is 
dependent upon the host’s operating system. You will need to be familiar with the operating system on your 
host.

For example in a UNIX environment you can use an ECHO command in a shell script.

If, after consulting your operating system literature, you require further assistance please contact Turbosoft for 
guidance. 

Defining Host Initiated Macros

From the TTWin menu select Configure > General > Host initiated macro, refer to Figure 16.1. 

:

Figure 16.1 TTWin host macro configuration.



Init unique macro sequence ()
A macro trigger sequence. This item can be any character or combination of characters. When the trigger 
sequence is detected in the host data stream, TTWin will execute the macro defined in Unique Macro.

Unique Macro() 
Macro that is triggered by Init unique macro sequence.

Macro Prefix/Trigger sequence
The trigger sequence is defined with the Macro prefix string. It is recommended that you define a sequence 
that is unlikely to occur. For this reason ESC is not a good character to start the sequence. An example trigger 
sequence is \x1f~, where \x indicates that the next two characters are a hex value, i.e., 1F.

When the trigger sequence is detected in the host data stream, TTWin will take one of several actions depend-
ing on the data which immediately follows the trigger sequence.

>> One of up to ten predefined local macros can be executed. These are defined in Macro0 through Macro9.
>> The host may append a delimited macro to the trigger sequence which will be executed by TTWin.
>> Alternately, the host can append content to the trigger sequence in the form of a script, either a legacy 
TTWin Basic format script or the newer VBA style.

This feature opens up many possibilities for greater host interaction, particularly where a host system may 
dynamically create and send a script or macro to the TTWin client. 

Macro timeout (5000)
Enter the maximum time allowed to execute a macro, shown in milliseconds. 

For more information on scripting in TTWin refer to Chapter 7 - Scripts.

For information on using macros to automate a login, refer to Chapter 10 - 
Session Preferences. 
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Interpretation of the Input Stream

When running the session, TTWin scans the input stream for the trigger sequence defined with the Macro pre-
fix or trigger string. On recognizing the trigger, TTWin looks for the next character and responds as follows:

Character Response

MacroN

TTWin executes the predefined macro N. For example the host could send the 
following string to TTWin.

\x1f~1

Where MacroN equals 1 and Macro1 is defined in TTWin as:

 Macro1=cd ~\n\p020ls -las\n

This sequence would do the following when triggered:

cd ~\n 	            change to the user's home directory
\p020 	              pause for 2.0 seconds
ls -las\n      generate an extended directory listing

mString

Executes a macro defined by String that includes a start and end delimiter. For 
example the host could send the following string to TTWin:

\x1f~m\x01cd ~\n\p020ls -las\n\x01

and TTWin would perform the same operation as the stored macro above.

SString

Executes a legacy TTWin Basic script defined by String that includes a start and 
end delimiter. For example, the following would display a message box with the 
text "Hello World" when triggered 

\x1f~S\x01msgbox "Hello World"\x01

VString

Executes a VBA script defined by String that includes a start and end delimiter. 
For example, the following would display a dialog box with the text "Hello 
World" when triggered. 

\x1f~V\x01Option Explicit

Sub Main

    msgbox "Hello World"

End Sub\x01



Macro Assistant
The Macro Assistant allows for text strings and Macros to be created via a graphical interface, it can be 
launched from several places within TTWin, most notably from the Configure > Keyboard... section of the 
TTWin program menu. Selecting either the String or Global string will display the button "...". Pressing this 
button initiates the Macro Assistant.  

Figure 16.2 Starting the Macro Assistant.

This interface allows the elements of the Macro to be selected from a list of valid entries and for the resulting 
string to be easily viewed, understood and modified if required. In addition the Macro Assistant ensures that 
the elements of the Macro are correctly entered and formatted
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.

 Figure 16.3 TTWin Macro Assistant tile.

Macro Text: 

This dialog box is used to display the text of the Macro in question. As the Macro is created the display reflects 
the changes that are made. In addition the Macro text can be edited directly, and any changes that are made are 
interpreted and listed in the components section of the tile.

Components Window

Shown on the left of the Macro Assistant tile, this list identifies each of the components of the macro, 
displaying the type of component and its value. If you select a component of the Macro from this list, such as 
the Function component shown selected in Figure 16.3, its Edit dialog will be displayed to the right of the 
list. 

Components of the Macro can be rearranged by selecting the appropriate entry and using the U(up) and 
D(down) buttons to adjust its location. By default a blank text component is placed in this list when the 
Macro Assistant is started.

Component Types 

Several different component types are available in the Macro Assistant, as shown in Figure 16.4.



 

 Figure 16.4 Macro Assistant component types tile

Component types include:

Text
This is used to enter standard text.

Character
This is used to enter either special characters such as LF, CR etc or to enter hexadecimal values. See Macro 
Commands for details.

Emulation key
This is used to add a predefined Emulation key to the Macro. The Emulation keys that are available to the 
Macro are dependent on the currently selected emulation module, and a key that is available in one module 
may not be valid in a different module.

Function
This is used to execute a macro function. 

Function (classic)
This is used to execute a TTWin version 3 compatibility token. 

If statement
This is used to start an If statement routine. If statements allows the execution of statements based on a 
condition.
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EndIf statement 
This is used to state that the end of the If statement has been reached. 

While statement
This is used to start a While statement routine. The While statement executes a group of statements in a 
loop as long as a condition remains true. 

Wend statement
This is used to state that the end of the While statement has been reached. 

Goto statement 
The Goto statement the execution of the script is transferred to a specified line (Label) within the same proce-
dure. 

Break statement
This is used to Break from a statement. 

Exit statement
This is used to perform an Exit from a statement. 

Label
This is used as a line reference for transfer of execution used in a Goto statement. 

Parameters

Insert Before
The Insert before button is used to add a new component to the Macro, causing it to be placed ahead of the 
highlighted entry in the Components list. When selected, a list of valid component types is displayed. Once a 
component type is chosen, an entry is placed in the Components list and the Edit dialog for that component 
type is displayed to the right of the tile. This Editor can then be used to set the appropriate values for that 
component.

Insert After
The Insert after button is used to add a new component to the Macro, causing it to be placed after the high-
lighted entry in the Components list. When selected, a list of valid component types is displayed. Once a com-
ponent type is chosen, an entry is placed in the Components list and the Edit dialog for that component type is 
displayed to the right of the tile. This Editor can then be used to set the appropriate values for that component.

Delete
The Delete button removes the selected component from the Components list, and therefore from the 
Macro. If only one component is listed when the Delete button is pressed, that component is removed and a 
blank text component is added



Macro Recorder
The Macro Recorder records certain host and program interactions and generates standard TTWin scripts 
which can be run to replay the interaction.

To initiate the Macro Recorder select Scripts > Start Macro Recording... from the program menu. When 
you have finished performing the desired activity select Scripts > Stop Macro Recording... from the pro-
gram menu. TTWin will then display a New Script Entry dialog with save options for the script output of 
the Macro Recorder. 

For more information on saving a script and how to use scripts in general, refer 
to Chapter 7 - Scripts. 

Supported Events
The Macro Recorder is focused on capturing host and terminal interaction rather than program configuration 
and consequently certain program functions are not captured by the Macro Recorder. The following events are 
supported.

>> Connect: As in the menu option Actions > Connect
>> Disconnect: As in the menu option Actions > Disconnect
>> Selecting an area of the terminal screen: This includes an arbitrary manual selection or a selection made 
through the menu options Edit > Select display and Edit > Select all.

>> Copy to clipboard. Selected areas and regions are copied to the clipboard as in the menu option Edit > 
Copy

>> Paste from clipboard: The contents of the clipboard are pasted to terminal as in the menu option Edit > 
Paste

>> Keyboard input: Keyboard entry made while connected to a host is recorded. Playback is determined by 
matching the 10 characters in the terminal immediately prior to the user input location. For example, during 
recording should keystrokes be entered at a 'login:' prompt the resulting script generated by the Macro 
Recorder would, when run, match the appearance and position of that 'login:' prompt before replaying 
the keyboard input.

>> Printing. As in the menu option File > Print

The Macro Recorder is a useful tool for assisting and automating the process of 
creating TTWin Scripts, however, in some cases manual editing of a created script 
may be required. Refer to Chapter 7 - Scripts for information on editing scripts.
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Chapter 17: Communications

Setting up the type of communications 

(transport) module.
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Communications Configuration
The communications configurations determine the method of connection to your remote host and ensures all 
data transmission is accurate and dependable.

Selecting a Communications Module

Open the communications modules configuration by selecting Configure > Comms from the main menu. 
This will bring up the communications dialog which is configured to Telnet by default.

To choose a different comms module select the current comms title (the top item in the list) and then click the 
Select Another… button as shown in Figure 17.1. The Module Selection tile is displayed listing the addi-
tional communications modules available.

Figure 17.1 Selecting a communications module



HP NS/VT
Hewlett Packard's Network Services/Virtual Terminal protocol.

Host ()

The Name or IP address of the remote host you wish to connect to. The mapping from Name to Address can 
be stored in the TTWIN.INI files section [HPNSHOSTS] or the name translation mechanism of the underly-
ing Windows Sockets protocol software (i.e. the local hosts file or DNS).

Advanced

Local NS nodename ()
The NS name of the Local PC, used to identify the terminal to the remote host. Consists of three labels repre-
senting host.department.organization i.e. PC31.DEV.TURBOSOFT.

Use custom prompt (off)
When enabled the prompt string sent by the host is replaced by the users customized string. 

Custom prompt (HP:)
Enter a custom prompt string. Maximum length 8 characters.

Stream mode (on)
TTWin's VT protocol supports the newer Stream Mode connection as well as the standard Message Mode.  
Enable this option to try to establish a Stream Mode connection first, if it fails HP NS/VT will automatically 
fall back to Message Mode.

Display diagnostics (off)
Enabling this feature displays various diagnostic messages during connection establishment.

DoDebug (off) 
Select this to enable log file capture.

Log File Name (c:\hpvt.log) 
Select the Browse button to specify a file name and location where log information will be saved.

Verbose (0) 
Debug setting. Select a value from 0 (least verbose) to 9 (most verbose).

Silent Errors (off)
When set to on this disables notification of TCP stack errors.
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Serial Comms

Port name (COM1) 

Specify the serial communications port to be used. Valid options are COM1 through to COM32.

Baud rate (9600) 

Specify the required speed from the following:

>> 300
>> 600
>> 1200
>> 2400
>> 4800
>> 9600
>> 19200
>> 38400
>> 57600
>> 115200
>> 128000
>> 256000

Data Format

Parity (None)
Specify the parity required:

>> None
>> Odd
>> Even
>> Mark
>> Space

Byte Size (8) 
Specify the byte size required.

Stop Bits (1) 
Specify the stop bit required:

>> 1
>> 1.5
>> 2



Flow Control

Software
From Host (on):
Selected if the flow controlled is initiated by the host.

To Host (off):
Selected if flow controlled by TTWin.

Start (Xon) (17):
Default setting is 17(dec) – Control Q ([CTRL_Q]).

Stop (Xoff) (19):
Default setting is 19(dec) – Control S ([CTRL_S]).

Hardware
Select either the To Host or From Host combination

To Host CTS (off):
Select Clear-To-Send.

To Host DSR (off):
Select Data-Set-Ready.

From Host DTR (off):
Select Data-Terminal-Ready.

From Host RTS (on):
Deselect Request-To-Send.

Control Lines

Ignore DCD (off) 
This option is required when running TTWin over a direct connection where the Carrier Detect Pin is not 

connected.

Drop DTR (on)
Drops the DTR signal in order to hangup.

Disable DTR (off)
Disables the DTR signal.

Break Duration (milli secs.) (100)

The Break period is defined in milliseconds.
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Buffers

Send Buffer Size (2048)
Internal TTWin data buffer settings.

Receive Buffer Size (2048)
Internal TTWin data buffer settings.

High Flow Mark (0)
For initiating flow control.

Low Flow Mark (0)
For initiating flow control.

Debug 

Log File (c:\serial.log) 
Selecting the Log file command activates the Browse tile. Enter or select the name of the file to which you 
wish to have the log information saved to.

Enable (off) 
Select this to enable log file capture.

Verbosity (0-9) (0)
Select a value from 0 (least verbose) to 9 (most verbose).



SSH – Secure Shell

Connection

Remote host address ()
Selecting the host tab allows you to enter the Name or the IP address of the remote host you wish to connect to. 
This is used when you wish to connect to the same host repeatedly and is saved to the configuration file.

Port No (22)
Assign the port number. The default is 22, as this is the port that is reserved for SSH.

Use TCP IPv6 (off)
Select if you wish to enable IPv6 support.

User Details
Login name ()
Enter the default login username.

Password ()
Enter the password for the login username.

Please consider your own security policies prior to implementing the User Details 
entries. 

Authentication key file ()
RSA private key.

Authentication key pass-phrase ()
Optional key passphrase.

Enable FIPS-140-2 mode(off)
Sets mode to FIPS-140-2 complaint.

Password required (on)
When set to off, a prompt for host dialog will not include a password field.

Prompt for host (if blank) 
Deselect this if you do not wish TTWin to prompt you for a host name or IP address. Options include:

>> Never
>> If Blank
>> Always
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Connection Attempt Timeout (6)
Time, in seconds, that a connection attempt will timeout in the event of a host not responding.

Remember host on successful connect (on)
On a successful connection the hostname is retained on the connection tile for subsequent connection attempts.

Terminal

Override Terminal Type (off)
TTWin will automatically supply the most appropriate Terminal Type for the SSH connection.  You may 
need to override this depending on your host’s SSH support. 

Terminal Type ()
The SSH protocol allows the terminal to inform the host or the host to ask the terminal for a terminal type 
identifier (such as VT220), to allow the host to correctly setup terminal-specific variables such as the codes to 
clear the screen.

Security

Use Keyboard Interactive (off)
Force a connection using Keyboard Interactive mode. A prompt for host dialog will not include a password field.

Strict Security (off) 
If selected the host RSA key must match the key listed in the known hosts file.

Miscellaneous

Enable Window Size (on)
When set to on TTWin will notify the host when local changes are made to the terminal row and column siz-
ing. Some hosts may not support this feature and in such cases it is recommended that Enable Window Size 
be set to off.

Keep Alive (secs.) (0)
During periods of inactivity TTWin will poll the host to keep a connection alive. This setting is defined in sec-
onds.

Debug

Enable Debug (off)

Debug Level (0-9) (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Debug File (c:\ssh.log)
Selecting the Debug File command activates the Browse tile. Enter or select the name of the file to which 
you wish to save the debug information to.



Telnet

Connection

Host () 
Selecting the host tab allows you to enter the IP address of the remote host you wish to connect to. This is 
used when you only wish to connect to the same host and will be saved within the configuration file. A system 
variable may be used to set the host, the variable must be enclosed with percent symbols. e.g %sysvar%

Use TCP IPv6 (off)
Select if you wish to enable IPv6 support.

LU Name () 
This is used to identify the terminal as an LU (Logical Unit) to an IBM Mainframe. A system variable may be 
used to set the LU Name, the variable must be enclosed with percent symbols. e.g %sysvar%

Associate ()
This option has no effect unless you are using the IBM3287 printer emulation. This is used to associate an 
existing Terminal LU (Logical Unit) to this session. For more information refer to the IBM 3287 section in 
Chapter 18 - Emulations.

The LU name and Associate options are mutually exclusive.

Advanced

Port No (23) 
This is an integer that identifies the destination within the remote host. 23 is reserved for Telnet, 21 for FTP.

Connection Attempt Timeout (6)
Time, in seconds, that a connection attempt will timeout in the event of a host not responding.

NoAdvancedSetup (off)

Prompt for host (if blank) 
Deselect this if you do not wish TTWin to prompt you for a host name or IP address. Options include:

>> Never
>> If Blank
>> Always

Remember host on successful connect (on)
On a successful connection to a host the host name is retained on the connection tile for subsequent connec-
tion attempts.
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Tn3270eEnabled (on) 
Select this if you wish to enable extended attributes when using the 3270 emulation.

Security

Security ([none])
>> [none]: no security enabled (standard telnet).
>> SSL: uses SSL3 encryption
>> SSH Tunnel: uses SSH encryption

Strict (off) 
If selected the host RSA key must match the key listed in the known hosts file.

SSL
SSL Enabled Protocols
Allow various SSL/TLS protocols.

SSL2 (off)
SSL3 (on)
TLS1 (on)
TLS1.1 (off)
TLS1.2 (off)
TLS1.3 (off)

Use System Security Libraries (on)
When disabled will allow connections using less secure legacy certificates.

Auto Select Certificate (off)
TTWin will automatically use a certificate in the user's name or prompt with a list where more than one 
certificate exists.

Certificate File () 
Options for selecting and importing certificate files. Clicking the Edit... button will display the tile 
shown in Figure 17.2

Figure 17.2 SSL certificate selection.



Store type
Select from Microsoft Certificate Store for existing certificate files or select a file format (PEM, DER, 
P12) to importing a new certificate for TTWin.

Store
A drop-down list of available certificates for the Microsoft Certificate Store. When choosing to 
import a certificate file, this option is replaced with a File option which loads a local certificate file 
into TTWin.

Password
Should the selected certificate require a password it should be entered here. Once entered correctly 
the Certificate drop-down list will update.

Certificate
Select the desired certificate.

Enable Express Logon Features (tn3270e only) (off)
Enable the Express Logon for secure connections to hosts via tn3270.

ELF Application ID ()
The application ID that the user is logging onto via Express Logon.

SSH Tunnel
SSH Only (off)
Enable this to send a Telnet datastream directly through an SSH channel rather than an SSH tunnel.

SSH Host ()
Enter the Name or IP address of the SSH host.

SSH Port No (22)
Enter the port number to be used for the SSH service.

Local Host () 
To override the local host Name or IP address (optional).

Local Port No (23) 
Enter the port number (listener) to be used for the local host defined above.

Username () 
Enter the username for the SSH service (optional).

Password () 
Enter the password for the SSH service (optional).
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Terminal
Override terminal characteristics (off)
TTWin will automatically supply the most appropriate Terminal Type and Telnet Mode for the Telnet 
connection. Select this option to override the supplied Terminal Type and Telnet Mode.

Terminal Type ()
The Telnet protocol allows the terminal to inform the host, or the host to ask the terminal, for a terminal type 
identifier (such as VT100). This allows the host to correctly setup terminal-specific variables such as the codes 
to clear the screen. This option is only available when Override Terminal Characteristics is selected.

Telnet Mode (NVT)
The type of Telnet communications between your local machine and the remote host can vary depending 
on the type of emulation you are using. The available settings are 

>> NVT 
>> IBM3270
>> IBM5250

This option is only available when Override Terminal Characteristics is set to on.

Telnet Options
Transmission Type (on)
When this option is set to on SGA (Suppress Go Ahead) is enabled.

Binary (off) 
All data is handled as 8 bit characters. There are no additional functions performed on characters such as 
end-of-line, or any other ASCII characters. This option is mutually exclusive with Line Mode. 

CR Handling (CR NULL)
This option specifics the character(s) to be used in terminating a packet. Available options are:

>> CR and NULL
>> CR Only
>> CR and LF

Line Mode (off)
In Line Mode, also known as character mode, characters like the end-of-line character, are translated.

Remote Echo (on)
When selected all data must first go to the remote host, then on return it is displayed on your screen.

‘Break’ Action (Interrupt)
Set the Break Action, available selections are

>> Interrupt
>> Break
>> Abort Output
>> Sync



Option Negotiation
Initiate Negotiation (off)
A Telnet connection is generally initiated from the remote host. Selecting this option forces the Telnet 
negotiation to start from the TTWin end. 

Show Negotiations (off)
When selected, the Telnet negotiation during the initial connection is shown.

Miscellaneous
Enable Window Size (on)
When set to on TTWin will notify the host when local changes are made to the terminal row and column 
sizing. Some hosts may not support this feature and in such cases it is recommended that Enable Window 
Size be set to Off.

Keep Alive (secs.) (0)
This setting is typically used for dial on demand connections, e.g. DSL. During a period of inactivity 
TTWin will poll the host to keep the connection alive. The poll interval is defined in seconds.

Send Location ([none])
Sends a location identifier, valid selection types are:

>> [none]
>> String: If this option is selected the Location field entry is sent to the host.
>> Hex IP
>> Decimal IP

Location ()
If the Send Location field is set to String then the contents of Location are sent to the host. Arbitrary 
text may be entered into this field or combinations of the following macro tokens may be used to dynami-
cally create a location string.

#x  Hexadecimal IP
#d  Decimal IP
#p  Port number
#s  Telnet Session ID (Not necessarily the TTWin Session Number)
#u  User Name
##  Inserts the '#' character.

Suppress Trying Messages (off)
When this option is set, messages indicating a connection attempt ('trying') are not displayed on screen.
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IBM5250 Options
User () 
Enter the username for TN5250 connections.

Password () 
Enter the password for TN5250 connections.

Encryption Required (off) 
Indicates whether the user and password fields require 3DES encryption.

MSGQNAME ()
5250 environment parameter. Please refer to your host documentation.

MSGQLIB ()
5250 environment parameter. Please refer to your host documentation.

IBMCURLIB ()
5250 environment parameter. Please refer to your host documentation.

IBMIMENU ()
5250 environment parameter. Please refer to your host documentation.

IBMPROGRAM ()
5250 environment parameter. Please refer to your host documentation.

Debug

Enable Debug (off)

Ask Before Starting (on)
When selected prompts user asking if they want to log the connection.

Debug Level (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Debug Log File ()
Selecting the Debug Log File command activates the Browse tile. Enter or select the name of the file to 
which you wish to save the debug information to.

Silent Errors (off)
When set to on this disables notification of TCP stack errors.



Express Logon Feature for IBM Hosts
TTWin supports Express Logon Feature (ELF) for IBM hosts. Follow the steps listed below to configure 
TTWin for use with ELF.

1	Select Configure > Emulation from the program menu.

2	Click on the Change Terminal button.

3	Select the IBM3270 from the Module Selection list and click OK.

4	Select Configure > Comms from the program menu.

5	Click on the Change Comms button.

6	Select Telnet from the Module Selection list and click OK.

7	 In the Telnet settings under Connection > Host, enter your host name or address.

8	 In Advanced > Port No, set the port number used by your host.

9	 In Advanced > Security section set the Security setting to SSL.

0	 Expand the Advanced > Security > SSL section and do the following:

Select Certificate and then Edit. 
Select the Store Type.
Select the Store or the Certificate File and browse to your Certificate file.
Enter the Password for the Certificate if required.
Select the required Certificate and select OK.

	 Select the Enable Express Logon Feature (TN3270 only) and set it to On.

	 Set the ELF Application ID

	 Select OK to close the Configure Telnet Tile.

	 Select File > Save from the program menu to retain these setting.

A standard TTWin installation includes a sample IBM Login script. This script is accessed by selecting Scripts 
> Run/Edit from the program menu and can be tailored to your host requirements for use with ELF.

Refer to Appendix D - Sample Scripts for details on this script and it's operation.
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Defining a Host List
TTWin allows you to predefine a single host for connection as part of each saved session (.TWC) configuration. 
However there may be occasions where you want to allow the user to select from a list of hosts regardless of 
the individual session configuration. To do this you'll need to perform the following steps:

1	 In a text editor such as notepad open TTWIN.INI, the program configuration file. This file can be found in 
the Global Config directory.

Refer to Appendix C for more information on program file paths.

2	Add the following text to the end of the file. Note that Telnet is the default communications module in 
TTWin, however this list will be available to all communications modules.

[Telnet] 
HostsTable=[Hosts] 

[Hosts]

3	Under the [Hosts] heading add any number of hosts, one host per line, in the following format.

hostAddress=alias

Your final table should look something like this:

[Telnet] 
HostsTable=[Hosts] 

[Hosts]
10.0.0.2=Bilbo
10.0.0.4=Frodo
myserver.com=Smaug

4	Save the TTWIN.INI file and restart TTWin. This list of hosts will be available to all sessions when insti-
gating a host connection via Actions > Connect as shown in Figure 17.3.

Figure 17.3 A list of predefined hosts available to the user.



Chapter 18: Emulations

Configuring your required terminal emulation.
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Emulation configuration
This chapter covers emulation configuration options for the various terminals emulated by TTWin.

Selecting an Emulation Module

Open the emulation module configuration tile by selecting Configure > Emulation... from the main menu. 
This will bring up the configuration options for the default emulation, which is the DEC VT Series.

To choose a different emulation module click the Change Terminal button as shown in Figure 18.1.

Figure 18.1 Selecting an emulation.



The Module Selection tile is displayed listing the additional emulation modules available. Use the mouse 
either double click or click once on the desired emulation followed by a click of the OK button. 

Figure 18.2 Selecting an emulation.

Note that a module may cover several emulations, for example the DEC VT Series module supports emula-
tions such as the DEC VT 52, the VT100, VT220 and others. Configuration options for each of the emulation 
modules supported by TTWin are listed alphabetically in this chapter.

Character Mapping

Emulation character mapping allows the user to select the character generated for a given ASCII value by the 
relevant country code mapping. This ASCII value may originate from a keyboard sequence, or from a character 
sequence from the remote host to the local PC screen or printer. Language mappings and Character Sets may 
be edited in-program. 

Not all languages are supplied for all emulations. If you require a language and it 
is not present in TTWin, please contact Turbosoft Support.

Character mapping and the process for modifying language and character sets is the same for all the emula-
tions. Each emulation contains a series of languages, found under the Language Name configuration option 
as shown in Figure 18.3. You may select an existing language or create a new language mapping and modify the 
accompanying character sets to suit.
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Figure 18.3 An example Configure emulation tile showing Character Mapping options.

Add a New Language Mapping 

To add a new language mapping select the required emulation and navigate to the Language Name item as 
shown in Figure 18.3. Click the Add.. button to display the Add New Language tile as shown in Figure 18.4. 
Enter a New Language Name and select an existing language or the (default) setting to base the new map-
ping on.

Figure 18.4 Add a new language.

At this point the new language mapping will contain character sets identical to the language mapping it was 
based upon. 



Editing a Character Set

To modify a character set select an items under the Character Sets heading as shown in Figure 18.3. Select the 
item and click the Edit... button to display the Edit Character Set tile shown in Figure 18.5.

.

Figure 18.5 Editing a Character Set.

The Edit Character Set tile lists the Map, Unicode and Character values for a character set. To edit an 
entry select the desired item and click the Edit... button. This will bring up the Edit Character Set Item tile 
shown in Figure 18.6. This tile allows you to modify the values for a particular character.

.

Figure 18.6 Editing a Character Set mapping.

Unicode Value
A hexadecimal Unicode value. The equivalent display character will be shown in the Character field. 

Character
Enter a character in this field and the equivalent Unicode value will appear in the Unicode value field.
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ADDS2020 Viewpoint

 End of line wrap (WRAP)

>> WRAP: When this item is selected and the cursor reaches the last column on a line, the cursor will be 
moved to the first column of the next line.

>> STOP: If this item is selected then the cursor will not move and incoming characters will overwrite the last 
column on the screen.

Autoscroll (SCROLL)

>> SCROLL: When selected, the screen will scroll up upon receiving a linefeed if the cursor is on the last line 
of the page.

>> LOOP: When selected, the screen and cursor position will remain the same.

Enable Status Line (on)

The ADDS 2020 terminal supports a status line across the bottom of the display region. Select this option to 
display the status line.

Mode (Native Mode)

Available modes are:

>> Wyse 
>> Native Mode

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Native text set
>> Native graphics set
>> Monitor mode character set
>> To host



ADM11

 ADM Mode (ADM11 /R)

 Four terminal modes are supported on the ADM11 emulation. 

>> ADM 11/R: Standard Pick System mode. This mode emulates most of the functions of the AWA VTE-6/R 
terminal. 

>> ADM 11/H: Hybrid mode. This emulation responds to both VTE-6/R and Prism II commands. In cases 
where the command codes or sequences clash, the Prism II command is executed.  

>> ADM 11/P: Prism II mode. Emulating the Microdata Prism II terminal.  
>> ADM 11/W: Wordmate mode. Specially designed for use with the Wordmate Word Processing Package.
>> ADM 11 (LSI): Native mode of operation.

Display Width (80)

Select between 80 column and 132 column display width.

Options: 

Enable CR send (off) 
This option governs whether or not a CR (carriage return) is inserted between each line of data sent to the host 
during a send operation.

Disable Lowercase (off)
When selected, the keyboard will behave the same as when the [CAPS LOCK] key is on. 

Keyboard Lock (off)
When selected, the keyboard is disabled. All keystrokes except for the RESET function will be ignored. The 
emulation will continue to display normally while the keyboard is disabled. When the emulation is first loaded 
it assumes a default state of the keyboard enabled (unlocked).

Autoscroll (on)
This affects the behavior of the terminal when a linefeed is issued on the last line. When selected, the screen 
scrolls up one line and the cursor  remains on the last line. When not selected, the screen remains unchanged 
but the cursor wraps around to the first column of the screen.

Status Line attribute (Normal)
The ADM11 terminal supports a status line across the bottom of the display region, available formats:  

>> Normal: The status bar appears with the normal attribute settings. 
>> Reverse: The status bar appears using the reverse attribute settings. 
>> Blank: The status bar is not visible, it uses the current normal text background attribute.  
>> Blink: The status bar uses the blink attribute settings.
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>> Character Mapping:

Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Normal character set
>> Monitor mode character set
>> LSI mode graphics set
>> To host



ANSI Color

Display Mode

Display Size (24x80) 
Available options are

>> 24x80
>> 24x132
>> Custom: uses the width and height as defined in the Custom Height and Custom Width options.

Custom Height (24)
Enter the number of rows required.

Custom Width (80)
Enter the number of columns required.

Options

Autowrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received. 

LF to CR/LF (Received) (off)
If selected then on receipt of a linefeed (LF) from the remote host TTWin performs a carriage return (CR) as 
well as a linefeed.

Edit Mode (Overtype)
Available options are:

>> Insert: Inserts incoming text at the position of the cursor. Existing text will be moved to the right to make 
space.

>> Overtype: From the current cursor position overwrites text to the right on the current line.

Special character set (Single line)
The ANSI emulation supports two styles of box drawing characters, these are:

>> Single line 
>> Double line

No gaps in underlines (on)
Select if you do not want gaps in underlines.

Erase with current attribute (on)
When selected, the current character attribute will be used when an erase operation is performed.
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Advanced
MapSingle (off)

SingleMapChar (155)

Set colors in Normal (on)

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages:

>> English
>> English (UK)
>> Dutch
>> Finnish
>> French
>> French/Canadian
>> German
>> Greek
>> Italian
>> Norwegian/Danish
>> Spanish
>> Swiss
>> Swedish
>> Cyrillic

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

ASCII
Extended ASCII
Graphics (single line box characters)
Single line box drawing character set.

Graphics (double line box characters)
Double line box drawing character set.

To host



Bull VIP7800

 Initial mode (character)

>> Character
>> Text 

Initially, the terminal is set to either Character or Text mode. Character and Text modes allow the host or 
user to define the screen attributes and fields that become active when Form mode is activated.

Insert mode (on)

When selected, all screen data received causes all data, line graphics and attributes from the cursor to the end of 
the line to shift right. When not selected, the data will overwrite data at the cursor position.

Roll mode (off)

This item governs the screen behavior when the cursor is on the last line of data space (which can be line 24 or 
line 72 if 72-line scroll is set) and a line feed is received. If Roll mode is on, then all data will be rolled up one 
line and the data that was on line 1 of data space is lost. Otherwise a DATA OVERFLOW error is generated on 
the status line.

Echoplex (on)

When selected, data entered at the terminal is transmitted without being displayed locally. This mode is only 
valid when in Character mode and Local mode is toggled on. When not selected, entered data is simultane-
ously displayed locally and sent to the host.

Transmit on return (off)

Provides an alternative method of transmitting data whilst in Text mode, by enabling the sending of spe-
cially-formatted data from the screen when the [RETURN] key is pressed. When this mode is disabled the 
[RETURN] acts as normal.

72-line scroll (off)

When selected this mode sets the terminal to operate with a 72 line data space instead of the standard 24 lines. 
The displayable text at any time is 24 lines, which will then scroll up and down over the 72 lines available in 
the data space.

Enable bell (on)

When selected, the bell will sound if a bell character [CTRL_G] is received from the host.
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Auto LF (off)

This option causes the [RETURN] key to generate the two bytes CR/LF, instead of the normal CR.

Space suppress (on)

This option causes the terminal to suppress trailing spaces from being sent to the host during various send 
operations. When not selected, all spaces are sent.

CR LF Delimiter (off)

This option governs whether or not a CR/LF is inserted between each line of data sent to the host during a 
send operation.

Immediate (Immediate)

>> Immediate: The cursor will immediately tab to the next unprotected field once the end of the current 
unprotected field has been reached. 

>> Delayed: The cursor will remain at the start of the next field then on the next valid keypress, the tab opera-
tion will occur.

Terminator (ETX)

The character appended to the end of data sent to the host during a send operation. Options are:

>> EOT
>> ETX

Enquiry ID (730G)

This configuration gives the user the ability to customize the first four characters sent to the host, such as dur-
ing an enquiry response. These characters act as a terminal identification string for the hosts that require cus-
tom strings to be sent.

Number of lines (Default)

The number of lines for the display. The default number of lines is 24. The Custom option allows the user to 
specify the number of lines. 

Custom page height (24)

 Enter a number from 1 to 99 to customize the number of lines.

Display 8 bit (off)

Strip 8th bit (on)



Printer

Start print CC (CR)
This option sets the combination of characters sent to the printer before a print job. Available options are:

>> CR
>> CR-LF
>> CR-FF
>> CR-VT

End print CC (CR)
This option sets the combination of characters sent to the printer after a print job. Available options are:

>> CR
>> CR-LF
>> CR-FF
>> CR-VT

PENQ Mode (off)

When selected, a receipt of a PENQ command (printer enquiry) will disable the use of the [PRINT] key. If not 
selected, then the [PRINT] key will not be disabled on receipt of a PENQ.

Print mode (All)
>> All: When selected, both unprotected and protected data is sent to the printer. 
>> Unprotected: When selected, only unprotected data is printed.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Standard map
>> Line graphics
>> To host
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Data General Series

 Options

DG Personality (DG470)
Available personality options are:

>> DG210
>> DG211
>> DG216
>> DG216E
>> DG410
>> DG411
>> DG412
>> DG460
>> DG461
>> DG462
>> DG470

Scroll mode (SCROLL) 
Available scroll modes are:

>> STOP 
>> LOOP 
>> WRAP
>> SCROLL

Show col 81 (off)
When selected the screen will show the 81st column (Applicable to DG4xx personalities only).

Data bits (8-BIT)
Available options are: 

>> 7-BIT 
>> 8-BIT

Null handling (None)
Various NULL character representations have been implemented by Data General. The default setting of None 
is almost always required, other options are Single or Double.

>> None 
>> Single
>> Double



G0 character set (US ASCII)
Available options are:

>> KEYBOARD
>> US ASCII
>> WP SET
>> LINEDRAW
>> DG INTERNAT
>> UK
>> FRENCH
>> GERMAN
>> SWED FIN
>> SPANISH
>> DAN NORW
>> SWISS
>> KATAK G0 
>> KATAK G1

G1 character set (DG INTERNAT)
Available options are:

>> KEYBOARD
>> US ASCII
>> WP SET
>> LINEDRAW
>> DG INTERNAT
>> UK
>> FRENCH
>> GERMAN
>> SWED FIN
>> SPANISH
>> DAN NORW
>> SWISS
>> KATAK G0
>> KATAK G1

Terminal mode (DG)
Available options are:

>> ANSI
>> DG

Clear screen on width change (off)
When selected, this will cause a screen clear whenever a screen change between 80 and 132 columns occurs. If 
history is enabled, the screen data will be saved to the scroll history buffer otherwise the data is lost.
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Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages: 

>> English (UK)

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Keyboard character set
>> U.S. character set
>> Word processing set
>> Line drawing characters
>> Data General International
>> United Kingdom set
>> French character set
>> German character set
>> Swedish/Finnish set
>> Spanish character set
>> Danish/Norwegian set
>> Swiss character set
>> Katakana G0 set
>> Katakana G1 set
>> To host



DEC VT Series

Display Size

Lines (24) 
Select to change between the following line modes:

>> 24
>> 36
>> 48

Columns (80) 
Select to change between the following column modes:

>> 80
>> 132

Custom Screen Size (off) 
Select to enable the custom sizes as entered in the Custom Lines and Custom Columns settings.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80) 
Enter the number of columns required.

Display Modes 

Local Echo (off)
If selected, as a character is typed on the keyboard it is immediately echoed to your screen. If disabled, the 
entered character is sent to the remote host which in turn echoes it back. On its return the character is dis-
played on your screen. In this way, passwords and other sensitive information do not appear on your screen. 

Insert Mode (off)
This mode determines how characters are added to the screen. When selected, the character is inserted at the 
cursor, moving previously displayed characters to the right. When not selected, new display characters replace 
old display characters at the current cursor position.

Autowrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

Clear using current attribute (off) 
Specifies whether a cleared character retains an attribute.
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Clear screen on size change (off)
When selected, this will cause a screen clear whenever a switch between 80 and 132 columns occurs. If history 
is enabled, the screen data is moved to the scroll history buffer, otherwise it is lost.

Character set mode (Normal)
Select between the following character set modes:

>> Normal
>> DBCS
>> UTF-8

Responses

Answerback Message ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (VT400)
Select to change between the following modes:

>> VT52
>> VT100
>> VT400

7 or 8 bit (7 Bit)
Select between 7 or 8 bit modes.

Terminal ID (VT 220) 
Select between 

>> VT100
>> VT101
>> VT102
>> VT220
>> VT240
>> VT320
>> VT340
>> VT420

Custom DA string (?64;1;2;6;7;8;9;15;21) 
Enter your custom DA string.

Use Custom DA string (off) 
Select to enable the Custom DA string function.



Keyboard Configuration

Keypad Mode (Application) 
Select between Application and Numeric keypad state. 

>> Application: Selects application keypad mode. The keypad generates application control functions.
>> Numeric: Selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

Cursor Keys (Normal)
The characters generated by the cursor keys depend on the state of the Cursor Keys mode. 

>> Normal: Causes the cursor keys to generate ANSI cursor control sequences.
>> Application: Causes the cursor keys to generate application control functions.

Keyboard Locked (off) 
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off) 
When selected, this causes a received [RETURN] to transmit as both a CR and a LF. When not selected and a 
[RETURN] is received only a CR is transmitted. 

User defined keys locked (off)  
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
To unlock the keys you must either deselect user defined keys locked option or a reset is required.

Compose Enabled (off) 
A compose sequence is a series of two or three keystrokes that produce a single character. Pressing the 
[COMPOSE CHARACTER] key starts the compose sequence.

Macros ignore keyboard lock state (off)
When selected macros will ignore the keyboard lock state, sending data to the host even if the keyboard is locked.

Advanced

Print Region (Print Region) 
Select from the following options: 

>> Print Region: to send just the selected region to the printer 
>> Print Screen: to send entire screen contents to printer. 

Print Form Feed (off) 
Send a form feed character at the end of the print job.
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Status Display (None)
>> None: The status line is not displayed. 
>> Indicator: The status display is always visible.
>> Host writable: Host applications can write messages in place of the status line. 

Tilda and Left Quote key (Sends escape) 
This option allows the user to define the TILDA/LEFT QUOTE key (i.e., ~/‘ key) to operate either as normal 
or as an escape key sequence. 

>> Sends escape: Redefine the TILDA/LEFT QUOTE key to send an escape key sequence.
>> Sends tilda/left quote: Leave the TILDA/LEFT QUOTE key as normal, i.e., left quote and with the 
SHIFT key, tilda.

User preferred Character Set (DEC Supplemental)
There are two 8-bit character sets and both include the standard ASCII character set and a supplemental set. 

>> DEC Supplemental: DEC Multinational set
>> ISO Latin

Miscellaneous

No Numeric Key Map (off)
Disables application and numeric mode for the numeric keypad.

StripCharValue (242)
xxx

Strip Printing (off)
xxx

StripSingleChar (off)
xxx

Wang Private Keys (off)
xxx

Reset Clear (off) 
Reset clears the terminal screen.

FavourDiacritics (off)
When enabled uses European characters rather than line draw characters.

Disable ModeN Bits Sequences (off) 
xxx 

CodePage (950) 
Sets the code page to be used when DBCS is enabled. See also Inputmode



BackspaceOn (off)
xxx 

New Line Mode (off)
When set, LF’s will act as New Line instead of Line Feed 

Character Mapping

Language Name () 
Selecting this option presents a drop-down menu of languages: 

>> English
>> English (UK)
>> Dutch
>> Finnish
>> French
>> French/Canadian
>> German
>> Greek
>> Italian
>> Norwegian/Danish
>> Spanish
>> Swiss
>> Swedish
>> Cyrillic
>> Croatian

Character Sets
>> HostsNational
>> ASCII
>> ASCII (8-bit)
>> DEC Special Graphics
>> DEC Supplemental
>> ISO Latin Supplemental
>> DEC Technical
>> To host
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Fujitsu 6681

Configuration options for the Fujitsu 6681 terminal are covered by the IBM 3270 
emulation. Select this emulation and refer to the section on IBM 3270 configura-
tion in this chapter for more detail.



HP Series

HP Model (MODEL_70092)

Select a Hewlett Packard terminal model. Available options are:

>> MODEL_2392A
>> MODEL_70092
>> MODEL_70094

Display Width (80 column) 

Select from the two available options:

>> 80 column 
>> 132 column

Main

User Terminal ID (70092) 
Select from the two available options:

>> 2392A
>> 70092

Field separator char (31)
Must be an ASCII character. When you press the [ENTER] key while the terminal is in block page mode and 
display memory contains a formatted display, the terminal automatically transmits the specified field separator 
character at the end of each protected field (except the final one). 

Block terminator char (30)
Can be any ASCII character. For data transfers between the terminal and a host computer, the terminal trans-
mits the specified block terminator character at the end of the transfer operation. 

Local echo (off)
If selected, characters entered through the keyboard are displayed on the screen and transmitted to the host 
computer. When not selected, characters entered through the keyboard are transmitted to the host computer 
only. If they are to appear on the screen, the host computer must echo them back to the terminal. 

XmitFnctn (0)
This field specifies whether the escape code functions are both executed at the terminal and transmitted to the 
host computer.

Inh Hnd Shk (off)
See InhDC2.
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CAPS locked (off)
This field specifies whether the terminal generates the full 128 character ASCII set or only the Teletype-
compatible codes.

Space overwrites/advances (off)
This field specifies whether or not spaces entered through the keyboard will overwrite existing characters.

InhDC2 (off)
Together, Inh Hnd Shk and InhDC2 fields determine what type of handshaking is to be used when transfer-
ring blocks of data from the terminal to the host computer.

Inh EOLWrap (off)
This field specifies whether or not the end-of-line wrap is inhibited.

Esc Xfer (0)
This field controls the transfer of escape sequences to a printer and has no effect if there is no second port. 

Margin bell (off)
This specifies whether the terminal's bell is enabled or disabled. If not selected, the bell will still sound in 
response to an ASCII Bell control code (decimal 7, [CTRL_G]).

Start Col (1)
This is a value in the range 1 – 80. 

Line/Page (Line)
This field specifies whether or not the terminal, when operating in Block mode, will transmit data a line at a 
time or a page at a time.

Modes

LF to CR/LF (on)
Converts a LF to a CR/LF. 

Smooth scroll (0) 
When selected (1), rolling data up and down the screen is done smoothly. When not selected (0), the scroll 
jumps a line at a time. 

Auto linefeed (0)
When selected a line feed control code is automatically appended to each carriage return control code generated 
through the keyboard.

Enq ACK (1)
When selected, all ENQ characters from the incoming data are stripped off and in turn responds by transmitting 
an ACK. When deselected, all incoming characters (including ENQ and ACK but excluding NULLS and DELS) 
are treated as data bytes, NULLS and DELS are stripped from the incoming data.



Insert mode (0)
This option determines how characters are added to the screen. When selected, the character is inserted at 
the cursor, moving previously displayed characters to the right. When not selected, new characters replace old 
characters at the cursor position. 

Format (0)
When selected, the terminal user can only enter data into unprotected fields. 

LineModify (0)
When the terminal is in Remote mode and Character mode and you are communicating interactively with a 
host computer, you may sometimes enter an erroneous command string to which the computer responds with 
an error message. If the command string is a lengthy one and the error consists of only a few characters, it is a 
nuisance to have to retype the entire string. In such a case, you may instead enable Line modify mode (which 
temporarily switches the terminal to a special form of Block mode). You can then move the cursor to the 
erroneous line on the display and correct the command string. When the string is edited to your satisfaction, 
you retransmit the line to the host computer by pressing either the [ENTER] key or the [RETURN] key. Line 
modify is automatically disabled when you press either [ENTER] or [RETURN]. 

ModifyAll (0)
When the terminal is in Character mode, you can enable ModifyAll, which switches the terminal to a special 
form of Block mode. Modify All is the same as Line Modify except that it is NOT disabled when you press 
[ENTER] or [RETURN]. 

Block mode (0)
When not selected, the terminal operates in Character mode. In Character mode, data is transmitted a char-
acter at a time as it is entered through the keyboard. Control codes (such as CR and LF) are also transmitted. 
When selected, the terminal operates in Block mode. In Block mode, data is NOT transmitted at the time it 
is entered through the keyboard. Instead, you transmit an entire block of data by first typing the data and then 
pressing the [ENTER] key. When the terminal is in Block mode, control codes (such as CR and LF) are acted 
upon locally but NOT transmitted with the data block. 

Remote (1)
When selected, if you press an alphanumeric key the associated character code is transmitted to the host com-
puter. When not selected (Local mode), if you press an alphanumeric key the associated character is displayed 
at the current cursor position on the screen. Nothing is transmitted to the host computer. 

Display Fns (0)
When selected, the terminal operates as follows In Local mode, it displays control codes and escape sequences 
but does not execute them. In Remote mode, it transmits control codes and escape sequences but does not 
execute them locally. 

Record (0)
Record mode copies from the host to the selected destination (to) device, e.g., an external printer. When the 
Record mode is not selected, the contents of a partially filled buffer will be sent to the destination device(s). 
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Log Bottom (0)
Logging is a mechanism whereby data can be automatically routed to an external device e.g., a printer. With 
bottom logging, each time the cursor moves from one line to another, the line from which the cursor moved is 
sent to the external device. 

Log Top (0)
When the display memory is full and another line of data is entered, the top line in the display is purged to 
make room for the new line. With top logging, each purged line is sent to the external device. Thus, while the 
line is lost from display memory, it is maintained in hard copy form. 

Send cursor pos (off)
When selected, if the [ENTER] key, [SELECT] or a user defined key (set to transmit) is pressed, the current 
cursor position is sent to the computer. 

Auto Kbd Lock (off)
When a terminal is connected to a packet switching network (using X.25 protocol) via a controller/multiplexer, 
it is necessary to ensure that the packet sent is received and acted upon before another is sent (from the termi-
nal). In order to achieve this, the keyboard must automatically lock, in such a way that it can only be unlocked 
by the receiving host. 

No Term On Send Page Format (off)
xxx 

Type-ahead (on) 
While the keyboard is locked, keystrokes are stored and released when the keyboard is Unlocked.

Type-ahead limit (100) 
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is 
resumed.

Type-ahead delay (0)
This setting gives the delay between each key when the type-ahead buffer is purged; i.e. its contents sent to the 
host. Measured in milliseconds.

Host Prompt Text (17) 
Decimal ASCII character value used by the host prompt. 

Enable host-prompt (on)
Uses a host originated user-definable character value to release the keystrokes, stored previously via Type-
ahead.

Return Is Enter (0) 
This is the flag to make the [RETURN] key (on main keyboard) act like the [ENTER] key (num pad). 

ReturnDefn (\r)
Sets the character string assigned to the [RETURN] virtual key using the TTWin string parsing language. 
Limited to a maximum of 2 characters, and if no string is provided then defaults to \r (carriage return).



TAB is spaces (off)
When selected, the [TAB] virtual key produces the number of spaces required to reach the next tab stop to 
the right. When not selected, the [TAB] key behaves as normal, (i.e., sends a tab character). Similarly, this flag 
causes [BACK TAB] to send out the required number of backspace characters (^H) to reach the nearest tab 
stop to the left. 

Numpad Tab (Tab)
Configure the numpad [TAB] virtual key to behave as one of the following virtual keys: 

>> Tab
>> Return
>> Enter

Destructive backspace (off)
With Destructive Backspace, pressing [BACKSPACE] moves the cursor back one character and clears the char-
acter. Normally, [BACKSPACE] moves the cursor back one character but the character is not cleared.

Set Hard Key Default (off)
xxx 

Disable block-mode (on)
When not selected, the terminal operates in Character mode. In Character mode, data is transmitted a char-
acter at a time as it is entered through the keyboard. Control codes (such as CR and LF) are also transmitted. 
When selected, the terminal operates in Block mode. In Block mode, data is NOT transmitted at the time it 
is entered through the keyboard. Instead, you transmit an entire block of data by first typing the data and then 
pressing the [ENTER] key. When the terminal is in Block mode, control codes (such as CR and LF) are acted 
upon locally but NOT transmitted with the data block.

8-Bit mode (on)
This enables 8 bit data input streams.

SerialNumber1 (TTWIN HP.)
xxx 

SerialNumber2 (TTWIN HPSER)
xxx 

SerialNumber3 (TTWIN HPSERIES)
xxx 
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Function keys

This option allows the user to assign functions and labels of their choosing to the first eight function keys. 

F1-F8 
Give the command to be executed when the appropriate function key is pressed. Each function key can be 
assigned a definition string or macro of up to 80 characters.

F1-F8 Attribute (Normal) 
The attribute is selected from the following options:

>> Normal: The key definition string acts as data entered normally from the keyboard. 
>> Transmit: For transmission only. The key definition string is sent to the host. It is not echoed locally. 
>> Local: For local use only. The key definition string is sent to the screen. It is not transmitted to the host.

F1-F8 Label 1 (“”) 
Specify the first line of text to appear on the displayed key. 

F1-F8 Label 2 (“        “) 
Specify the second line of text to appear on the displayed key.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages: 

>> Danish
>> Dutch
>> English
>> English (UK)
>> Finnish
>> French
>> French/Flemish
>> French/Canadian
>> German
>> Italian
>> Norwegian
>> Spanish - European
>> Spanish - Latin
>> Swedish
>> Swiss French/German.

Character Sets
>> Standard map
>> Line drawing characters
>> Display functions map
>> ASCII
>> Special graphics
>> To host



IBM 3101 and IBM 3151

Display Mode

Personality(IBM3151)
Available personalities are: 

>> IBM3101
>> IBM3151

Size (24x80)
Available options are:

>> 24x80
>> 24x132
>> 25x80
>> 25x132
>> Custom: uses the width and height as defined in the Custom Height and Custom Width settings.

Custom Height (24)
Enter the number of rows required.

Custom Width (80)
Enter the number of columns required.

General

Auto LF (off)
When selected, a linefeed is generated automatically when a carriage return is received. That is, both a car-
riage return and linefeed are sent to the screen. When not selected, only a carriage return is sent when one is 
received.

Line Wrap (off)
When selected, if the current cursor position is on the last column of the screen, the cursor will be moved to 
the first column of the next. When not selected, then the cursor will not move and incoming characters will 
overwrite the last column on the screen.

Force Insert Line (on)
When selected, and there is no room to insert a NULL line, the rest of the screen will be scrolled down when 
an insert line operation is requested. When not selected then the insert line request is ignored if there is no 
room.

Force Insert Char (on)
When selected and there is no room to insert a character, then space is created for the character by moving the 
rest of the line right. If Line Wrap is OFF or ON then the last character is dropped from either the field or 
the page. When not selected and there is no room to satisfy a request to insert a character then the request is 
ignored.
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Send NULL (off)
When selected trailing NULLs are converted to blanks when sent to the host. When not selected trailing NULLs 
are not sent to the host.

Lock Keep MDT (on)
If selected then after performing the send function MDT bit @ SEND, the MDT bit is not reset and the key-
board is locked. The only key enabled after this is the [RESET] key. If not selected then the MDT bit is reset 
to 0.

Enable Transparent (on)
xxx

G0 Character Map (ASCII)
Select from the following options:

>> ASCII
>> Special graphics
>> Auxiliary Page 1
>> Auxiliary Page 2

G1 Character Map (Special Graphics)
Select from the following options:

>> ASCII
>> Special graphics
>> Auxiliary Page 1
>> Auxiliary Page 2

Terminal ID ()
This can be set to any string (of up to 20 characters in length) you choose and is used by the host to identify 
the terminal.

Advanced

Operating mode (Echo)
>> Char: Sends the character to the host and to the screen at the same time.
>> Block: This option only updates the screen. The data from the screen is sent to the host only when request-
ed by pressing the [SEND] keys or on request from the host via a READ command.

>> Echo: Sends the character only to the host. The host then echoes the character to the screen.

Vert scroll mode (Scroll)
The scroll function relates to what happens when a linefeed is received and the cursor is on the last line of the 
screen.

>> Scroll: When selected, the screen is scrolled up.
>> Loop: When selected, the cursor is sent to the top of the screen.



LF char (LF)
>> LF: When selected and a linefeed is entered or received, the cursor will move to the same column on the 
next line.

>> CR: When selected and a linefeed is entered or received, the cursor will move to the first column on the 
next line.

Send Data Format (<Text><LTA>)
>> <Text><LTA>: When selected and the [SEND] key is pressed, both text and the LTA (line turnaround) 
character are sent to the host.

>> <AID><LTA>: The identification character followed by the line terminator is sent to the host when a 
[SEND] key is pressed.

Turnaround char (13)
This is used to set your line turnaround character. This character is sent to the host at the end of a data stream 
when a [SEND] key is pressed. The default is ASCII character 13.

Send Line (off)
xxx

Short Model Response (T)
Used to obtain the basic terminal characteristics.

XT Model Response (&(! B)
This command is used when additional information is required on the 3151. Refer to the IBM3151 Reference 
manual for further details.

Pass-through:
Aux Port Settings
Defines the settings to be used when pass-through data is passed to the Aux port.

Aux Port (COM1)
This is used to nominate the port to which Auxiliary devices are attached. The format of the entry 
should be the same as used in the Windows environment. For example, “COM2”, “SERDEVØ1”.

Baud Rate (9600)

Data Format

Byte Size (8) 
Stop Bits (1)
Partity (none)
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Pass-out device (Aux printer)
>> None: No pass-through printer attached.
>> AUX printer: Data is directed to the device attached to the AUX port specified above. 
>> TTWIN Printer: Data is directed to the currently selected printer. This may be altered using the File > 
Print Setup... command

Pass-out Local LF expansion (on)
Used to toggle LF to CR/LF.

Aux Input device (None) 
This is used to nominate the type of device attached as inbound passthrough data source.

>> None: No device attached. 
>> Dynjab DVR: The inbound data will be created using a Dynjab Document Verification Reader.

Character set mode (Normal)
Select between the following character set modes:

>> Normal
>> DBCS
>> UTF-8

Code Page (950)
Sets the code page to be used when DBCS is enabled.

Keyboard

Tab key (Field)
Available options are:

>> Field
>> Column

Send key (Page)
Available options are: 

>> Page
>> Line

Enter key (Return)
Available options are: 

>> Return
>> Send



Return key (Field)
Available options are: 

>> Field
>> Newline

Newline key (CR)
Available options are 

>> CR
>> CR/LF

Insert key (Toggles insert/replace mode) 
Available options are:

>> Insert SPACE
>> Toggles insert/replace mode

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages: 

>> Multinational

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII control characters
>> Delete character
>> ASCII
>> Special graphics
>> Auxiliary Page 1
>> Auxiliary Page 2
>> To host
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IBM 3164 Color

Display Size

Width (80x24)
Available options are:

>> 80x24
>> 132x24

Custom: uses the width and height as defined in the Custom Columns and Custom Lines settings.

Custom Columns (80)
Enter the number of columns required.

Custom Lines (24)
Enter the number of lines required.

General:

Line wrap (1)
When selected and the current cursor position is on the last column of the screen, the cursor will be moved to 
the first column of the next. If not selected, the cursor will not move and incoming characters will overwrite 
the last column on the screen.

Auto LF (off)
When selected, a linefeed is generated automatically when a carriage return is received. That is, both a car-
riage return and linefeed are sent to the screen. When not selected, only a carriage return is sent when one is 
received.

Send NULL (off)
When selected trailing NULLs are converted to blanks when sent to the host. When not selected trailing NULLs 
are not sent to the host.

Disable Set Field (off)
When selected, field attributes can not be modified by the operator. When not selected, they can be modified.

Enable transparent (on)
This controls whether or not the operator can switch to transparent mode by entering a DLE sequence from 
the keyboard.

Enable Prog Colors (on)
When not selected the terminal can display only the default colors of an IBM3164 terminal which are green, 
blue, red and white. When selected the emulation can also display black, yellow, magenta and turquoise.

Terminal ID ()
This can be set to a string (up to 20 characters in length) that the host can use to identify the IBM3164 terminal.



Trace send (on)
xxx

Trace receive (on)
xxx

Lock keep MDT (on)
xxx

Keyboard

TAB (Field)
>> Field: When selected the tab stop positions defined by the field attribute character are used, instead of the 
column tab definitions.

>> Column: When selected the column tab stop positions are used, instead of the field tab stop positions.

SEND (Page)
>> Page: When selected and the [SEND] key is pressed, the contents of the current page will be sent to the 
host. When selected and the [SEND LINE] key is pressed then contents of the current line are sent to the 
host.

>> Line: When selected, the [SEND] key will send the contents of the current line and the [SEND LINE] 
key will send the contents of the current page.

ENTER (Return)
This enables you to define the [ENTER] key as either a [SEND] or [RETURN] key.

RETURN (Field)
Available options are:

>> Field
>> New line

NEWLINE (CR)
>> CR: Pressing the [RETURN] key will send only a carriage return when this is set to CR.
>> CR/LF: When set to CR/LF it will also send a linefeed.

PRINT (Page)
This controls whether the contents of the page, screen or viewport are sent to the printer when the [PRINT] 
key is pressed.

INSERT (Toggle)
>> Toggle: When selected, pressing the [INSERT] key will cause the terminal to go into Insert mode.
>> Ins SP: When selected, pressing the [INSERT] key will insert a space character after the current cursor 
position.
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Advanced

Scroll mode (Loop)
The scroll function relates to what happens if a linefeed is received when the cursor is on the last line of the 
screen.

>> OFF: When selected, the display does not scroll. 
>> Scroll: When selected, the screen is scrolled up.
>> Loop: When selected, the cursor is sent to the top of the screen.

Operating mode (Echo)
This determines what happens when a key is pressed.

>> Character: Sends the character to the host and to the screen at the same time.
>> Block: This option only updates the screen. The data from the screen is sent to the host only when request-
ed by pressing the [SEND] key or on request from the host via a READ command.

>> Echo: Sends the character only to the host. The host then echoes the character to the screen.

Line end (CR/LF)
>> CR: When selected, pressing the [RETURN] key will send only a carriage return.
>> CR/LF: When selected, pressing the [RETURN] key will send a linefeed and a carriage return.

Send format (Text[LTA])
>> Text[LTA]: When selected and the [SEND] key is pressed, both text and the LTA (line turnaround) charac-
ter are sent to the host

>> AID[LTA]: Otherwise, it sends only the identification character followed by the line terminator.

LTA (turnaround) char (CR)
This is used to set your line turnaround character. This character is sent to the host at the end of a data stream 
when a [SEND] key is pressed. Options are: 

>> CR
>> EOT
>> ETX
>> DC3

Controls

Print NULL (on)
When selected, trailing NULLs are converted into blanks and sent to the printer when a print is requested. 
When not selected, trailing NULLs are not sent to the printer.

Print EOL (on)
When selected the defined line end character is sent to the printer at the end of each printed line. (See also 
Line end.)

Default FA (on)
Default field attribute enable.



ASCII LF ctrl (off)
If this is selected, receiving a linefeed from either the host or the keyboard will also generate a carriage return. 
That is, the cursor will move to the first column of the next line. When not selected, the cursor will just move 
down one line.

Number of Time Fill chars (0)
May be set to 0, 1, 2 or 3. This enables you to set the number of time fill characters (DELs) at the end of each 
line that are sent to the printer.

Character Mapping

Language Name () 
Selecting this option presents a drop-down menu of languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII control characters
>> Delete character
>> ASCII
>> Special graphics
>> Alternate characters
>> To host
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IBM 3270

Users needing a configuration to match IRMA hardware cards will find a precon-
figured session file (.TWC) in their default install directory. To load this configura-
tion choose File > Open configuration... from the program menu and select 
IRMA.TWC

For Express Logon Feature (ELF) configuration for TN3270e sessions refer to Telnet 
SSL options in Chapter 19 - Comms.

Models

Model (IBM 3279-2 24x80) 
The following Fujitsu and IBM terminals are supported

>> IBM 3278-2 	 24 x 80 display
>> IBM 3278-3	 32 x 80 display
>> IBM 3278-4	 43 x 80 display
>> IBM 3278-5	 27 x 132 display
>> IBM 3279-2	 24 x 80 display
>> IBM 3279-3	 32 x 80 display
>> IBM 3279-4	 43 x 80 display
>> IBM 3279-5	 27 x 132 display
>> IBM DYNAMIC 	 62 x 160 display
>> Fujitsu 6681-2	 24 x 80 display
>> Fujitsu 6681-3	 32 x 80 display
>> Fujitsu 6681-4	 43 x 80 display
>> Fujitsu 6681-5	 27 x 132 display
>> Fujitsu 6681-6	 27 x 136 display

IBM3270 DYNAMIC Custom Screen Size
Primary screen rows (24)
Primary screen columns (80)
Alternate screen rows (62)
Alternate screen columns (160)

IBM3270
Extended Attributes (off) 
Select to enable additional terminal characteristics.



Fujitsu 
Mode (Mode 2) 
This is dependent upon your host system and affects the handling of colors. Select between mode 1 and 2.

Log Mode ID () 
This is a two-digit number used by the host. It is required for the Telnet setup and it MUST come from 
your systems administrator.

Extended Data Stream (off)

Colors

IBM3270 Default Colors 
Available colors are Black, Blue, Red, Pink, Green, Turquoise, Yellow, Deep Blue, Orange, Purple, Pale Green, 
Pale Turquoise, Gray, White.

Alpha (Green)
Protected (Blue)
Numeric (Green)
Protected Numeric (Blue)
Highlight Alpha (Red)
Highlight Protected Alpha (White)
Highlight Numeric (Red)
Highlight Protected Numeric (White)

Fujitsu Colors 
Available colors are Black, Blue, Red, Pink, Green, Turquoise, Yellow, Deep Blue, Orange, Purple, Pale Green, 
Pale Turquoise, Gray, White.

Green (Green)
Red (Red)
White (White) 

Status Bar Colors 
Color settings for the 3270 status bar.

Foreground color (Black)
Background color (Cyan)

Advanced 

Status Line Display (Plain)
There are three possible status lines settings:

>> Plain
>> Average response
>> Last response
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Enable ‘dot’ facility (off)
This option places a dot in input fields for every character.

Word Wrap Enabled (off)
Determines whether or not this capability is permitted. Word wrapping is available in DBCS mode only.

Word Wrap (on)
When set to on this enables word wrapping in multiline fields. When it is disabled words spanning two lines 
are moved to the start of a new line in a multiple line field. For this setting to be honored Word Wrap Enabled 
must be set to on.

Enable TypeAhead (off)
While the keyboard is locked, keystrokes are stored and released when the keyboard is unlocked.

TypeAhead Size (100)
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is resumed.

DBCS Enabled (off)
Select to enable DBCS support (Double Byte Character Set).

Code Page (37(US))
Select from a list of supported Code Pages:

>> 37(US)
>> 273(Austria/Germany)
>> 277(Denmark/Norway)
>> 278(Finland/Sweden)
>> 280(Italy)
>> 284(Spain)
>> 285(UK)
>> 297(France)
>> 420(Arabic Bilingual) 
>> 423(Greek)
>> 424(Hebrew)
>> 500(International)
>> 833(Korean Extended)
>> 870(Latin2 Poland/Romania/Slovakia/Slovenia)
>> 871(Iceland)
>> 875(Greece)
>> 880(Cyrillic Russian)
>> 924(Multinational ISO Euro)
>> 930(Japanese)
>> 930(Japanese - Extended Katakana)
>> 939(Japanese - Extended English)
>> 1025(Cyrillic Belarus/Bulgaria/FYR Macedonia)
>> 1026(Latin 5 Turkey)
>> 1047(US Open Systems)
>> 1140(Euro Belgium/Brazil/Canada-Bilingual/Netherlands)



>> 1141(Euro Austria/Germany)
>> 1142(Euro Denmark/Norway)
>> 1143(Euro Finland/Sweden)
>> 1144(Euro Italy)
>> 1145(Euro Spain)
>> 1146(Euro UK)
>> 1147(Euro France)
>> 1148(Euro International)
>> 1149(Euro Iceland)
>> 1155(Euro Latvia Latin 5/Lithuania/Turkey)
>> 2975(Czech)
>> 2978(Poland)
>> 2979(Russian)
>> 37/2(US)

Use JIS 78 (Japanese DBCS Mode) (off)
Select this option to use JIS 78 character mode.

DBCS/SBCS input mode follows screen data (on)
By default TTWin will automatically toggle DBCS/SBCS mode depending on the type of field that cursor is 
currently positioned in. This option allows automatic DBCS/SBCS mode toggle to be disabled.

Map Backslash to Yen (for Japanese) (on)
The backslash key is mapped to the Yen character for usage on Japanese host systems.

Miscellaneous
Use Alternate Addressing (off)
Changes the way TTWin performs cursor addressing.

Use TTWin classic 3270 Status Line (off)
Utilize old style TTWin 3270 Status Line display.

Screen Size Switching (off)
Controls whether screen size changing is permitted.

Start With Model Size (off)
If selected the TTWin will connect using the selected model size instead of 24x80.

Terminal Reset Clears Screen (off)
If selected the screen will be cleared and the cursor is placed in the home position.

ClearPadding (off)
This setting determines if a clear is performed using a clearpad character.

ClearPad (0)
The character used for padding. To be employed this setting requires the ClearPadding to be set to on.
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Insert Mode is Persistent (on)
This option maintains the current insert mode when moving between fields. When this is setting is disabled 
the insert is turned off on entering a new field.

Destructive Backspace (off)
With Destructive Backspace, pressing [BACKSPACE] moves the cursor back one character and clears the 
character. Normally, [BACKSPACE] moves the cursor back one character but the character is not cleared.

Honor Numeric Field Type (off)
When set to off TTWin will allow any input in a field designated as numeric by the host. 

Lock the keyboard when inserting in a full field (off)
When inserting text and the field becomes full the keyboard will lock

Create Debug Log (off)
Select this to enable the log file capture.

Debug Log File (c:\ibm3270.log)
Selecting the Debug file command activates the Browse tile. Enter or select the name of the file to which 
you wish to save the debug information to.

Clipboard

Paste
Enable Advanced Pasting (off)
Advanced pasting options for IBM3270.

After Paste Reset Cursor To Start Position (on)
Cursor remains at current location after paste.

Clear to End of Field after Paste (off)
Clears text from the last pasted character to the end of field.

Wrap text to next field (off)
Text that runs past the end of a field starts filling in the next field.

Wrap to field below (off)
Text that runs past the end of a field, moves to the next line.

Align text to input fields (off)
A New-Line in pasted text will go to the next field instead of the next line.

Use field delimiters (off)
When a New-Line lands in a protected position, it tabs to the next field.



Replace Tabs (off)
Replaces tab characters in the paste text with the text from Replace Tabs With.

Replace Tabs With ()
Character to use instead of Tab. Replace Tabs must be set to on.

Printer

These settings link a 3270 host session to an associated IBM 3287 printer session. For more information refer 
to the IBM 3287 section of this chapter.

Use Associated Printer(off)
Set to on if a IBM 3287 printer emulation is to be used in conjunction with your 3270 host session.

Printer Session ()
Browse to a TTWin configuration file (.twc) specifying the associated 3287 session. 

Character Mapping

Language Name () 
Selecting this option presents a drop-down menu of languages: 

>> English (US)
>> English (UK)
>> Austrian/German
>> Belgian
>> Canadian (French)
>> Danish/Norwegian
>> Finnish/Swedish
>> French
>> Greek
>> International
>> Italian
>> Japanese (English)
>> Spanish
>> Spanish Speaking

Character Sets
>> Standard character set
>> Graphics character set
>> ASCII to EBCDIC
>> EBCDIC to ASCII
>> To host
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IBM 3287 (IBM Printer)
The IBM 3287 is a 3270-data-stream color printer, designed to be used in conjunction with TTWin's IBM 
3270 emulation.

Printer Output
Specify the print destination. Options are:

>> Printer
>> Text File

Text File Printer
When the Printer Output options is set to Text File, these configuration options define the output file.

Prompt for file name (on)
When set to on, the user is prompted for a file name as each print job is output.

Print Directory ()
Specify the default directory destination for text file output. If no path is supplied output is directed to the 
Documents directory.

Base File Name (IBM3287)
Specify the default file prefix for the text file output. To differentiate printer file output a timestamp is 
appended to the base file name along with a .TXT extension.

PDT Printing
A PDT, or Printer Definition Table, is a file that is used to translate the IBM 3270 host datastream into a for-
mat suitable for outputting to a Windows printer, bypassing the Windows print driver. Each Printer Definition 
Table is created from the PDF, or Printer Definition File, specified in the setting below. 

Use PDT (off)
Enable Printer Definition Tables. PDTs are disabled by default.

PDF to use ()
Select the Printer Definition File specific to the output printer. Click the Browse button to open a file 
browser.

Print to file? (off)
When selected a print file is created in Print Directory.

Print Directory ()
Select the printer directory to use when Print to File is enabled.

DBCS Enabled (off)
For use with Double Byte Character System sessions.



Code Page (37(US))
Select from a list of supported Code Pages:

>> 37(US)
>> 273(Austria/Germany)
>> 277(Denmark/Norway)
>> 278(Finland/Sweden)
>> 280(Italy)
>> 284(Spain)
>> 285(UK)
>> 297(France)
>> 420(Arabic Bilingual) 
>> 423(Greek)
>> 424(Hebrew)
>> 500(International)
>> 833(Korean Extended)
>> 870(Latin2 Poland/Romania/Slovakia/Slovenia)
>> 871(Iceland)
>> 875(Greece)
>> 880(Cyrillic Russian)
>> 924(Multinational ISO Euro)
>> 930(Japanese)
>> 930(Japanese - Extended Katakana)
>> 939(Japanese - Extended English)
>> 1025(Cyrillic Belarus/Bulgaria/FYR Macedonia)
>> 1026(Latin 5 Turkey)
>> 1047(US Open Systems)
>> 1140(Euro Belgium/Brazil/Canada-Bilingual/Netherlands)
>> 1141(Euro Austria/Germany)
>> 1142(Euro Denmark/Norway)
>> 1143(Euro Finland/Sweden)
>> 1144(Euro Italy)
>> 1145(Euro Spain)
>> 1146(Euro UK)
>> 1147(Euro France)
>> 1148(Euro International)
>> 1149(Euro Iceland)
>> 1155(Euro Latvia Latin 5/Lithuania/Turkey)
>> 2975(Czech)
>> 2978(Poland)
>> 2979(Russian)
>> 37/2(US)

Use JIS 78 (Japanese DBCS Mode) (off)
Select this option to use JIS 78 character mode.
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Diagnostic

Create Debug Log (off)
Select this to enable the log file capture.

Debug Log File (c:\ibm3287.log)
Selecting the Debug file command activates the Browse tile. Enter or select the name of the file to which 
you wish to save the debug information to.

Function Keys

When initiated the IBM 3287 terminal display shows printer status messages such as the LU Name, the 
number of total pages and jobs spooled. The printer can be further configured through function key options 
F1 through F6.

Hold (F1)
Pauses the current print job. This option is only valid when printing is active.

PA1 (F2)
When in a Hold condition pressing F2 will send a Program Attention signal to the host.

PA2 (F3)
When in a Hold condition pressing F3 will send a Program Attention signal to the host.

Cancel (F4)
When in a Hold condition pressing F4 sends a Cancel Print message to the host and the print buffer is cleared, 
halting  the current print job.

FF (F5)
Form feed. When in a Hold condition the page will be advanced until the first print line of the next page is 
reached.



Config (F6)
Opens the IBM Printer tile with extended configuration options.

.

Figure 18.7 IBM3287 Printer Configuration tile.

IBM Printer Configuration Tile

Page Setup (portrait)
This page orientation will match the setting as defined in File> Print setup.

Font (Courier New)
This font value is fixed to a standard monospace font such as Courier New.

Size (6)
Set a font size in points.

User CPL/LPP (characters per line, lines per page)

Characters Per Line (80)
Set the number of characters per line. A maximum value is suggested based on the font size selected in Size.

Lines Per Page (66)
Set the number of lines per printed page. A maximum value is suggested based on the font size selected in 
Size.

Continue Long Lines (off)
When set to on, long lines that extend beyond the right page boundary are wrapped. When set to off they 
are truncated.
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Continue Long Pages (on)
When set to on, long pages that extend beyond the page edge boundary are continued on the following 
page. When set to off they are truncated.

Margins (centimeters)
Set margins in centimeters for the printed page. Valid settings are from .10 cm to 20 cm.

Best Fit
The Set Best Fitting Font button will automatically adjust the font Size to suit your selected Lines Per 
Page, Characters Per Line and Margin settings.

.

Figure 18.8 IBM3287 Printer Configuration tile.



Advanced...

Text/Output Options

All Caps (off)
When selected all printer output is converted to upper case.

Proportionally space lines(off), 
When set to on, lines are spaced proportionally to fill the available page space.

Proportionally space characters (off) 
When set to on, characters are equally spaced to fill the entire line space.

Inhibit spooler job separator(on) 
Disable separator printing between consecutive print jobs.

SCS Host Formatting Options
Handling options for SNA Character String (SCS) host formatting. Valid options are:

>> Ignore host formatting 
>> Apply host formatting
>> Apply and Save host formatting

Print Buffer Flush Control (10 seconds)
Period in seconds, after which the print buffer is flushed if a print job has started and there is no activity from 
the host.

Position Paper
Select a row and column position for the top left of the page. The default is Row 1, Column 1.

Message to Print
Enter text at this item to be printed as a test page.

Print a Test Page
Prints a test page to the default printer as defined in File > Print Setup.
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Initiating a 3287 Session

An IBM 3287 printing session works in conjunction with IBM 3270 host session. To make use of the printer 
emulation TTWin requires a 3270 and a 3287 session to be simultaneously open.  To configure TTWin to auto-
matically initiate the 3287 session when you connect to a host via 3270, follow these steps: 

1	Open a new session by selecting File > New session

2	Selecting the IBM 3287 emulation module under Configure > Emulation... and click OK.

3	Configure the communications by selecting the Telnet option under Configure > Comms. For more 
information on configuring communications protocol settings refer to Chapter 17 - Communications.

Ensure that the Telnet module is configured to use TN3270e (this is the default 
and must remain selected.) TN3270e is required for printer communications. 

4	 In the Telnet settings listing enter a name under Telnet > Connection > Associate. 

5	Click OK.

6	Select File >  Save Configuration as...   and save the session configuration file (.twc) to your local drive 
with a unique name. For more information on saving settings refer to Chapter 2 - Getting Started.Open a 
second session by selecting File > New session and configure it to use Telnet and an IBM 3270 emulation 
under Configure > Emulation.

Again, ensure that the Telnet module on your 3270 session is configured to use 
TN3270e (this is the default and must remain selected.) TN3270e is required for 
printer communications.

7	 In the 3270 emulation settings, check the box next to Printer > Use Associated Printer.

8	Under Printer Session, browse to the .twc file you created in step 6.

0 Select File >  Save Configuration as... and save the session configuration file (.twc) to your local drive 
with a unique name.

Now, when selecting Action > Connect to connect to a host system using this 3270 session a second, associ-
ated 3287 session will be opened automatically using the settings specified in your saved configuration.

An alternate option is to specify an LU under the Telnet settings on your 3287 session. Connect this 3287 
session to your host first and open a subsequent 3270 host session. Specify the LU of your 3287 printer where 
required by your host applications when initiating printing.

The LU name and Associate options are mutually exclusive.



IBM 5250

Model (IBM 3477-FC)

Support for the IBM5250 terminal modes is extensive. Currently supported modes are:

>> IBM 3179-2
>> IBM 3179-220
>> IBM 3180-2
>> IBM 3196-A1
>> IBM 3477-FG
>> IBM 3477-FC
>> IBM 5251-1
>> IBM 5251-11
>> IBM 5252
>> IBM 5291-1
>> IBM 5292-2
>> IBM 5555-C01 (DBCS)
>> IBM 5555-B01 (DBCS)
>> IBM Printer. See also IBM 5250 Printer Configuration, in this chapter.

Options

Code Page (37(US))
Select from a list of supported Code Pages:

>> 37(US)
>> 273(Austria/Germany)
>> 277(Denmark/Norway)
>> 278(Finland/Sweden)
>> 280(Italy)
>> 284(Spain)
>> 285(UK)
>> 297(France)
>> 420(Arabic Bilingual) 
>> 423(Greek)
>> 424(Hebrew)
>> 500(International)
>> 833(Korean Extended)
>> 870(Latin2 Poland/Romania/Slovakia/Slovenia)
>> 871(Iceland)
>> 875(Greece)
>> 880(Cyrillic Russian)
>> 924(Multinational ISO Euro)
>> 930(Japanese)
>> 930(Japanese - Extended Katakana)
>> 939(Japanese - Extended English)
>> 1025(Cyrillic Belarus/Bulgaria/FYR Macedonia)
>> 1026(Latin 5 Turkey)
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>> 1047(US Open Systems)
>> 1140(Euro Belgium/Brazil/Canada-Bilingual/Netherlands)
>> 1141(Euro Austria/Germany)
>> 1142(Euro Denmark/Norway)
>> 1143(Euro Finland/Sweden)
>> 1144(Euro Italy)
>> 1145(Euro Spain)
>> 1146(Euro UK)
>> 1147(Euro France)
>> 1148(Euro International)
>> 1149(Euro Iceland)
>> 1155(Euro Latvia Latin 5/Lithuania/Turkey)
>> 2975(Czech)
>> 2978(Poland)
>> 2979(Russian)
>> 37/2(US)

Enable TypeAhead (off)
While the keyboard is locked, keystrokes are stored and released when the keyboard is unlocked.

TypeAhead Size (100)
The number of keystrokes permitted whilst keyboard is locked before the buffer fills and locked state is 
resumed.

Dot Attribute (Dots)
Enables or disables dot attributes.

Use TTWin classic 5250 Status Line (off)
Utilize old style TTWin 5250 Status Line display.

Insert Cursor skip to unprotected (off)

Advanced
Map Enter to Field + Enter (on)
 

Map Backslash to Yen (for Japanese)(on) 
The backslash key is mapped to the yen character for usage on Japanese host systems.

Max. Packet Size Buffer (kb) (6)
xxx

Generate TN5250log (off) 
Select this to enable the log file capture.



Log file (c:\ibm5250.log)
Selecting the Debug file command activates the Browse tile.  Enter or select the name of the file to which 
you wish to have the log information saved to.

Honor Numeric Field Type (on)
When set to off TTWin will allow any input in a field designated as numeric by the host. x

Enable 5250 extensions (off)
xxx 

Allow the host to control the cursor blink state (off)

Colors
Selecting the Edit button displays the IBM5250 Attribute Configuration tile.

Figure 18.9 IBM5250 Attribute Configuration tile.

Attribute
IBM defined attribute number. Alongside of the Attribute field is a description of the currently selected 
emulation mode.

5250 Default Attribute Description
Default description given to current Attribute Description attribute.

Features
The current attributes associated with the selected Attribute. The possible attributes are:

>> Blink
>> Column Separator
>> High Intensity
>> Invisible
>> Reverse
>> Underscore
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Colors
The color of the current Attribute. Select the foreground and background colors.

Example
Displays a sample text using the current attributes color scheme.

Revert to Default
Clicking on the button will reset the IBM5250 attributes back to the TTWin default.

Status Bar Colors
Specify colors for the status bar.

	Foreground color (Black)
 

	Background color (Cyan)
 

Character Mapping 

Language Name ()
Selecting this option presents a drop-down menu of languages: 

>> Austria/Germany
>> Belgium
>> Canadian French
>> Denmark/Norway
>> Finland/Sweden
>> France
>> Italy
>> Portugal
>> Spain
>> United Kingdom
>> U.S./Canada/Netherlands

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Standard character set
>> ASCII to EBCDIC
>> EBCDIC to ASCII
>> To host



IBM 5250 Printer

The IBM 5250 Printer emulation is available by selecting IBM Printer from the list of models available under the 
IBM 5250 Emulation configuration. For more information refer to the IBM 5250 item in this chapter.

Function Keys

When initiated the IBM 5250 terminal display shows printer status messages such as the number of total pages and 
jobs spooled. The printer can be further configured through function key options F1 through F5.

Hold (F1)
Pauses the current print job. This option is only valid when printing is active.

FF (F2)
Form feed. When in a Hold condition the page will be advanced until the first print line of the next page is 
reached.

Cancel (F3)
When in a Hold condition pressing F3 sends a Cancel Print message to the host and the print buffer is cleared, 
halting  the current print job.

Flush (F4)
Flush the contents of the host print buffer. The contents of the buffer are sent to the printer rather than dis-
carded, as occurs when pressing Cancel (F3).

Config (F5)
Opens the IBM 5250 Printer tile with extended configuration options.

IBM Printer Configuration Tile 

Page Setup (portrait)
This page orientation will match the setting as defined in File> Print setup.

Font (Courier New)
This font value is fixed to a standard monospace font such as Courier New.

Size (6)
Set a font size in points.
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.

Figure 18.10 IBM5250 Printer Configuration tile.

User CPL/LPP (characters per line, lines per page)

Characters Per Line (80)
Set the number of characters per line. A maximum value is suggested based on the font size selected in Size.

Lines Per Page (66)
Set the number of lines per printed page. A maximum value is suggested based on the font size selected in 
Size.

Continue Long Lines (off)
When set to on, long lines that extend beyond the right page boundary are wrapped. When set to off they 
are truncated.

Continue Long Pages (on)
When set to on, long pages that extend beyond the page edge boundary are continued on the following 
page. When set to off they are truncated.

Margins (centimeters)
Set margins in centimeters for the printed page. Valid settings are from 0.10 cm to 20 cm.

Best Fit
The Set Best Fitting Font button will automatically adjust the font Size to suit your selected Lines Per 
Page, Characters Per Line and Margin settings.



.

Figure 18.11 Advanced Printer Configuration tile.

Advanced...

Text/Output Options

All Caps (off)
When selected all printer output is converted to upper case.

Proportionally space lines(off) 
When set to on, lines are spaced proportionally to fill the available page space.

Proportionally space characters (off) 
When set to on, characters are equally spaced to fill the entire line space.

Inhibit spooler job separator(on) 
Disable separator printing between consecutive print jobs.
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SCS Host Formatting Options
Handling options for SNA Character String (SCS) host formatting. Valid options are:

>> Ignore host formatting 
>> Apply host formatting
>> Apply and Save host formatting

Print Buffer Flush Control (10 seconds)
Period in seconds, after which the print buffer is flushed if a print job has started and there is no activity from 
the host.

Position Paper
Select a row and column position for the top left of the page. The default is Row 1, Column 1.

Message to Print
Enter text at this item to be printed as a test page.

Print a Test Page
Prints a test page to the default printer as defined in File > Print setup.

Initiating an IBM 5250 Printer Session

An IBM 5250 printing session works in conjunction with IBM 5250 host session. To make use of the printer 
emulation TTWin requires a 5250 host session and a 5250 printer session to be open simultaneously. 

When configuring the printer session, select Configure > Comms and specify and specify a LU (Logical 
Unit) under the Telnet settings of your printer session. Connect this printer session to your host first and open 
a subsequent 5250 host session. Specify the LU of your 5250 printer where required by your host applications 
when initiating printing.



ICL 7561
Options

7-bit Mode (on)
All data is restricted to 7 bits.

UseSessionSingCharStrs (off)

Single char start string (\x1b)

Single char end string (\r)

UseSessionSendStrs (off)

Send start string ()

Send end string (\r)

Lock keyboard (on)

Type-ahead buffer size (0)

Field marker type ([])
Valid field markers are [ ], < >, > <, ( ), none or default.

SOM marker type (box)
Valid Start Of Message (SOM) markers are:

>> box
>> vertline

Mouse cursor control (on)

Allow consecutive protected fields (off)

Character Mapping
Language Name ()
Selecting this option presents a drop-down menu of languages. 

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Default ICL Character Set
>> To host
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ICL VT220 Plus

Display Size

Lines (24) 
Select to change between the following line modes:

>> 24
>> 25

Columns (80) 
Select to change between the following column modes:

>> 80
>> 123

Custom Screen Size (off) 
Select to enable the custom sizes as entered in the Custom Lines and Custom Columns settings.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80)
Enter the number of columns required.

Display Modes

Local Echo (off)
When selected, as a character is typed on the keyboard it is immediately echoed to your screen. When not 
selected, the entered character is sent to the remote host which in turn echoes it back. On its return the char-
acter is displayed on your screen. In this way, passwords and other sensitive information do not appear on your 
screen.

Insert Mode (off)
This option determines how characters are added to the screen. When selected, the character is inserted at the 
cursor, moving previously displayed characters to the right. When not selected, new display characters replace 
old display characters at the current cursor position.

Autowrap (off)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

Clear using current attribute (off)
Clear the screen using the current attribute.



Clear screen on size change (on)
When selected the screen is cleared once the screen size changes.

Character Set Mode (Normal)
Select between the following character set modes:

>> Normal
>> DBCS
>> UTF-8

Responses

Answerback ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (VT300)
Select to change between the following modes:

>> VT52
>> VT100
>> VT300

7 or 8 bit (7 Bit)
Select either 7 or 8 bit modes as required.

Terminal ID (VT220)
Select from the following:

>> VT100
>> VT101
>> VT102
>> VT220
>> VT240
>> VT320
>> VT340
>> VT420

Custom DA string (?62;1;2;6;7;8;9)
Enter your custom DA string.

Use Custom DA string (off)
Select to enable the Custom DA string function.
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Keyboard Configuration

Keypad Mode (Numeric)
The numeric keypad generates either numeric characters or control functions. Selecting Application or 
Numeric keypad mode, determines the type of characters. The terminal emulation when first selected, or after 
a reset, will be set to numeric keypad mode. 

>> Application: selects application keypad mode. The keypad generates application control functions. 
>> Numeric: selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

Cursor Keys (Normal)
The characters generated by the cursor keys depend on the state of the Cursor Keys mode. 

>> Normal: causes the cursor keys to generate ANSI cursor control sequences. 
>> Application: causes the cursor keys to generate application control functions.

Keyboard Locked (off)
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off)
When selected, causes a received [RETURN] to transmit as both a CR and a LF. When not selected and a 
[RETURN] is received only a CR is transmitted.

User defined keys locked (off)
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
Once the keys are locked, to unlock you must either deselect the User defined keys locked option or a reset 
is required.

Macros ignore keyboard lock state (off)
When selected macros will ignore the keyboard lock state, sending data to the host even if the keyboard is locked.

Print Region (Print Region)

Select from the following options: 

>> Print region: Sends just the selected region to the printer. 
>> Print screen: Sends the entire screen contents to the printer.

Print Form Feed (off)

Send a form feed character at the end of the print job.



Status Display (None)

>> None: The status line is not displayed. 
>> Indicator: The status display is always visible. 
>> Host writable: Host applications can write messages in place of the status line.

Tilda and Left Quote key (Sends tilda/left quote)

This option allows the user to define the TILDA/LEFT QUOTE key (i.e., [~/‘] key) to operate either as nor-
mal or as an escape key.

User preferred Character Set (ISO Latin)

Two 8-bit character sets are built into the ICL VT220. These are: 

>> DEC Supplemental: DEC Multinational set 
>> ISO Latin 

Both 8-bit sets include the standard ASCII character set and a supplemental set.

Miscellaneous

No Numeric Key Map (on)
xxx

StripCharValue (242)
xxx

Strip Printing (off)
xxx

StripSingleChar (off)
xxx

Wang Private Keys (off)
xxx

Reset Clear (on)
xxx

Favour Diacritics (on)
When enabled uses European characters rather than line draw characters.

Disable ModeN Bits Sequences (off)
xxx
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CodePage (950)
Sets the code page to be used when DBCS is enabled.

BackspaceOn(off)
xxx

Character mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages. 

Character Sets:
>> Hosts National
>> ASCII
>> ASCII (8bit)
>> DEC Special Graphics
>> DEC Supplemental
>> ISO Latin Supplemental
>> DEC Technical
>> ICL special graphics
>> To host



Liberty Freedom One

Display width (80) 

Select from the following options:

>> 80 column
>> 132 column

Options

Auto Scroll (SCROLL) 
Available scroll modes are:

>> STOP
>> LOOP
>> WRAP
>> SCROLL

Background (off)
xxx

Block mode (off)
When selected, no communication takes place to the host computer until the [ENTER] or [SEND] key is 
pressed. It does, however, respond to commands and characters received from the host.

Duplex mode (FULL)
>> FULL: duplex every typed character is transmitted to the host. The host must then decide what to do in 
response to the character it has received. In the majority of cases, it will simply echo the character back to the 
screen (or take some action, if it is a control character such as a carriage return).

>> HALF: duplex mode, character strings are displayed on the screen without waiting for the host to echo them 
back. The emulation also responds to characters sent from the host, displaying or executing them, as appro-
priate.

Insert mode (off)
When selected, Insert mode causes text to be inserted without overwriting existing data. As new text is entered, 
existing text is shifted right to the next character position.

Insert character (32)
Several editing, erase, clear and scrolling functions use an insert character to clear the screen, the default insert 
character is ASCII 32.

Local edit (off)
When selected, limits editing functions to the display and does not communicate them to the host system.
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Page mode (off)
When selected, allows editing functions to operate on the entire scrolling page. When not selected, limits the 
effects of editing functions to the current line.

Truncate (off)
Any characters extending past the end of line are truncated.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII
>> Graphics character set
>> To host



Linux Terminal

Autowrap (off)

When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

Columns (80)

Select to change between the following column modes:

>> 80
>> 132

Custom Screen Size (off)

Select to enable the custom sizes as defined in the Custom Lines and Custom Columns settings.

Custom Lines (25)

Enter the number of rows required.

Custom Columns (80)

Enter the number of columns required.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> HostsNational
>> ASCII
>> ASCII (8 bit)
>> DEC Special Graphics
>> DEC Supplemental
>> To host
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McDonnell Douglas P12

Display

Screen width (80)
The maximum number of columns displayable can be set to one of the following:

>> 80
>> 132

 Switching from 132 to 80 will truncate text in columns 81 to 132.

Options

Emulation Mode (MCDP)
Select the emulation mode: 

>> MCDP
>> ANSI
>> MF40

Enable Function Keys (on)
When selected, this causes the standard code sequences to be generated by all function keys.

Enable Programmable Function Keys (on)
It is possible to define a different string for each of the function keys when  they are used with or without 
the [SHIFT] key. When selected, this causes the  function keys to generate the programmed string. When 
not selected, this  causes the standard code sequences to be generated by all function keys. The strings are not 
cleared.

Clear All Function Keys (off)
When selected, this clears the strings defined for all the programmed function keys.

Blank character (NUL)
Select the NUL or SPACE character to represent blanks.

P8pr_NAKMode (on)
xxx

Soft-reset Clear Screen (on)
xxx



Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

>> English

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>>  US - ASCII character set
>>  MDC British character set
>>  British ASCII character set
>>  MDC National Extension set
>>  MDC Multinational Extension set
>>  MDC Graphics character set
>>  DEC Supplemental
>>  MDC Spanish National Extension set
>>  To host
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Prime PT25

Display Mode

Screen mode (80 column) 
Available screen mode options are:

>> 80 column
>> 132 column
>> Custom: Select to enable the custom sizes as defined in the Custom Height and Custom Width settings.

Custom Height (24) 
Enter the number of rows required.

Custom Width (80) 
Enter the number of columns required.

Options

Status Line (on)
Selects whether the status line is displayed or not.

Translate CR (off)
Defines how to handle received carriage return characters from the remote host. Received carriage returns can 
be transmitted as a carriage return or converted to carriage return and a line feed.

Auto line wrap (on)
When selected, if cursor is in the last column, incoming text is written to the beginning of the next line. When 
not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is received.

Scroll mode (SCROLL)
Available scroll modes are:

>> STOP
>> LOOP
>> WRAP
>> SCROLL

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

Character Sets
>> Native text character set
>> Native graphics character set
>> To host



 Prime PT250S

Display Mode

Screen mode (24x80) 
Available screen mode options are:

>> 24x80
>> 48x80
>> 27x132
>> 24x160
>> 25x80
>> Custom: Select to enable the custom sizes as defined in the Display width and Display Height settings.

Display width (80) 
Enter the number of columns required.

Display height (24) 
Enter the number of rows required.

Options

Auto wrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When deselected, incoming  characters will overwrite the last column until an EOL (end-of-line) character is 
received.

LF to CR/LF (on rcv) (off)
This effects how the line feed (LF) character is interpreted in receipt from the host. Normally line feed char-
acters move the cursor down one line (possibly scrolling the screen up), and carriage return (CR) characters 
move the cursor to the start of the current line.

When selected, line feed characters received from the host are translated to a LF/CR sequence. When not 
selected, the line feed is not translated.

Edit extent (SCREEN)
This parameter effects how much of the screen is affected by the INSERT and DELETE character commands. 

>> SCREEN: When selected, the region from the cursor to the end of the screen is moved.
>> LINE: When selected, the whole line to the right of the cursor position is moved.

Strip 8th bit (on)
When selected the eighth bit on the incoming data byte is stripped.
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Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Standard character set
>> Alternate character set
>> Line drawing font
>> Block drawing font
>> To host



QNX System Console

Display Mode

Display Size (24x80) 
Available screen size options are:

>> 24x80
>> 25x80
>> 24x132
>> 25x132
>> Custom: Select to enable the custom sizes defined in the Custom Height and Custom Width settings.

Switching from 132 to 80 will truncate text in columns 81 to 132.

Custom Height (24)
Enter the number of rows required. 

Custom Width (80)
Enter the number of columns required.

Options

Auto Wrap (on) 
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not set incoming characters overwrite the last column until an EOL (end-of-line) character is received. 

Auto Scroll (on)
This affects the behavior of the terminal when a linefeed is issued on the last line. When selected, the screen 
scrolls up one line and the cursor remains on the last line. When not selected, the screen remains unchanged 
but the cursor wraps around to the first column of the screen.

CR to CR/LF, Received (off)
Defines how to handle received carriage return characters from the remote host. When set to on received car-
riage returns are converted to carriage return and a line feed.

Character Mapping 

Language Name ()
Selecting this option presents a drop-down menu of languages.
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Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII
>> Alternate set
>> To host



SCO ANSI Color Console

Display

Screen Width (80) 
Enter the number of columns required.

Screen Height (24) 
Enter the number of rows required.

Options

Auto Wrap (on) 
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received. 

Clear screen on width change (off)
When select the screen will be cleared on a change of width.

Answerback

Send Answerback (off) 
Transmit the string defined within the Answerback Message String field when the ENQ character is received 
from the remote host. 

Answerback Message String () 
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Printing

Disable non-printable chars (on) 
Select to enable non-printable characters to be passed on to the printer.

Enable special printing (on)
xxx

Print line termination (None) 
Options available include: 

>> None
>> CR, LF
>> CR/LF
>> LF/CR



207TTWin 4 User Guide : Chapter 18 - Emulations

Printer acknowledgement char (13) 
Decimal character value.

Enable Transparent Print (on) 
Deselect if you wish to disable transparent print function.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages: 

>> English
>> English (UK)
>> Dutch
>> Finnish
>> French
>> French/Canadian,
>> German
>> Greek
>> Italian 
>> Norwegian/Danish 
>> Spanish 
>> Swiss 
>> Swedish (437)
>> Swedish (850) 
>> Cyrillic

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Low Character Set
>> High Character Set
>> US ASCII set
>> UK ASCII set
>> Graphics set
>> To host



Siemens Nixdorf 97801

Display Size

Lines (24)
Select to change between the following modes:

>> 24
>> 36
>> 48

Columns (80)
Select to change between the following modes

>> 80 
>> 132

Custom Screen Size (off)
Select to enable the custom sizes as defined in the Custom Lines and Custom Columns settings.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80)
Enter the number of columns required.

Display Modes

Local echo (off)
When selected, as a character is typed on the keyboard it is immediately echoed to your screen. When not select-
ed, the entered character is sent to the remote host which in turn echoes it back. On its return the character is 
displayed on your screen. In this way, passwords and other sensitive  information do not appear on your screen.

Insert Mode (off)
This option determines how characters are added to the screen. When selected, the character is inserted at the 
cursor, moving previously displayed characters to the right. When not selected, new display characters replace 
old  display characters at the current cursor position.

Autoscroll (on)
This affects the behavior of the terminal when a linefeed is issued on the last line. When selected, the screen 
scrolls up one line and the cursor  remains on the last line. When not selected, the screen remains unchanged 
but the cursor wraps around to the first column of the screen.

Autowrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
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received.

Clear using current attribute (off)
Clear the screen using the current attribute.

Clear screen on size change (on)
When selected the screen is cleared once the screen size changes.

Character set mode (Normal)
Select between the following character set modes:

>> Normal
>> DBCS 
>> UTF-8

Responses

Answerback Message ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (SN97801)
Select to change between the following modes:

>> VT52
>> VT100
>> SN97801

7 or 8 bit (7 Bit)
Select either 7 or 8 bit modes as required.

Terminal ID (SN97801)
Select from the following:

>> VT100
>> VT101
>> VT102
>> VT220
>> VT240
>> VT320
>> VT340
>> VT420
>> SN97801

Custom DA string (?62;1;2;6;7;8;9)
Enter your custom DA string.



Use Custom DA string (off)
Select to enable the Custom DA string function.

Keyboard Configuration

Keypad Mode (Numeric)
The numeric keypad generates either numeric characters or control functions. Selecting Application or 
Numeric keypad mode, determines the type of characters. The terminal emulation when first selected, or after 
a reset, will  be set to Numeric keypad mode.

>> Application: selects application keypad mode. The keypad generates application control functions.
>> Numeric: selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

Cursor Keys (Normal):
The characters generated by the cursor keys depend on the state of the cursor keys mode.

>> Normal: causes the cursor keys to generate ANSI cursor control sequences.
>> Application: causes the cursor keys to generate application control functions.

Keyboard Locked (off)
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off)
When selected, causes a received [RETURN] to transmit as both a CR and a LF. When not selected and a 
[RETURN] is received only a CR is transmitted.

User defined keys locked (off)
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
Once the keys are locked, to unlock you must either deselect the User defined keys locked option or a reset 
is required.

Compose Enabled (on)
A compose sequence is a series of two or three keystrokes that produce a single compose character. Pressing the 
[COMPOSE CHARACTER] key starts the composed sequence.

Macros ignore keyboard lock state (off)
When selected macros will ignore the keyboard lock state, sending data to the host even if the keyboard is locked.

Advanced

Print Region (Print Region)
Set the default print mode.

>> Print Region: Sends just the selected region to the printer.
>> Print Screen: Sends the entire screen contents to the printer.



211TTWin 4 User Guide : Chapter 18 - Emulations

Print Form Feed (off)
Send a form feed character at the end of the print job.

Status Display (None)
>> None: The status line is not displayed.
>> Indicator: The status display is always visible.
>> Host writable: Host applications can write messages in place of the status line.

Tilda and Left Quote key (Sends tilda/left quote)
This option allows the user to define the TILDA/LEFT QUOTE key (i.e., [~/‘] key) to operate either as 
normal or as an escape key.

User Preferred Character Set (DEC Supplemental)
Two 8-bit character sets are built into the Siemens 97801. These are:

>> DEC Supplemental: DEC Multinational set
>> ISO Latin

Both 8-bit sets include the standard ASCII character set and a supplemental set.

Miscellaneous
No Numeric Key Map (on)
xxx

StripCharValue (242)
xxx

Strip Printing (off)
xxx

StripSingleChar (off)
xxx

Wang Private Keys (off)
xxx

Reset Clear (on)
xxx

Favour Diacritics (on)
When enabled uses European characters rather than line draw characters.

Disable ModeN Bits Sequences (off)
 



CodePage (950)
Sets the code page to be used when DBCS is enabled.

CtmDisableLines (off)
BackspaceOn (off)

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages.

>> ISO 8859-1
>> ISO 8859-2
>> ISO 8859-3
>> ISO 8859-4
>> ISO 8859-5
>> ISO 8859-7

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> HostsNational
>> ASCII
>> ASCII (8bit)
>> DEC Special Graphics
>> DEC Supplemental
>> ISO Latin Supplemental
>> DEC Technical
>> International A
>> International
>> German
>> Euro
>> Brackets
>> Facet
>> IBM
>> Mathematics
>> Blanks
>> ISO Right
>> To host
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Stratus V102

Display height (24)

Enter the number of rows required, options available are:

>> 24
>> 25
>> 42
>> 43

Display width (80)

Enter the number of columns required, options available are:

>> 80
>> 132

Compatibility mode (tvi955)

Select tvi950 or tvi955 for compatibility with either of these emulations.

>> tvi950
>> tvi955

Main

Duplex mode (Full)
The mode in which the terminal communicates with the host. 

>> Full: The terminal sends characters to the host and the host then echoes them back to the screen. In this 
mode, the terminal and the host can transmit simultaneously.

The VOS operating system ONLY supports Full duplex mode.

>> Half: in half duplex mode, entered characters are displayed on the screen without being sent to the host for 
echo back.

Attributes effect (page)
This determines whether display attributes apply to each line, or each page. Display attributes are set by the 
host software; they include invisible, blinking, reverse video, underline and intensity. 

>> char: Assigns display attributes to the character at current cursor position. 
>> line: Assigns display attributes from the current cursor position to the end of the current line. 
>> page: Assigns display attributes from the current cursor position to the end of the current page.



Background character (Space)
On a terminal reset or screen initialization, a character referred to as the background character is used to refill 
the screen. Select either the Space character or the NUL character.

Insert character:
Several editing, erase, clear and scrolling functions use an insert character to clear the screen.

Default to Space (on)
An ASCII space.

Other character (32)
The insert character can be selected from any one of the ASCII characters. 

8-bit mode (on)
When selected no stripping occurs. When not selected the 8th bit of every byte from the host is stripped.

Status line (on)
When selected the status line is displayed.

Setup

Auto wrap (on)
When selected and the cursor is currently in the last column, incoming text is written to the beginning of the 
next line. When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) 
character is received.

Auto scroll (on)
When selected and the cursor reaches the bottom of the screen, the display page scrolls up. When not selected, 
the cursor jumps back up to the top of the screen.

Auto page (off)
When selected and the cursor reaches the bottom of the screen, the cursor will jump to the next memory page. 
This flag overrides Auto scroll.

Enhancements mode (off)
When selected, this option enables the sending and receiving of more control sequences than are otherwise 
enabled on a standard V102 terminal. When not selected, only the basic set of V102 control sequences are sent 
and received.

Hidden field attributes (off)
When selected, attributes occupy a character space. When not selected, attributes do not occupy a character 
space.

Insert mode (off)
When selected, this option causes text to be inserted without overwriting existing data. As new text is entered, 
existing text is shifted right to the next character position.
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Local edit (off)
When selected, this option limits editing functions to the display and does not communicate them to the host 
system.

Block mode (off)
When selected, no communications take place with the host computer until the [ENTER] or [SEND] key is 
pressed. It does, however, respond to commands and characters received from the host.

Page mode (off)
When selected, this allows editing functions, e.g. insert, delete etc. to operate on the entire scrolling page. 
When not selected, limits the effects of edit functions to the current line.

Strip outgoing (on)
xxx

Upper Info Line (on)
xxx

Graphics persist (2000)
xxx

Overwrite after Move (off)
xxx

Prog Key NUL substitute (0)
xxx

twcStatusLine (on)
xxx

Responses

Non-printable characters (e.g., linefeed) can be included in the response strings. The format is the same as 
with mapping a keyboard key.

Answerback message:
The terminal answerback is the string supplied to the host in response to an answerback enquiry from the host, 
by default this is blank.

Enable (off)
When selected, the terminal sends the answerback message to the host when the host sends the ENQ char-
acter. The message field is disabled unless this is selected. 

Text string ()
The string supplied to the host as the answerback message.



Terminal ID:
The Terminal ID is a semi-standardized string supplied to the host during negotiations.

Override (off)
Select to override the standard response string.

Text string ()
Enter the user defined response string.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII
>> High set
>> Graphics set 
>> Monitor Mode set 
>> Multinational set  
>> To host
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Stratus V103

Display height (24) 

Enter the number of rows required, options available are:

>> 24
>> 25
>> 42 
>> 43

Display width (80)

Enter the number of columns required, options available are:

>> 80
>> 132

Compatibility mode (tvi955)

Select from the list below for compatibility with either of these emulations.

>> tvi950
>> tvi955

Main

Duplex mode (Full)
The mode in which the terminal communicates with the host. 

>> Full: The terminal sends characters to the host and the host then echoes them back to the screen. In this 
mode, the terminal and the host can transmit simultaneously.

The VOS operating system ONLY supports Full duplex mode.

>> Half: In half duplex mode, entered characters are displayed on the screen without being sent to the host for 
echo back.



Attributes effect (page)
This determines whether display attributes apply to each line, or each page. Display attributes are set by the 
host software; they include invisible, blinking, reverse video, underline and intensity. 

>> Char: Assigns display attributes to the character at current cursor position. 
>> Line: Assigns display attributes from the current cursor position to the end of the current line. 
>> Page: Assigns display attributes from the current cursor position to the end of the current page.

Background character (Space):
On a terminal reset or screen initialization, a character referred to as the background character is used to refill 
the screen. Select either the Space character or the NUL character.

Insert character
Several editing, erase, clear and scrolling functions use an insert character to clear the screen.

Default to Space (on)
An ASCII space.

Other character (32)
The insert character can be selected from any one of the ASCII characters. 

8-bit mode (on)
When selected no stripping occurs. When not selected the 8th bit of every byte from the host is stripped.

Status line (on)
When selected the status line is displayed.

Setup

Auto wrap (on)
When selected and the cursor is currently in the last column, incoming text is written to the beginning of the 
next line. When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) 
character is received.

Auto scroll (on)
When selected and the cursor reaches the bottom of the screen, the display page scrolls up. When not selected, 
the cursor jumps back up to the top of the screen.

Auto page (off)
When selected and the cursor reaches the bottom of the screen, the cursor will jump to the next memory page. 
This flag overrides Auto scroll.

Enhancements mode (on)
When selected, this option enables the sending and receiving of more control sequences than are otherwise 
enabled on a standard V103 terminal. When not selected, only the basic set of V103 control sequences are sent 
and received.
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Hidden field attributes (off)
When selected, attributes occupy a character space. When not selected, attributes do not occupy a character 
space.

Insert mode (off)
When selected, this option causes text to be inserted without overwriting existing data. As new text is entered, 
existing text is shifted right to the next character position.

Local edit (off)
When selected, this option limits editing functions to the display and does not communicate them to the host 
system.

Block mode (off)
When selected, no communications take place with the host computer until the [ENTER] or [SEND] key is 
pressed. It does, however, respond to commands and characters received from the host.

Page mode (off)
When selected, this allows editing functions, e.g. insert, delete etc. to operate on the entire scrolling page. 
When not selected, limits the effects of edit functions to the current line.

Strip outgoing (on)
xxx

Graphics persist (2000)
xxx

Overwrite after Move (off)
xxx

Prog Key NUL substitute (0)
xxx

twcStatusLine (on)
xxx

Responses

Non-printable characters (e.g., linefeed) can be included in the response strings. The format is the same as 
with mapping a keyboard key.

Answerback message
The terminal answerback is the string supplied to the host in response to an answerback inquiry from the host, 
by default this is blank.

Enable (off)
When selected, the terminal sends the answerback message to the host when the host sends the ENQ char-
acter. The message field is disabled unless this is selected. 



Text string ()
The string supplied to the host as the answerback message.

Terminal ID
The Terminal ID is a semi-standardized string supplied to the host during negotiations.

Override (off)
Select to override the standard response string.

Text string ()
Enter the user defined response string.

Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages:

>> Greek

Character Sets:
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII
>> High set
>> Graphics set 
>> Monitor Mode set 
>> Multinational set  
>> To host
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Stratus V105

Display Size

Columns (80)
Enter the number of columns required, options available are:

>> 80
>> 132

Custom Screen Size (off)
Select to enable the custom sizes as set below.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80)
Enter the number of columns required.

Display Modes

Local echo (off)
When selected, as a character is typed on the keyboard it is immediately echoed to your screen. When not 
selected, the entered character is sent to the remote host which in turn echoes it back. On its return the char-
acter is displayed on your screen. In this way, passwords and other sensitive information do not appear on your 
screen.

Insert mode (off)
This option determines how characters are added to the screen. When selected, the character is inserted at the 
cursor, moving previously displayed characters to the right. When not selected, new display characters replace 
old display characters at the current cursor position.

Autowrap (off)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will  overwrite the last column until an EOL (end-of-line) character is 
received.

Clear using current attribute (off)
Clear the screen using the current attribute.

Clear screen on size change (on)
When selected the screen is cleared once the screen size changes.



Character set mode (Normal)
Select between the follow character set modes:

>> Normal
>> DBCS
>> UTF-8

Responses

Answerback Message ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (VT300)
Select to change between the following modes:

>> VT52
>> VT100
>> VT300

7 or 8 bit (7 Bit)
Select either 7 or 8 bit modes as required.

Terminal ID (VT220)
Select from the following:

>> VT100
>> VT101
>> VT102
>> VT220
>> VT240
>> VT320
>> VT340
>> VT420

Custom DA string (?62;1;2;6;7;8;9)
Enter your custom DA string.

Use Custom DA string (off)
Select to enable the Custom DA string function.

Keyboard Configuration

Keypad Mode (Numeric)
The numeric keypad generates either numeric characters or control functions. Selecting Application or 
Numeric keypad mode, determines the type of characters. The terminal emulation when first selected, or after 
a reset, will be set  to Numeric keypad mode.
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>> Application: selects application keypad mode. The keypad generates application control functions.
>> Numeric: selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

Cursor Keys (Normal)
The characters generated by the cursor keys depend on the state of the Cursor Keys mode.

>> Normal: causes the cursor keys to generate ANSI cursor control sequences.
>> Application: causes the cursor keys to generate application control functions.

Keyboard Locked (off)
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off)
When selected, causes a received [RETURN] to transmit as both a CR and a LF. When not selected and a 
[RETURN] is received only a CR is transmitted.

User defined keys locked (off)
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
Once the keys are locked, to unlock you must either deselect the User defined keys locked option or a reset 
is required.

Compose Enabled (on)
A compose sequence is a series of two or three keystrokes that produce a single compose character. Pressing the 
[COMPOSE CHARACTER] key starts the composed sequence.

Macros ignore keyboard lock state (off)
When selected macros will ignore the keyboard lock state, sending data to the host even if the keyboard is 
locked.

Advanced

Print Region (Print Region)
Set the default print mode.

>> Print Region: Sends just the selected region to the printer.
>> Print Screen: Sends the entire screen contents to the printer.

Print Form Feed (off)
Send a form feed character at the end of the print job.

Status Display (None)
>> None: The status line is not displayed.
>> Indicator: The status display is always visible.
>> Host writable: Host applications can write messages in place of the status line.



Tilda and Left Quote key (Sends tilda/left quote)
This option allows the user to define the TILDA/LEFT QUOTE key (i.e., [~/‘] key) to operate either as nor-
mal or as an escape key.

User preferred Character Set (DEC Supplemental)
Two 8-bit character sets are built into the Stratus V105. These are:

>> DEC Supplemental: DEC Multinational set
>> ISO Latin

Both 8-bit sets include the standard ASCII character set and a supplemental set.

Miscellaneous
No Numeric Key Map (on)
xxx

StripCharValue (242)
xxx

Strip Printing (off)
xxx

StripSingleChar (off)
xxx

Wang Private Keys (off)
xxx

ResetClear (on)
xxx

Favour Diacritics (on)
When enabled uses European characters rather than line draw characters.

Disable ModeN Bits Sequences (off)
xxx

CodePage (950)
Sets the code page to be used when DBCS is enabled.

BackspaceOn (off)
xxx
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Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages:

>> English
>> English (UK)
>> Dutch
>> Finnish
>> French
>> French/Canadian
>> German
>> Greek
>> Italian
>> Norwegian/Danish
>> Spanish
>> Swiss
>> Swedish
>> Cyrillic

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> HostsNational
>> ASCII
>> ASCII (8-bit)
>> DEC Special Graphics
>> DEC Supplemental
>> ISO Latin Supplemental
>> DEC Technical
>> To host



Tandem T653X

Display

Screen Format (25x80)
The Tandem T653X terminal has four standard screen resolution modes:

Switching from 132 to 80 truncates text in columns 81 to 132.

>> 25 x 40
>> 25 x 80
>> 28 x 132
>> 28 x 66

When TTWin receives a remote host generated sequence to change resolution modes, the screen is erased and 
the cursor moves to the home position.

No Of Pages (30) 
The Tandem T653X allows multiple page display.

Main

Mode (Conversational) 
The two available modes are:

>> Conversational: Data is transmitted to the host one character at a time.
>> Block: Data is transmitted to and from the host in blocks. Block mode allows the user to edit locally before 
sending the data to the host.

Bell Column (70) 
The column at which a bell will sound.

Return Fn Key (off)
This option is used with Block mode and determines whether the [RETURN] key is treated as an additional 
function key.

Half Duplex (off)
When not selected (full duplex), characters entered on the keyboard are not processed until they are echoed 
back by the host.

Insert Mode (off)
When selected, all characters entered from the keyboard are inserted by shifting the existing characters to the 
right.



227TTWin 4 User Guide : Chapter 18 - Emulations

Show Status Field (on)
When selected, the status field is displayed at the bottom of the screen.

No CR on Send Key (off)
xxx

Mode Switch Ack (off)
xxx

Color Mapping Disable (off)
x

Terminal Identifier (F)
x

Firmware Rev Level (G21)
xxx

Log File Name (C:\EMUL.LOG) 
Clicking the mouse on the Log file command allows entry of the filename to which the log information will 
be saved.

DoDebug (0)
Select a value 0 least verbose – 9 most verbose. 

Telnet (on)
Deselect this option if a Telnet session is not required.

Inline editor

Enable inline editor (off)
xxx

Use emulation colors for editor (off)
xxx



Status Bar Colors

Override default Status Line Colors? (off)
xx

Foreground color (black)
xx

Background color (Cyan)
xx

Status overline (off)
xx

Colors

Enables the editing of the Tandem color map. Clicking on the Edit... button opens the T653X Color 
Mapping Defaults tile. 

Attribute
A list of attributes that specify how characters appear on the screen. To change an attribute, scroll though 
the list and highlight the required attribute. To change the foreground or background color, click on the 
drop-down menu of the Foreground or Background field and select the new color.

Foreground
The foreground color of the currently selected Attribute as displayed in the Sample Text box. Select the 
desired color via the drop-down list.�

Background
The background color of the currently selected Attribute as displayed in the Sample Text box. Select the 
desired color via the drop-down list. 

Reset
Click on the Reset button to re-instate the default color mapping for the selected attribute.

Reload All
Click on the Reload All button to reinstate the session file color settings for all attributes.

Sample Text
Displays the currently selected Attribute as it would be shown on the terminal display.

Disable Mapping
If the Disable Mapping option is checked, attributes receive only their intrinsic interpretations. For exam-
ple, underscore simply controls underlining. Any color mapping that has been set is ignored.

Persistence
If the Persistence option is checked, color mappings are saved to the session file as soon as OK is clicked.
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Figure 18.12 T653X Color Mapping Defaults tile. 

Character Mapping 
Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets 
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Standard map 
>> To host



Televideo 955

Display height (24) 

Select from one of the following row options:

>> 24
>> 25
>> 42
>> 43

Display width (80)

Enter the number of columns required, options available are:

>> 80
>> 132

Compatibility mode (tvi955)

Select from the following available compatibility options:

>> tvi955
>> tvi950

Main

Duplex mode (Full)
The mode in which the terminal communicates with the host. 

>> Full: The terminal sends characters to the host and the host then echoes them back to the screen. In this 
mode, the terminal and the host can transmit simultaneously.

The VOS operating system ONLY supports Full duplex mode.

>> Half: In half duplex mode, character strings are sent to the Host and displayed on the screen without wait-
ing for the host to echo them back. The emulation also responds to characters sent from the host, displaying 
or executing them, as appropriate.
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Attributes effect (page)
This determines whether display attributes apply to each line, or each page. Display attributes are set by the 
host software; they include invisible, blinking, reverse video, underline and intensity. 

>> Char: Assigns display attributes to the character at current cursor position. 
>> Line: Assigns display attributes from the current cursor position to the end of the current line. 
>> Page: Assigns display attributes from the current cursor position to the end of the current page.

Background character (Space)
On a terminal reset or screen initialization, a character referred to as the background character is used to refill 
the screen. Select either the Space character or the NUL character.

Insert character
Several editing, erase, clear and scrolling functions use an insert character to clear the screen.

Default to Space (on)
An ASCII space.

Other character (32)
The insert character can be selected from any one of the ASCII characters. 

8-bit mode (on)
If deselected the 8th bit of every byte from the host is stripped. 

Status line (on)
Selects whether the status line is displayed or not.

Setup

Auto wrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

Auto scroll (on)
When selected and the cursor reaches the bottom of the screen, the display scrolls up. When not selected, the 
cursor jumps back up to the top.

Auto page (off)
When selected and the cursor reaches the bottom of the screen, the cursor will jump to the next memory page. 
This flag overrides Auto scroll.

Enhancements mode (off)
When selected, this option enables the sending and receiving of more control sequences than are otherwise 
enabled on a standard tvi955 terminal. When not selected, only the basic set of tvi955 control sequences are 
sent and received. 



Hidden field attributes (off)
When selected, the attribute occupies a character space. When not selected, the attribute does not occupy a 
character space.

Insert mode (off)
When selected, this option causes text to be inserted without overwriting existing data. As new text is entered, 
existing text is shifted right to the next character position. 

Local edit (off)
When selected, this option limits editing functions to the display and does not communicate them to the host 
system.

Block mode (off)
When selected, no communications take place with the host computer until the [ENTER] or [SEND] key is 
pressed. It does, however, respond to commands and characters received from the host.

Page mode (off)
When selected, this allows editing functions to operate on the entire scrolling page. When not selected, limits 
the effects of edit functions to the current line.

Strip outgoing (on)
xxx

Upper Info Line (on)
xxx

Graphics persist (2000)
xxx

Overwrite after Move (off)
xxx

Prog Key NUL substitute (0)
xxx

twcStatusLine (on)
xxx

Responses
Answerback message
The terminal answerback is the string supplied to the host in response to an inquiry from the host, by 
default this is blank.

Enable (off)
When selected, the terminal sends the answerback message to the host when the host sends the ENQ 
character. The message field is disabled unless this is selected.
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Text string ()
The string supplied to the host as the answerback message.

Terminal ID
The Terminal ID is a string supplied to the host during negotiations.

Override (off)
Select to override the standard response text string. 

Text string ()
Enter the user defined response string.

Character mapping

Language Name ()
Selecting this option presents a drop-down menu of available languages.

Character Sets:
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> ASCII
>> High set
>> Graphics set
>> Monitor Mode set
>> Multinational set
>> To host



Unisys T27
The T27 emulation provides a single-environment rendition of Unisys’ Burroughs-originated T27 terminal.

The emulation is designed for use with Telnet and Burroughs Poll/Select protocols. Selecting any comms 
module other than Serial (i.e. Nominally Telnet) configures the emulation for raw data operation. Selecting the 
Serial comms module configures the emulation to send and receive data packetized for Poll/Select.

Personality (T27) 

Select from the available models: 

>> T27
>> TD830-ASCII
>> TD830-NDL

Screen Format (24x80)

The T27 emulation has five standard screen resolution modes: 

>> 24 x 80 
>> 12 x 80 
>> 24 x 40 
>> 12 x 40  
>> 24 x 132

While possible, host-initiated resolution switching is not a normal feature of T27 operation and is not currently 
supported by the emulation.

Main

Pages (4)
xxx

Page Height (32)
xxx

Protocol (Telnet)
>> Poll-Select
>> Telnet 

Insert Mode (Line Mode)
The drop-down allows the default insert mode to be specified. Insert mode is not cleared upon arrow-key or 
other non-printing keypress. The mode can also be selected with the Insert key and, whilst in Insert Mode, 
can be toggled between Line Mode and Page Mode with [ALT_INSERT]. If Overtype mode is selected 
Line and Page modes are disabled.
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Type Ahead (on)
While the keyboard is locked, keystrokes are stored and released when the keyboard is unlocked.

TABs Ruler (off)
When checked, this causes the separator line between the Environment Window Area and the first 
(Application) status line to display a ruler-style visual indication of tab stop settings.

Reveal Delimiters (on)
When checked, field delimiters are shown as graphics symbols, otherwise as they are shown as space characters.

App Status Line only (off)
Allows the sizes of the Environment Window Area and the display font to be maximized at the expense of the 
indications available on the second and third (Environment and System) status lines. 

Environment ID (ENVMNT 0)
This field allows the Environment ID, normally displayed in reverse video at the right-hand end of the separa-
tor line, to be customized.

Advanced

Attribute Markers Hidden (on)
xxx

Auto Field Advance (on)
If checked, the cursor jumps to the next field whenever it moves past the right most character in a left-justified 
field.

Backspace Destructive (off)
xxx

Byte Config allowed (off)
xxx

Clear-key action (Unprotected) 
>> Unprotected: The [CLEAR] key action can be set to clear either unprotected only 
>> Clear all: Both unprotected and protected areas.

Cursor Wrap (on)
When checked, cursor movement past one extent of the screen area takes the cursor to the opposite extent of 
the screen.

Data CR visible marker (off)
The CR code doesn’t normally produce any additional on-screen indication, however a CR marker can be writ-
ten.



DC1 function (Stay in Rcv) 
>> Stay in Rcv: The T27 terminal can interpret the DC1 code (11H) as an instruction to stay in Rcv mode 
at the end of a host write. It also has a Rcv Mode Hold option that provides this behavior continuously. 
Otherwise, at end of write, the T27 switches to Local mode. The emulation doesn’t fully implement 
separate Rcv, Local and Xmit modes, being always in a combined Rcv / Local mode unless transmitting. 
Consequently the Stay in Rcv choice has no effect other than to disable the alternate choice. 

>> Clear to EOL: DC1 causes a clear-to-end-of-line operation.

DC2 function (Toggle Forms) 
>> Toggle Forms: The T27 can interpret the DC2 code (12H) as a command to toggle Forms Mode 
>> Advance DCP: Or to advance the DCP (host write pointer) by one position.

Expand Data CR (CR LF) 
>> CR LF: The T27 can expand a received CR (0DH) to a CR, LF pair 
>> CR: No expansion is performed.

Expand Data LF (LF) 
>> CR LF: The T27 can expand a received LF (0AH) to a CR, LF pair (ie. carriage-return, linefeed) 
>> LF: No expansion is performed.

Expand keybd CR (off)
xxx

ETX visible marker (off)
The ETX code may be written to a page to modify Transmit behavior. The codes can optionally be displayed 
with a special glyph. 

ETX Advance (off)
If checked, cursor position is advanced after ETX is written.

FF Clears TAB stops (off)
Allows the FF (0CH - Clear Page) command code to be used to also clear variable tabstop settings.

FF Exits Forms mode (off)
xxx

Form Xmit to Cursor (on)
If checked, and ignoring other influences, in Forms Mode, a transmit operation sends all data from the mobile 
home position to the cursor. Otherwise, the send is to end-of-page.

Lock out Lowercase (off)
Characters entered at the keyboard are normally displayed in the case in which they are typed. This option 
allows them to be forced to uppercase.

Mouse Cursor Control (on)
xxx
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Render Fields to End Delimiter (on)
xxx

Return-key visible marker (off)
Return doesn’t normally entail additional on-screen indication, however a CR marker can be written.

Return-key action in Forms (Exit field)
Return can be actioned either as positioning to the Next Line, possibly still within the current field, or as 
explicitly positioning beyond the current field (Exit Field).

RS Resets Attributes (on)
xxx

RS Alternate Character (<RS> 0x1E)
Use the drop-down to select the appropriate character for your host.

US Alternate Character (<US> 0x1F)
Use the drop-down to select the appropriate character for your host.

Show Status Lines (on)
xxx

SO,SI switch Character-set (off)
When checked, the SO (0EH) and SI (0FH) codes are active as Shift-Out and Shift-In. Characters received 
bracketed by SI and SO command codes are translated to the corresponding high-bit-set character.

SPCFY Key sends Page Number (off)
The default [SPCFY] key ([Ctrl_Shift_Numpad5]) action is to send cursor column and row parameters 
to the host. It can optionally send column, row and page.

SPCFY Key sends ASCII (off)
The default [SPCFY] sequence uses binary encoding of the cursor parameters. This checkbox allows ASCII 
encoding to be selected.

Suppress LINC Header (off)
xxx

TAB-key visible marker (off)
TAB moves the cursor to the next tabstop or, in forms mode, to the next field. It doesn’t normally entail addi-
tional on-screen indication, however a HT marker can be written.

Variable TABs (off)
xxx



VT Page Advance (off)
Allows the VT (0BH - Vertical Tab) command code to be used to execute a vertical tab. Page height must be the 
default 32 lines and the tabstops are at rows 1, 9, 17, 25. Otherwise, VT toggles the tabstop at the current cur-
sor column.

Block Timeout duration, ms (350)
It is necessary for the emulation to be aware when a write from the host has concluded. For Telnet comms 
where no protocol-based indication is available, the emulation assumes that a write is complete when a timeout 
period elapses after the last character is received. The timeout period can be from 1 - 999 milliseconds.

Sync display to Forms and blocking (on)
xxx

Do Debug (off) 
Selecting this item enables data to be written to the debug file.

Log File name (C:\T27.LOG)
Clicking the mouse on the Log file command allows entry of the filename to which the log information will be 
saved.

Poll-Select

Terminal Address (00)
xxx

Passthrough Printer Address ()
xxx

DCOM Early Fill (off)
If checked, the emulation interprets host data and commands as they are received, without waiting for block 
validation. It should normally be left unchecked. This can be particularly important for successful remote 
operation and also for PPT.

Fast-Select Enable (on)
This option’s current purpose is simply to allow or prevent the interpretation of Fast-Select sequences by the 
emulation. This behavior may change.

Group-Select Character (4)
This is the single character address that the emulation will look for when deciding whether to accept a Group 
Select message. Valid characters are codes 0x20 - 0x7f with the exception of ‘p’, ‘q’, ‘s’ and ‘t’. Specification of 
an invalid character causes 0x04 to be stored.

SOH Clears Screen (off)
This option provides for an automatic Clear Page operation to be performed for each block of application data 
from the host. Disabled by default but often required enabled.
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SOH Exits Forms (on)
This option provides for automatic exiting of Forms Mode on each new block of application data from the 
host.

Character Mapping 

Language Name()
Selecting this option presents a drop-down menu of available languages.

Character Sets 
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Standard map 
>> To host



UNIX ANSI Console

ANSI Mode (Interactive Unix)

Support for several different 386 UNIX products is provided within the ANSI Terminal emulation by way of 
the ANSI Mode option. The supported 386 UNIX products are:

>> Interactive Unix
>> Bell Tech. Unix
>> AT&T Unix

Display Size (80x24) 

Available options are:

>> 80x24
>> 132x24
>> Custom: uses the width and height as defined in the Custom display size section.

Options

AutoWrap (on)
When selected and the cursor is in the last column, incoming text is written to the beginning of the next line. 
When not selected, incoming characters will overwrite the last column until an EOL (end-of-line) character is 
received.

AutoScroll (on)
When selected and the cursor reaches the bottom of the screen, the display scrolls up. When not selected, the 
cursor jumps back up to the top. 

Filter out NULs (on)
When selected, all received NULL characters are removed from the received data stream prior to passing it to 
the emulation.
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Character Mapping

Language Name ()
Selecting this option presents a drop-down menu of languages. 

>> English
>> English (UK)
>> Dutch
>> Finnish
>> French
>> French/Canadian
>> German
>> Greek
>> Italian
>> Norwegian/Danish
>> Spanish
>> Swiss
>> Swedish
>> Cyrillic

Character Sets

This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Low character set
>> High character set
>> Normal character set
>> Graphics set
>> To host

Custom display size

Height (24)
Enter the number of rows required.

Width (80)
Enter the number of columns required.



Wang 2110

Display Size

Lines (24)
Select to change between the following options:

>> 24
>> 25

Columns (80)
Select to change between the following options:

>> 80 
>> 132

Custom Screen Size (off)
Select to enable the custom sizes as described in the Custom Lines and Custom Columns set-
tings.

Custom Lines (24)
Enter the number of rows required.

Custom Columns (80)
Enter the number of columns required.

Display Modes

Local Echo (off)
When selected, as a character is typed on the keyboard it is immediately echoed to your screen. 
When not selected, the entered character is sent to the remote host which in turn echoes it back. 
On its return the character is displayed on your screen. In this way, passwords and other sensitive 
information do not appear on your screen.

Insert mode (off)
This option determines how characters are added to the screen. When selected, the character is 
inserted at the cursor, moving previously displayed characters to the right. When not selected, new 
display characters replace old display characters at the current cursor position.

Autowrap (off)
When selected and the cursor is in the last column, incoming text is written to the beginning of 
the next line. When not selected, incoming characters will overwrite the last column until an EOL 
(end-of-line) character is received.

Clear using current attribute (off)
Clear the screen using the current attribute.
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Clear screen on size change (on)
When selected the screen is cleared once the screen size changes.

Character set mode (Normal)
Select between the following character set modes

>> Normal
>> DBCS
>> UTF-8

Responses

Answerback ()
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Operating Mode (WANG2110A)
Select to change between the following modes:

>> VT52
>> VT100
>> WANG2110
>> WANG2110A

ControlBits (7 Bit)
Select either 7 or 8 bit modes as required.

TermID (WANG2110A)
Select between the following:

>> VT102
>> WANG2110
>> WANG2110A

Custom DA string (?77;2;1)
Enter your custom DA string.

Use Custom DA string (off)
Select to enable the Custom DA string function.



Keyboard Configuration

Keypad Mode (Numeric)
The numeric keypad generates either numeric characters or control functions. Selecting Application or 
Numeric keypad mode, determines the type of characters. The terminal emulation when first selected, or after 
a reset, will be set to numeric keypad mode. 

>> Application: selects application keypad mode. The keypad generates application control functions. 
>> Numeric: selects numeric keypad mode. The keypad generates characters that match the numeric, period, 
plus, minus, star and forward-slash keys on the main keypad.

Cursor Keys (Normal)
The characters generated by the cursor keys depend on the state of the Cursor Keys mode. 

>> Normal: causes the cursor keys to generate ANSI cursor control sequences. 
>> Application: causes the cursor keys to generate application control functions.

Keyboard Locked (off)
When the keyboard is locked, no codes can be transmitted from the keyboard to the Host. You can unlock the 
keyboard either by deselecting this option or resetting the terminal.

Convert LF to CR/LF (off)
When selected, causes a received [RETURN] to transmit as both a CR and a LF. When not selected and a 
[RETURN] is received only a CR is transmitted.

User defined keys locked (off)
The lock parameter determines whether the downloaded key definitions are locked or not, after you load them. 
Once the keys are locked, to unlock you must either deselect the User defined keys locked option or a reset 
is required.

Scancode mode (off) 
xxx

Macros ignore keyboard lock state (off)
When selected macros will ignore the keyboard lock state, sending data to the host even if the keyboard is 
locked.

Advanced

PrintExtent (Print Region):
Set the default WANG2110 print mode. 

>> Print Region: Sends just the selected region to the printer. 
>> Print Screen: Sends the entire screen contents to the printer.

Print FF (off)
Send a form feed character at the end of the print job.
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Status type (None)
>> None: The status line is not displayed. 
>> Indicator: The status display is always visible. 
>> Host writable: Host applications can write messages in place of the status line.



Tilda and Left Quote key  (Sends tilda/left quote)
This option allows the user to define the TILDA/LEFT QUOTE key (i.e., [~/‘] key) to operate either as nor-
mal or as an escape key.

SuppCharSet (DEC Supplemental)
Two 8-bit character sets are built into the VT220. These are: 

>> DEC Supplemental: DEC Multinational set 
>> ISO Latin 

Both 8-bit sets include the standard ASCII character set and a supplemental set.

Miscellaneous:

No Numeric Key Map (on) 
xxx

StripCharValue (242) 
xxx

Strip Printing (off) 
xxx

StripSingleChar (off) 
xxx

Wang Private Keys (off) 
xxx

Reset Clear (on) 
xxx

FavourDiacritics (on)
When enabled uses European characters rather than line draw characters.

Disable ModeN Bits Sequences (off) 
xxx

CodePage (950)
Sets the code page to be used when DBCS is enabled.

BackspaceOn (off) 
xxx
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Character mapping:

Language Name ()
Selecting this option presents a drop-down menu of available languages. 

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> HostsNational
>> ASCII
>> ASCII (8bit)
>> DEC Special Graphics
>> DEC Supplemental
>> To host



Wyse Series

Display

Personality (Wyse 60) 
Select from the following:

>> Wyse 50+
>> Wyse 60
>> Wyse 350

Number of lines (24)  
Enter the number of rows required.

Number of Columns (80)  
Enter the number of columns required.

Number of Pages (4) 
The Wyse terminal offers the ability to store multiple pages of information. The number of pages you require 
can be specified here. Each page will use part of your system memory.

Options 

Autowrap (Wrap)  
This affects the behavior of the terminal when a character is inserted in the last column of the screen. 

>> Stop: The cursor remains in the last column position on the same line and all following characters overwrite 
into the same position.

>> Wrap: The cursor wraps around to the first column of the next line. 

ScrollMode (Scroll)
This affects the behavior of the terminal when a linefeed is issued on the last line. 

>> Loop: The screen remains unchanged but the cursor loops to the first column of the screen.
>> Scroll: The screen scrolls 1 line and the cursor remains on the last line. 

Map CR to CR/LF (off)
This option determines the effect of received carriage return (CR) codes. When selected, all received CR codes 
move the cursor to the first column position on the next line i.e., it is interpreted as a CR followed by a line 
feed (LF). When not selected, all received CR codes simply move the cursor to the first column of the current 
line. 

Send ACK (off)
When selected the terminal will send an ACK character on receipt of an ENQ character from the host. When not 
selected the terminal will ignore ENQ characters. 
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You can configure Send Ack for the Wyse 60 personality however the Wyse 
50+, like the real terminal, forces SEND ACK to be selected at all times.

Map NULLs to Spaces (on)
When selected NULLs are converted to spaces.

Attribute Extent (Char)
This determines the extent affected by changing the current display attribute.

>> Char: All characters that are afterwards will have the new attribute.
>> Line: The existing line will inherit the new attribute.
>> Page: The entire page will inherit the new attribute.

Clear screen on Width change (off)
When selected, this will cause a screen clear whenever a screen change between 80 and 132 columns occurs. If 
history is enabled, the screen data will be saved to the scroll history buffer otherwise the data is lost.

Backspace Wraps (on)
Allows backspace to move back to previous line. 

Character Set Mode (Normal)
Select from the following Character Set Mode options:

>> Normal
>> DBCS
>> UTF-8

Code Page (950)
Sets the code page to be used when DBCS is enabled.

Miscellaneous
Printing CR conversion (None) 
Available options are:

>> None
>> Strip
>> CR/LF 
>> LF/CR



Printing LF conversion (None) 
Available options are:

>> None
>> Strip
>> CR/LF 
>> LF/CR

Enhanced (off) 
xxx

Strip 8th Bit (off) 
Strips the 8th bit from the character.

Allow Local Echo (off)
If selected, as a character is typed on the keyboard it is immediately echoed to your screen. If disabled, the 
entered character is sent to the remote host which in turn echoes it back. On its return the character is dis-
played on your screen. In this way, passwords and other sensitive information do not appear on your screen.

Status Line 

Status Line Type (None)
Across the bottom of the TTWin window will be displayed various status details. There are three choices:

>> None: Hides the status line
>> Standard
>> Extended

Status Line Location (Top) 
Four options are available:

>> Top
>> Bottom
>> Top Plain
>> Bottom Plain

Use a separator line (on)
When selected places a line between the status line and the rest of the emulation display.

Answer Back 

Enable Answerback (off) 
Transmit the string defined within the Answerback Message field when the ENQ character is received from 
the remote host. 
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Answerback Message () 
The string specified here is used as the answerback message which is sent from the terminal to the host when 
the host sends the ENQ character.

Colors 

To implement the large array of colors associated with a Wyse 350 terminal, this emulation takes advantage of 
the Override Color feature in the TTWin Color configuration tile. This mimics the use of attributes to asso-
ciate and display colors in a Wyse 350 terminal. To aid in the set-up of the color associations, three check-boxes 
are available. 

Notify a color palette change (off)
Allows an administrator to know what palette, if any, is been asked for by the host application. The palette can 
be set-up as a color scheme in the Color configuration tile. The user can also be notified when to change the 
color scheme for an application when colors are important to its usage. 

Notify a color association sequence (off)
Applications sometimes add their own flavors to the standard Wyse 350 color palettes. This option allows the 
administrator to change the color schemes accordingly. 

Lock write-protect attribute to Invisible|Blink (off)
TTWin does not have a Write-Protect as a standard overridable attribute. This option maps this attribute to 
a rare attribute, Invisible and Blink, to enable a color to be associated with it. Note that when this option is 
selected, any application request for a change of Write-Protect attribute will be ignored.

Character Sets

Primary Character Set (Font Bank 0)
Selection options available 0, 1, 2 or 3.

Secondary Character Set (Font Bank 1)
Selection options available 0, 1, 2 or 3.

Font Bank 0 (G0 Char Map) (Native Mode)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.

Font Bank 1 (G1 Char Map) (MultiNational)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.

Font Bank 2 (G2 Char Map) (Native Mode)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI.



ont Bank 3 (G3 Char Map) (MultiNational)
Available options include: Native Mode, Graphics Overlay, MultiNational, PC Equivalent, Standard ASCII, 
Graphics 1, Graphics 2, Graphics 3, Standard ANSI, ANSI Graphics or UK ANSI. 

Character Mapping

Language Name () 
Selecting this option presents a drop-down menu of languages.

>> English
>> Swedish

Character Sets
This configuration option allows editing of various character sets. The Language Name setting must be con-
figured prior to editing these settings.

>> Native Mode
>> Graphics Overlay
>> Multinational
>> PC equivalent
>> Standard ASCII
>> Graphics 1
>> Graphics 2
>> Graphics 3
>> Standard ANSI
>> ANSI Graphics
>> UK ANSI
>> To host
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Chapter 19: File Transfer

File transfers and configuration.
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File Transfer
The File Transfer option can be found under the Configure menu and enables you to configure the file 
transfer protocol modules. As it is possible to nominate and use any of the available file transfer protocols at 
any time during a session with a remote host, it is important that all the requisite protocols have been config-
ured.

Figure 19.1 Filter transfer modules selection tile.

Selecting a File Transfer Module

To select a file transfer module, choose the File transfer... option from the Configure menu. If at the time of 
selecting a file transfer module there is no file transfer module loaded, you will be prompted with the Module 
Selection tile, (see Figure 19.1). Choose the required file transfer from the list presented.

If a file transfer module is already loaded then the Configure tile for that module will be displayed, ready for 
editing, such as that shown in Figure 19.2 (following page).

Changing the Current File Transfer Module 

To choose a different file transfer module click on the Change File Transfer button on the Configure tile 
for the currently loaded module

You will then be presented with the Select a File Transfer Module tile, (see Figure 19.1). Choose the 
required file transfer from the list presented. 

Loading a File Transfer Module 

Having selected the required file transfer module, the configure tile for that file transfer is displayed.  

To load the configured file transfer module click on the OK button on the configure tile.  (Any changes that 
have been made to the configuration of the file transfer module are saved.) 



Configuring a File Transfer Module 

Having selected a file transfer module, you are automatically presented with the configure tile.  The configure 
tile allows you to edit the details for the chosen file transfer module. All the available file transfer modules are 
described in detail in the following sections of this chapter. 

File transfer software is required to be resident on the host. If you select a 
protocol that is not available on your host, the file transfer will fail. 

Figure 19.2 FTP options. To change the selected file transfer module click Change File Transfer.
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FTP/FTPS
This is the default file transfer protocol supplied within TTWin. 

Connection

IP Address ()
Enter the name or the IP address of the remote host you wish to connect to.

FTP Port No (21)
Assign the port number you wish to use. The default is 21, as this is the port that is normally reserved for FTP.

Security Section
Security ([None])

>> [None]: No security enabled (standard FTP).
>> Auto: Auto detect Implicit/Explicit (FTPS).
>> Implicit: Connects in FTPS Implicit mode (Also set FTP Port No to 990).
>> Explicit: Connects in FTPS Explicit mode.

>> Strict (off) 
If selected the host RSA key must match the key listed in the known hosts file.

SSL
SSL Enabled Protocols
Allow various SSL/TLS protocols.

SSL2 (off)
SSL3 (on)
TLS1 (on)
TLS1.1 (off)
TLS1.2 (off)
TLS1.3 (off)

Use System Security Libraries (on)
When disabled will allow connections using less secure legacy certificates.

Certificate ()
Options for selecting and importing certificate files. Clicking the Edit... button will display the tile shown 
in Figure 19.3.



Figure 19.3 SSL certificate selection.

Store Type
Select from Microsoft Certificate Store for existing certificate files or select a file format (PEM, 
DER,P12) to importing a new certificate for TTWin.

Store
A drop-down list of available certificates for the Microsoft Certificate Store. When choosing to import a 
certificate file, this option is replaced with a File option which loads a local certificate file into TTWin.

Password
Should the selected certificate require a password it should be entered here. Once entered correctly the 
Certificate drop-down list will update.

Certificate
Select the desired certificate.

Login username
Enter the login name of the user you wish to connect as to the remote host.

Login password
Enter the login password for the above login username.

Use Environment Variables (off)
When set to on, this option allows the use of Windows Environment Variables to set the username and pass-
word for FTP login. This setting will override the login user name and login password settings.

Username environment variable()
Enter the system variable name that specifies the user login name. Use Environment Variables must be set 
to on. 

Password environment variable()
Enter the system variable name that specifies the user password. Use Environment Variables must be set to on.
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Autoconnect on startup (on) 
When enabled, on opening the FTP transfer tile ( Actions > Transfer a file ) a connection to the host will 
automatically be established using the login credentials supplied in login username and login password. When 
this option is disabled the FTP transfer tile will open in an unconnected state and require the user to select the 
connect button to begin an FTP session.

Auto disconnect on exit (off)
Close FTP session on leaving File Transfer dialog. When off, FTP connection is maintained until TTWin ses-
sion is closed.

Directories

Remote Directory()
Specifies the remote host directory TTWin will attempt to change to when a host connection is established. If 
TTWin is unable to list this directory, for example because the supplied directory is invalid, the remote host's 
default directory will be used instead.

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.

File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are redi-
rected to the File transfer directory.

For example if you set the File transfer directory alias path to c:\ and selected Action > Receive a file, 
naming the file to be received as test.txt, that file would be placed in c:\test.txt.

Protocol Settings

Block Time Out (10)
Set the time period (in seconds) that the file transfer waits for a remote response.

Content Conversion (Auto Detect)
This setting controls how TTWin will handle file conversions.

>> Text: converts UNIX LF's to CR LF (Receive), and CR LF to LF (Send)
>> Binary: Data is Binary, no conversion is performed. 
>> Auto Detect: Automatically detects if the data is Text or Binary.

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new. TTWin will automatically rename the incoming file.
>> Discard new. The incoming file will be discarded.
>> Overwrite old. The existing local file will be overwritten.
>> Rename old. TTWin will automatically rename the existing local file.



Delete Remote File When Overwriting (off)
Deletes remote host file before transferring the current file.

Text File Types (txt ini twc)
Specify a list of file extensions for files that TTWin will automatically treat as ASCII/text transfers.

Allow File Size Request (on)
Request remote file size before receiving file.
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IBM IND$FILE
IND$FILE is a file transfer protocol used when communicating with IBM mainframes. It allows text and data 
to be copied and includes the capacity to translate between ASCII and EBCDIC character sets.

IND$FILE encompasses two different modes of operation - Screen Buffer Mode 
and Structured Field Mode. This version of IND$FILE supports only the 
Structured Field Mode.

To successfully transfer files using this version of IND$FILE, the mainframe host must know the terminal 
supports extended attributes.

Refer to the description of the relevant IBM emulation in Chapter 18 - Emulations.

For example, if you connect to the remote host via Telnet and you select the IBM 3270 emulation, then the 
Extended Attributes option must be selected. This adds an -E suffix, giving the emulation type IBM-3279-2-E.

General

	Host Type (TSO)
	This must be set to the operating environment of the remote host. The IND$FILE module constructs a 	
command 	string to send to the host. It therefore needs to know what environment is running in order to 
format the command correctly. Select from: 

>> CMS
>> TSO
>> CICS

	Program (IND$FILE)
	Allows the actual command for the file transfer to be customized, should it be named differently to the 
standard 	IND$FILE. For example, APVUFILE for Kana on Japanese hosts.

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new. TTWin will automatically rename the incoming file.
>> Discard new. The incoming file will be discarded.
>> Overwrite old. The existing local file will be overwritten.
>> Rename old. TTWin will automatically rename the existing local file.



	Transfer Type (Text)
This setting specifies how the transferred data is handled.

>> Text. Specifies that the data in the file is ASCII type data
>> Binary. Specifies that the data in the file is binary data.
>> Append. Appends the file being sent to an existing file.

Local Conversion (On)
When enabled TTWin performs the ASCII to EBCIDIC conversion instead of the host.

Content Conversion (Append)
This setting specifies how TTWin will handle file conversions.

>> Text. When specified the program converts EBCDIC codes to 1-byte workstation codes, converts IBM host 
DBCS codes to 2-byte codes and removes SO/SI characters in the DBCS field. Default option for SBCS 
sessions

>> Binary. Data is Binary, no conversion is performed.
>> Append. Automatically detects if the data is Text or Binary.

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.

File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are redi-
rected to the File transfer directory.

For example if you set the File transfer directory alias path to c:\ and selected Action > Receive a file, 
naming the file to be received as test.txt, that file would be placed in c:\test.txt.

Protocol Options

Timeout After (# secs) (20)
This may need to be increased depending upon the speed of the host, and/or the quality of the communication 
link 	between the PC and the host. 

Abort After (# errors) (10) 
This sets the maximum number of consecutive protocol errors before the transfer is aborted.

Structured Fields (on)
This allows the desired mode of operation to be selected, (screen buffer or structured field), and if structured 
field 	mode is desired, then the block length can be chosen.

	This currently cannot be altered. Structured fields mode must be used.
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Using larger buffers may increase the data transfer speed, but structured fields larger than 2K may not be 	 sup-
ported on older model controllers.

Max Block Length (kb) (4)
Enter the required block length in kilobits.

Advanced

TSO File Transfer Program
TSO Transfer Program()
Alternate transfer program to use for TSO hosts.

TSO Transfer Extra Params()
Extra parameters to be added to the TSO transfer command.

TSO Strict Host Ready Check (on)
When enabled TTWin will perform checks to test if you are on a host screen that supports file transfers. These 
can cause host not ready errors in some circumstances. If you see this error when in a location where your 
host allows transfers turn this off. If you start a transfer in an unsupported screen you will need to wait for the 
transfer to timeout.

TSO Auto Browse (on)
When enabled automatically populates remote file list.

Text Transfer Type Settings
ASCII (on)
When specified the program converts EBCDIC codes to 1-byte workstation codes, converts IBM host 
DBCS codes to 2-byte codes and removes SO/SI characters in the DBCS field. Default option for SBCS 
sessions.

CRLF (on)
When set to on this setting preserves carriage returns and line feeds.

Append (off)
Enables/disables append mode.

Text DBCS Setting
JISCII (off)
For use with Japanese DBCS sessions

NOSO (off)
This option instructs the program not to convert SO (hex 0E) and SI (hex 0F) before and after the 
DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E) and SI (hex 0F). 
(Send)



SO (off)
This option instructs the program to convert SO (hex 0E) and SI (hex 0F)to RS (hex 1E) and US (hex 
1F). (Receive)

USER (off)
This option instructs the program to not convert  SO (hex 0E) and SI (hex 0F) to RS (hex 1E) . US 
(hex 1F) and is written to a file without being converted (Receive)

Text Record Format
Format (Variable)
Specifies the record format for a new data set on your MVS/TSO volume.

>> Default.
>> Fixed. 
>> Undefined. 
>> Variable.

Block Size (0)
Specifies the size of the blocks of data in a new data set on your MVS/TSO volume. This setting is 
optional.

Record Length (133)
Specifies the record length for a new data set on your MVS/TSO volume, where n is a whole number 
from 1 through 32760 representing the number of characters per record. If you wish to set the record 
length for a new data set, replace n with the new length.

Text TSO Space Allocation
Allocation (Default)
Specifies an amount of space to be set aside for a new data set on your MVS/TSO volume. To set aside a 
certain number of blocks, tracks, or cylinders for the new data set:  

>> Default 
>> Average Blocks
>> Tracks
>> Cylinders

Average Block Size (0)
This setting specifies the length of a  block.

Quantity (0)
The amount of space that you want the data set to occupy (in the unit specified by the Allocation set-
ting).

Increment (0)
If the data set requires more space than specified in Quantity, the Increment value is the size of addi-
tional space to be used only when necessary.
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Binary Transfer Type Settings
ASCII (off)
When specified the program converts EBCDIC codes to 1-byte workstation codes, converts IBM host 
DBCS codes to 2-byte codes and removes SO/SI characters from the DBCS field. Default option for SBCS 
sessions.

CRLF (off)
When set to on this setting preserves carriage returns and line feeds.

Append (off)
Enables/disables append mode.

Binary DBCS Setting
JISCII (off)
For use with Japanese DBCS sessions

NOSO (off)
This option instructs the program not to convert SO (hex 0E) and SI (hex 0F) before and after the 
DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E) and SI (hex 0F). 
(Send)

SO (off)
This option instructs the program to convert SO (hex 0E) and SI (hex 0F)to RS (hex 1E) and US (hex 
1F). (Receive)

USER (off)
This option instructs the program to not convert  SO (hex 0E) and SI (hex 0F) to RS (hex 1E) . US 
(hex 1F) and is written to a file without being converted (Receive)

Binary Record Format
Format (Variable)
Specifies the record format for a new data set on your MVS/TSO volume.

>> Default
>> Fixed 
>> Undefined 
>> Variable

Block Size (0)
Specifies the size of the blocks of data in a new data set on your MVS/TSO volume. This setting is 
optional.

Record Length (0)
Specifies the record length for a new data set on your MVS/TSO volume, where n is a whole number 
from 1 through 32760 representing the number of characters per record. If you wish to set the record 
length for a new data set, replace n with the new length.



Binary TSO Space Allocation
Allocation (Default)
Specifies an amount of space to be set aside for a new data set on your MVS/TSO volume. To set aside a 
certain number of blocks, tracks, or cylinders for the new data set:  

>> Default
>> Average Blocks
>> Tracks
>> Cylinders

Average Block Size (0)
This setting specifies the length of a  block.

Quantity (0)
The amount of space that you want the data set to occupy (in the unit specified by the Allocation set-
ting).

Increment (0)
If the data set requires more space than specified in Quantity, the Increment value is the size of addi-
tional space to be used only when necessary.

Append Transfer Type Settings
ASCII (on)
When specified the program converts EBCDIC codes to 1-byte workstation codes, converts IBM host 
DBCS codes to 2-byte codes and removes SO/SI characters from the DBCS field. Default option for SBCS 
sessions.

CRLF (on)
When set to on this setting preserves carriage returns and line feeds.

Append (on)
Enables/disables append mode.

Append DBCS Setting
JISCII (off)
For use with Japanese DBCS sessions

NOSO (off)
This option instructs the program not to convert SO (hex 0E) and SI (hex 0F) before and after the 
DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO (hex 0E) and SI (hex 0F). 
(Send)

SO (off)
This option instructs the program to convert SO (hex 0E) and SI (hex 0F)to RS (hex 1E) and US (hex 
1F). (Receive)
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USER (off)
This option instructs the program to not convert  SO (hex 0E) and SI (hex 0F) to RS (hex 1E) . US 
(hex 1F) and is written to a file without being converted (Receive)

Append Record Format
Format (Default)
Specifies the record format for a new data set on your MVS/TSO volume.

>> Default
>> Fixed
>> Undefined
>> Variable

Block Size (0)
Specifies the size of the blocks of data in a new data set on your MVS/TSO volume. This setting is 
optional.

Record Length (0)
Specifies the record length for a new data set on your MVS/TSO volume, where n is a whole number 
from 1 through 32760 representing the number of characters per record. If you wish to set the record 

length for a new data set, replace n with the new length.

Append TSO Space Allocation
Allocation (Default)
Specifies an amount of space to be set aside for a new data set on your MVS/TSO volume. To set aside a 
certain number of blocks, tracks, or cylinders for the new data set:  

>> Default
>> Average Blocks
>> Tracks
>> Cylinders

Average Block Size (0)
This setting specifies the length of a  block.

Quantity (0)
The amount of space that you want the data set to occupy (in the unit specified by the Allocation set-
ting).

Increment (0)
If the data set requires more space than specified in Quantity, the Increment value is the size of addi-
tional space to be used only when necessary.



Debug

	Enable Debug (off)
	Select this option if you wish to have a debug/diagnostic file created. 

	Debug Verbosity (1)
	Select a value from 0 (least verbose) to 9 (most verbose). 

	Debug Log File (c:\ind$file.log) 
	Enter or select the name of the file to which you wish to save the debug information to.

Protocol Meta-Options

	Amount of debugging information (0)
	Select a value from 0 (least verbose) to 9 (most verbose). 
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IBM IND$FILE (Command Line)
IND$FILE file transfer is also available through a command line utility. Two executables, send.exe and 
receive.exe, are located in the TTWin installation directory (see Appendix C for program file locations) 
and can be used to send and receive files with TTWin's IBM3270 emulation and IND$FILE file transfer 
protocol. 

VM/CMS (Virtual Machine/Conversational Monitor System)

SEND ['][d:][\temp\]filename.ext['] [A:]fn ft fm [[[](options]

Bracketed items are optional.

  - The workstation drive and path of the file to send.

>> d: The workstation drive of the file to send
>> \temp\ The path to the directory where the file to send is located

  - The name of the file to send. Required. If the file name or workstation path includes spaces be sure to 
place quotes around this section as shown above.

  - Host session specifications for the file to be sent to the host.

>> A: The short name of the session (when using the default A:, this may be omitted).
>> fn The destination file name. Required.
>> ft The destination file type. Required.
>> fm The destination file mode (when using the default A:, this may be omitted).

  - Optional changes made to the file during transfer, note that the single open bracket (, must be included 
as it is an identifier required by IND$FILE. More than one option can be selected:

>> [: Use APVUFILE instead of IND$FILE. For use with Japanese host systems.

>> APPEND:  Appends the file being sent to an existing file. 
>> ASCII: When specified the program converts 1-byte workstation codes to EBCDIC codes, converts 
2-byte codes to IBM host DBCS codes and inserts SO/SI characters into the DBCS field and, if control 
characters (-> or <-) are found, converts the control characters to SO/SI characters.

>> CLEAR: Clears the workstation window at the beginning of the file transfer. This is the default option.
>> CRLF: Preserves carriage returns and line feeds.
>> JISCII : For use with Japanese DBCS sessions. 
>> LRECL n: Specify the file's record length. The default value is 80 for fixed length records and a maxi-
mum of 80 for variable length records.

>> NOCLEAR: Suppress the sending of the clear command at the beginning of a file transfer.
>> NOSO: For use with DBCS sessions. This option instructs the program not to convert SO (hex 0E) and 
SI (hex 0F) before and after the DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO 
(hex 0E) and SI (hex 0F).



>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages
>> RECFM x: File record format settings. Valid options are:

>> v: variable file record length.
>> f: fixed file record length.

>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.

RECEIVE ['][d:][\temp\]filename.ext['] [A:]fn ft fm [[[](options]

  - The workstation drive and path of the file to be received.

>> d: The local drive where the file will be received.
>> \temp\ The path to the directory where the file to be received will be saved.

  - The name of the file to be received.  If the file name or workstation path includes spaces be sure to 
place quotes around this section as shown above.

  - Host session specifications for the file to be received from the host.

>> A: The short name of the session (when using the default A:, this may be omitted).
>> fn The file name. Required.
>> ft The file type. Required.
>> fm The file mode (when using the default a:, this may be omitted).

  - Optional changes made to the file during transfer, note that the single open bracket (, must be included 
as it is an identifier required by IND$FILE. More than one option can be selected:

>> [: Use APVUFILE instead of IND$FILE. For use with Japanese host systems.

>> APPEND:  Appends the file being received to the end of an existing workstation file.
>> ASCII: When specified the program converts EBCDIC codes to 1-byte workstation codes, converts 
IBM host DBCS codes to 2-byte codes and removes SO/SI characters in the DBCS field. Default option 
for SBCS sessions.

>> BLANK: This option, when used in conjunction with the CRLF option will retain BLANK (x'40;) at the 
end of each line.

>> CLEAR: Clears the workstation window at the beginning of the file transfer. This is the default option.
>> CRLF: Preserves carriage returns and line feeds.
>> JISCII : For use with Japanese DBCS sessions. 
>> NOCLEAR: Suppress the sending of the clear command at the beginning of a file transfer.
>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages
>> SO: For use with DBCS sessions. This option instructs the program to convert SO (hex 0E) and SI (hex 
0F)to RS (hex 1E) and US (hex 1F).

>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.

>> USER:  For use with DBCS sessions with the options JISCII, ASCII, and SO. SO (hex 0E) and SI (hex 
0F) are not converted to RS (hex 1E) and US (hex 1F) and are written to a file without being converted.
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MVS/TSO (Multiple Virtual Storage/Time Sharing Option)

SEND  ['][d:][\temp\]filename.ext['] [A:]data-set-name [(member-name)]  

[/password] [[[]options]

  - The workstation drive and path of the file to send.

>> d: The workstation drive of the file to send
>> \temp\The path to the directory where the file to send is located

  - The name of the file to send. If the file name or workstation path includes spaces be sure to place 
quotes around this section as shown above.

  - The short name of the host session and the data set name of the file to send.

  -The member name if the file is in a partitioned data set. If you use member-name, you cannot use 
LRECL(n), BLKSIZE(n), RECFM(x), or SPACE(n,[n1]) unit options.

  -The password of the data set (if required).

  - Optional changes made to the file during transfer. More than one option can be selected. 

>> [: Use APVUFILE instead of IND$FILE. For use with Japanese host systems.

>> APPEND:  Appends the file being sent to the end of an existing MVS/TSO data set. You cannot use 
LRECL(n), BLKSIZE(n), RECFM(x), and SPACE(n,[n1]) unit in conjunction with this option. 

>> ASCII: When specified the program converts 1-byte workstation codes to EBCDIC codes, converts 
2-byte codes to IBM host DBCS codes and inserts SO/SI characters into the DBCS field. 

>> BLKSIZE(n): Specifies the size of the blocks of data in a new data set on your MVS/TSO volume. This 
part is optional. To set the block size for a new data set, replace n with the new size. Cannot be used in 
conjunction with the APPEND or member-name options.

>> CLEAR: Clears the workstation window at the beginning of the file transfer. This is the default option.
>> CRLF: Preserves carriage returns and line feeds.
>> JISCII : For use with Japanese DBCS sessions. 
>> LRECL n: Specifies the record length for a new data set on your MVS/TSO volume, where n is a whole 
number from 1 through 32760 representing the number of characters per record. If you want to set the 
record length for a new data set, replace n with the new length. If you omit this option, the record length 
is set to 80 for fixed-length records and to 255 for variable-length records. Cannot be used in conjunc-
tion with the APPEND or member-name options.

>> NOCLEAR: Suppresses the sending of a Clear command at the beginning of the file transfer. This option 
is required for ISPF command mode.

>> NOSO: For use with DBCS sessions. This option instructs the program not to convert SO (hex 0E) and 
SI (hex 0F) before and after the DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO 
(hex 0E) and SI (hex 0F).

>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages
>> RECFM x: Specifies the record format for a new data set on your MVS/TSO volume. Valid options are:

>> v: variable.
>> f: fixed.
>> u: undefined.



>> SPACE(n[,n1]) unit: Specifies an amount of space to be set aside for a new data set on your MVS/TSO 
volume. To set aside a certain number of blocks, tracks, or cylinders for the new data set: The following 
options are valid:

>> Specify unit as the type of space required (AVBLOCK, TRACKS, or CYLINDERS).
>> Give n as the amount of space that you want the data set to occupy (in the unit specified).
>> If the data set needs more space than you ask for with n, give n,n1 where n1 is the size of additional 
space to be used only when necessary.

If you omit this option, you get space for one block. The length of the block is set by the BLKSIZE(n) 
or LRECL(n) options. Cannot be used in conjunction with the APPEND or member-name options.

>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.

RECEIVE ['][d:][\temp\]filename.ext['] [A:]data-set-name [(member-name)] 

[/password] [[[]options]

  - The workstation drive and path of the file to be received.

>> d: The local drive where the file will be received.
>> \temp\ The path to the directory where the file to be received will be saved.

  - The name of the file to be received. If the file name or workstation path includes spaces be sure to place 
quotes around this section as shown above.

  - The short name of the host session, and the data set name of the file you are receiving.

  -The member name if the file is in a partitioned data set. If you use member-name, you cannot use 
LRECL(n), BLKSIZE(n), RECFM(x), or SPACE(n,[n1]) unit options.

  -The password of the data set (if required).

  - Optional changes made to the file during transfer. More than one option can be selected.

>> [: Use APVUFILE instead of $INDFILE. For use with Japanese host systems.

>> APPEND:  Appends the file being received to the end of an existing workstation file. 
>> ASCII: When specified the program converts EBCDIC codes to 1-byte workstation codes, converts 
IBM host DBCS codes to 2-byte codes and removes SO/SI characters in the DBCS field. Default option 
for SBCS sessions. 

>> BLANK: This option, when used in conjunction with the CRLF option will retain BLANK (x'40') at the 
end of each line.

>> CRLF: Preserves carriage returns and line feeds.
>> JISCII : For use with Japanese DBCS sessions. 
>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages.
>> SO: For use with DBCS sessions. This option instructs the program to convert SO (hex 0E) and SI (hex 
0F)to RS (hex 1E) and US (hex 1F).

>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.

>> USER: For use with DBCS sessions with the options JISCII, ASCII, and SO. SO (hex 0E) and SI (hex 
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0F) are not converted to RS (hex 1E) and US (hex 1F) and are written to a file without being converted.

CICS
SEND ['][d:][\temp\]filename.ext['] [A:]fn [ft] [[[](options)]

  - The workstation drive and path of the file to send.

>> d: The workstation drive of the file to send
>> \temp\ The path to the directory where the file to send is located

  - The name of the file to send. If the file name or workstation path includes spaces be sure to place 
quotes around this section as shown above.

  - Host session specifications for the file to be sent to the host.

>> A: The short name of the session (when using the default A:, this may be omitted).
>> fn The destination file name. Required.
>> ft The destination file type. Required.

  - Optional changes made to the file during transfer, note that the brackets (), must be included as they 
are an identifier required by IND$FILE. More than one option can be selected:

>> [: Use APVUFILE instead of IND$FILE. For use with Japanese host systems.

>> ASCII: When specified the program converts 1-byte workstation codes to EBCDIC codes, converts 
2-byte codes to IBM host DBCS codes and inserts SO/SI characters into the DBCS field.  Default option 
for SBCS sessions.

>> BINARY: Specifies that the data in the file is binary data. This is the default option for DBCS sessions.
>> CLEAR: Clears the workstation window at the beginning of the file transfer. This is the default option.
>> CRLF: Preserves carriage returns and line feeds. Default option for SBCS sessions.
>> JISCII : For use with Japanese DBCS sessions. 
>> NOCLEAR: Suppresses the sending of a Clear command at the beginning of the file transfer. This option 
is required for ISPF command mode.

>> NOCRLF. Valid for SBCS sessions only. This option is mutually exclusive with CRLF.
>> NOSO: For use with DBCS sessions. This option instructs the program not to convert SO (hex 0E) and 
SI (hex 0F) before and after the DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO 
(hex 0E) and SI (hex 0F).

>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages
>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.



RECEIVE ['][d:][\temp\]filename.ext['] [A:]fn [ft] [[[](options)]

  - The workstation drive and path of the file to be received.

>> d: The workstation drive of the file to be received.
>> \temp\ The path to the directory where the file to be received will be saved.

  - The name of the file to be received. If the file name or workstation path includes spaces be sure to place 
quotes around this section as shown above.

  - Host session specifications for the file to be received from the host.

>> A: The short name of the session (when using the default A:, this may be omitted).
>> fn: The source file name. Required.
>> ft: The source file type. Required.

  - Optional changes made to the file during transfer, note that the brackets (), must be included as they 
are an identifier required by IND$FILE. More than one option can be selected:

>> [: Use APVUFILE instead of IND$FILE. For use with Japanese host systems.

>> ASCII: When specified the program converts EBCDIC codes to 1-byte workstation codes, converts 
IBM host DBCS codes to 2-byte codes and removes SO/SI characters in the DBCS field. Default option 
for SBCS sessions.

>> BINARY: Specifies that the data in the file is binary data. This is the default option for DBCS sessions.
>> CLEAR: Clears the workstation window at the beginning of the file transfer. This is the default option.
>> CRLF: Preserves carriage returns and line feeds. Default option for SBCS sessions.
>> JISCII : For use with Japanese DBCS sessions. 
>> NOCLEAR: Suppresses the sending of a Clear command at the beginning of the file transfer. This option 
is required for ISPF command mode.

>> NOCRLF. Valid for SBCS sessions only. This option is mutually exclusive with CRLF.
>> NOSO: For use with DBCS sessions. This option instructs the program not to convert SO (hex 0E) and 
SI (hex 0F) before and after the DBCS field and not to not convert RS (hex 1E) and US (hex 1F) to SO 
(hex 0E) and SI (hex 0F).

>> PROGRESS:  Displays a message when the file transfer is in progress or has ended.
>> QUIET: Do not display any messages
>> SO: For use with DBCS sessions. This option instructs the program to convert SO (hex 0E) and SI (hex 
0F)to RS (hex 1E) and US (hex 1F).

>> TIMEn: Specify a timeout period where n is multiple of 30 seconds. If, after the specified time, the host 
has not responded an error message will be sent. Do not insert a space between TIME and n.

>> USER:  For use with DBCS sessions with the options JISCII, ASCII, and SO. SO (hex 0E) and SI (hex 
0F) are not converted to RS (hex 1E) and US (hex 1F) and are written to a file without being converted.
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Kermit
The Kermit file transfer protocol is a popular file transfer protocol. Originally developed at the Columbia 
University, it now has world-wide support on most types of computers.

Kermit supports both ASCII and binary data transfers. With error checking as part of the protocol it ensures 
that data is correctly transferred between computers, even when the connecting line is noisy.

Protocol Settings

	Conversation Mode (Automatic)
	Available options are:

>> Automatic
>> Text 
>> Binary

	Remote mode (on)
	If selected, the remote host Kermit will run in Interactive mode. In interactive mode a command must be 
issued to the remote Kermit each time you want to transfer a file. If not selected, most versions of the Kermit 
program have the ability to operate as a slave to a remote Kermit. This is referred as Server mode. Server mode 
reduces the effort required by the user to transfer files, since only the local transfer command needs to be 
given. (Instead of commands being given at both ends as with many other file transfer protocols).

Parity (None)
Available options include:

>> None
>> Even
>> Odd
>> Space
>> Mark

	Block check mode (1)
Available options are:

>> 1. 6-bit checksum
>> 2. 12-bit checksum
>> 3. 16-bit CRC

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new: TTWin will automatically rename the incoming file.
>> Discard new: The incoming file will be discarded.
>> Overwrite old: The existing local file will be overwritten.
>> Rename old: TTWin will automatically rename the existing local file.



Protocol Commands

	Receive Command (kermit)
	Enter the command required to execute a receive.

	Send Command (kermit)
	Enter the command required to execute a send.

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.

File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are redi-
rected to the File transfer directory.

File-Receive Options

Keep files incompletely received (off)
Select this if you wish incomplete transfer files to be kept.

Size of received buffer (1024)
Each packet can be up to 1024 characters long. By setting the receive buffer to 1024 you allow Kermit to 
support up to the maximum of a 1024 character packet length.

Some systems will require this buffer setting to be a different value, e.g., VMS 
Kermit suggests a setting of 94.

Timeout in 1/10 seconds (10)
This may need to be increased or decreased depending upon the speed of the host, and/or the quality of the 	
communication link between the PC and the host. 

File-Send Options

	Size of sending buffer (1024)
	Each packet can be up to 1024 characters long. By setting the local buffer to 1024 you allow Kermit to support 	
up to the maximum of a 1024 character packet length.

Some systems will require this buffer setting to be a different value, e.g., VMS 
Kermit suggests a setting of 94.
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Protocol Options

Perform end-of-line conversions (off)
XXX

Protocol Meta-Options

Amount of debugging information (0)
Select a value from 0 (least verbose) to 9 (most verbose). 

Do not Save (test receive only) (off)
XXX

Content Conversion (Automatic)
This setting controls how TTWin will handle file conversions.

>>  Text: converts UNIX LF's to CR LF (Receive), and CR LF to LF (Send)
>>  Binary: Data is Binary, no conversion is performed.
>>  Automatic: Automatically detects if the data is Text or Binary.



SFTP (SSH FTP)

Connection

IP Address ()
Enter the name or the IP address of the remote host you wish to connect to.

SFTP Port No (22)
Assign the port number you wish to use. The default is 22 as this is the port that is normally reserved for SSH.

login user name
Enter the login name of the user you wish to connect as to the remote host.

login password
Enter the login password for the above login user name.

Use Environment Variables (off)
When set to on, this option allows the use of Windows Environment Variables to set the username and pass-
word for SFTP login. This setting will override the login user name and login password settings.

Username environment variable()
Enter the system variable name that specifies the user login name. Use Environment Variables must be set to 
on. 

Password environment variable()
Enter the system variable name that specifies the user password. Use Environment Variables must be set to on.

Autoconnect on startup (off) 
When enabled, on opening the SFTP transfer tile ( Actions > Transfer a file ) a connection to the host will 
automatically be established using the login credentials supplied in login username and login password. When 
this option is disabled the SFTP transfer tile will open in an unconnected state and require the user to select 
the connect button to begin an SFTP session.

Auto disconnect on exit (off)
Close SFTP session on leaving File Transfer dialog. When off, SFTP connection is maintained until TTWin 
session is closed.

Directories

Remote Directory()
Specifies the remote host directory TTWin will attempt to change to when a host connection is established. If 
TTWin is unable to list this directory, for example because the supplied directory is invalid, the remote host's 
default directory will be used instead.

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.
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File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are redi-
rected to the File transfer directory.

For example if you set the File transfer directory alias path to c:\ and selected Action > Receive a file, 
naming the file to be received as test.txt, that file would be placed in c:\test.txt.

Protocol Settings

Block Time Out (10)
Set the time period (in seconds) that the file transfer waits for a remote response.

Content Conversion (Auto Detect)
This setting controls how TTWin will handle file conversions.

>> Text: converts UNIX LF's to CR LF (Receive), and CR LF to LF (Send)
>> Binary: Data is Binary, no conversion is performed. 
>> Auto Detect: Automatically detects if the data is Text or Binary.

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new: TTWin will automatically rename the incoming file.
>> Discard new: The incoming file will be discarded.
>> Overwrite old: The existing local file will be overwritten.
>> Rename old: TTWin will automatically rename the existing local file.

Delete Remote File When Overwriting (on)
Deletes remote host file before transferring the current file.

Text File Types (txt ini twc)
Specify a list of file extensions for files that TTWin will automatically treat as ASCII/text transfers.

Allow File Size Request (on)
Request remote file size before receiving file.



XModem/YModem
XMODEM and YMODEM are public domain error detecting file transfer protocols.

XMODEM uses 128 byte blocks for communications. Only a single file can be sent per command and a file-
name must be given for both the host file and the local file. This means that wildcards cannot be used.

YMODEM uses the CRC method of error detection/correction to determine any transmission errors. It uses 
1024 byte blocks for data communications and unlike XMODEM it supports wild cards such as * and ? in file-
names so that multiple files can be transferred with one request.

Protocol Settings

Block Time Out (10)
Set the time period (in seconds) that the file transfer waits for a remote response.

Maximum retry errors (10)
The maximum acceptable number of errors received while transmitting the same packet before the file transfer 
aborts.

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new. TTWin will automatically rename the incoming file.
>> Discard new. The incoming file will be discarded.
>> Overwrite old. The existing local file will be overwritten.
>> Rename old. TTWin will automatically rename the existing local file.

Protocol variant (X-modem)
Available options include: 

>> X-modem
>> X-modem CRC
>> X-modem 1k
>> Y-modem
>> Y-modem-g 
>> SEAlink

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.

File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are 
redirected to the File transfer directory.
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File-Receive Options

Skip if File Does Not Exist (off)
Source files that do not already exist as destination files are not transferred.

Protocol Commands

Receive command (rx)
The command used to receive files.

Send Command (sx)
The command used to send files.

Protocol Options

Send large blocks (off)
Use a block size of 1024 bytes for all transfers.

Perform end-of-line conversions (off)
xxx

Append ^Z to file (off)
With some early systems, such as CP/M, data ends exactly on a 128-byte boundary, with a CR in 127 and LF in 
128. Appending a subsequent sector containing ^Z([CTRL_Z]) is preferred, but optional

Some utilities and user programs cannot handle EOF with a ^Z(CTRL_Z).

Request CRC from host (off)
When receiving files, TTWin informs the remote transfer module that CRC error checking will be used.

Verify EOT (off)
The sender sends a NAK character on receipt of an EOT character, then waits for an ACK character to be 
returned. This provides for synchronization and flow control.

Streaming Mode (off)
xxx

Allow ^X^X to abort (off)
When selected, sending the ^X ([CTRL_X]) sequence at least twice will terminate the current file transfer.

Send ^X^X to abort (off)
If a file transfer error is detected, the receiver aborts the transfer by sending a multiple ^X [CTRL_X] sequence.



Protocol Meta-Options

Do not Save (test receive only) (off)
Performs a test receive only and does not save any file.

Write debug log (off)
Select this option if you wish to have a debug/diagnostic file created.

Level of Diagnostics (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Content Conversion (Auto Detect)
This setting controls how TTWin will handle file conversions.

>> Text: converts UNIX LF's to CR LF (Receive), and CR LF to LF (Send)
>> Binary: Data is Binary, no conversion is performed.
>> Auto Detect: Automatically detects if the data is Text or Binary.
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ZModem
ZMODEM is a public domain protocol that can use both 16 and 32 bit CRC error detection. It does not use 
fixed length data blocks but instead varies their length so that it is better able to handle interference on its 
transmission path.

ZMODEM also caters for interrupted file transfers so that once the communications line is clear again the 
transfer can be restarted from where it left off.

Protocol Settings

Block Time Out (10)
Set the time period (in seconds) that the file transfer waits for a remote response.

Maximum retry errors (10)
The maximum acceptable number of errors received while transmitting the same packet before the file transfer 
aborts.

Maximum Blocklength (1024)
Size of data packets, specified in bytes. The available values are: 

>> 64
>> 128
>> 256
>> 512
>> 1024

Maximum Windows Size (4096)
The maximum size to use for the window. When selected, available values are: 

>> 256
>> 512
>> 1024
>> 2048
>> 4096

Override Window Size (off)
xxx

If Incoming File Exists (Rename new)
Select the action TTWin will take if a downloaded file already exists on the local device. Options are:

>> Rename new. TTWin will automatically rename the incoming file.
>> Discard new. The incoming file will be discarded.
>> Overwrite old. The existing local file will be overwritten.
>> Rename old. TTWin will automatically rename the existing local file.



File-Receive Options

Overwrite Existing File? (Clobber)
Available options include:

>> Newer or Longer 
>> Different CRC
>> Append
>> Clobber
>> Newer
>> Different
>> Never

Skip if File Does Not Exist (off)
This option is used in combination with the above algorithms. Source files that do not already exist as destina-
tion files are not transferred.

Transfer Mode

Automatic Restart (off)
When the communications line is clear again the transfer is restarted from where it left off.

File transfer directory (C:\Users\{user}\Documents\FileTransfer)
Specifies the default file transfer directory used by TTWin. This path is used if no alternative path is provided.

File transfer directory alias()
Specifies an alias for the File transfer directory. If the alias path is given during the transfer the files are redi-
rected to the File transfer directory.

Protocol Commands
Receive Command (rz)
The command used to receive files.

Send Command (sz)
The command used to send files.

Protocol Options

Escape All Codes (off)
Escape High-bit Data (off)
Convert Filenames to Lower Case (on)
Send Full Pathname to Host (off)
Use CP/M End-of-File (off)
Use 16-bit CRC (off)
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Challenge Sender (off)

Protocol Meta-Options

Do not Save (test receive only) (off)
Performs a test receive only and does not save any file.

Write Debug Log (off)
Select this option if you wish to have a debug/diagnostic file created.

Level of Diagnostics (0)
Select a value from 0 (least verbose) to 9 (most verbose).

Content Conversion (Automatic)
This setting controls how TTWin will handle file conversions.

>> Text: converts UNIX LF's to CR LF (Receive), and CR LF to LF (Send)
>> Binary: Data is Binary, no conversion is performed. 
>> Automatic: Automatically detects if the data is Text or Binary.

Initiating a File Transfer
For information on how to initiate a file transfer refer to Chapter 6. Actions Menu.



Chapter 20: Keyboard Mapping

Remapping the TTWin keyboard.
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Keyboard Mapping
TTWin's keyboard mapping is extremely flexible and allows you to have as many different keyboard configura-
tions as you require. You can have a different keyboard configuration for each application and/or emulation.

To assist you in the configuration of your keyboard, a standard keyboard mapping file is automatically installed 
with each emulation. If you wish, you can customize this file or design your own. 

With TTWin you have the ability to program just about any key to match an emulation key, to send a string or 
macro sequence.

Global Mappings versus Emulation Mappings

TTWin provides both global and emulation key mappings. Because global mappings are saved in the configura-
tion file (.TWC), you can use global mappings to enforce a certain key mapping for all the emulations that are 
also held in that .TWC file.

Beneath the global level there is an emulation level where mappings for individual emulations can be defined. 
The emulation mappings are saved in a .KEY file, the key definition file, which forms part of the emulation 
environment.

A global mapping always takes precedence over an emulation mapping i.e., global mappings override whatever 
that key is mapped to do in an emulation mapping.

If you only ever want to communicate with one host application using one emulation then global mappings or 
emulation mappings will achieve this. However, if you want to communicate with different applications, per-
haps on different hosts, you may wish to map some keys globally and some keys to the emulations.

Or you may want to communicate with one host and with one emulation, but the host has two applications 
that require different mappings for one or more keys. The majority of keys could then be held as global map-
pings, with the remaining as emulation mappings.

As global key mappings are saved in the .TWC file or session file, you will need to 
configure the keyboard for each session file that you use.



Keyboard Mapping

In keyboard mapping it is important to distinguish between physical keys and emulation keys. The physical 
keys are the keys on the physical keyboard attached to your PC. Emulation keys are the keys found on the ter-
minal being emulated. This may, for example, include the GOLD PF1 key on a VT220 terminal.

There are two approaches to mapping the keyboard:

>> Mapping an emulation key. When mapping an emulation key it is only possible to map a physical key 
to the emulation key. However, this can prove to be far easier than trying to work through physical PC key 
mappings, although clearly it is not possible to create global mappings this way.

>> Mapping a physical key. You can map either a string or an emulation key to a physical key. Both global and 
emulation mappings are possible this way. Global mappings take precedence over emulation mappings.

While global mappings are typically used for string assignments, they may also be used to run macros or to map 
escape sequences to the keys.

Configuring the Keyboard

When you select the Keyboard... option from the Configure menu the Configure Keyboard tile is dis-
played. The physical PC keyboard is always shown in the top of the tile and the emulation keyboard is always 
shown in the bottom of the tile.

Figure 20.1 Keyboard configuration.
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The standard mappings are automatically set for the emulation that you have chosen. If you require an alter-
native keyboard mapping, please contact Turbosoft with your request. (See Appendix B for support contact 
details).

To assign a physical key(s) to an emulation key follow these 6 steps:

You can use the SHIFT, ALT and CTRL keys together with a physical or emula-
tion key, if required.

1	Select Keyboard... from the Configure menu.  The Configure Keyboard tile is displayed. (Make sure 
that the correct emulation and physical keyboards are selected.)

2	Click on the emulation key(s), in the bottom half of the tile, you wish to map. The physical key along with 
the shift state currently mapped to the selected emulation key(s) is highlighted in the top of the tile. 

3	Click on the physical key(s), in the top half of the tile, you want to assign to the selected emulation key. 

4	To save the mapping, click on the Map button. Emulation mappings are saved in a key definition file. By 
default this is the file DEFAULT.KEY.

5	Repeat the above steps for all the emulation keys you need to map. 

6	To save session settings, you must also save the .TWC file by selecting Save from the File menu.

For example, to map the physical PC sequence [CTRL_SHIFT_F6] to the currently selected emulation key, 
scroll down the physical key list and select the F6 key, finally check the Shift and Ctrl boxes.

Mapping Physical Keys

You create mappings for physical keys in three ways, with:

>> An emulation key from the current emulation, e.g., the VT220 PF1 key. 
>> A global escape sequence, string or macro, e.g., ^[[1M - the ANSI sequence for bold text. 
>> An emulation specific escape sequence, string or macro.

Global mappings take precedence over emulation mappings.



To map an emulation key, global or emulation string to a physical key or key sequence, follow these steps:

You can use the [SHIFT], [ALT] and [CTRL] keys together with a physical or 
emulation key, if required.

1	Select Keyboard... from the Configure menu, the Configure Keyboard tile is displayed.

2	Select the physical key, in the top half of the tile, you wish to map. The emulation key, global or emulation 
string currently mapped to the selected physical key is highlighted or displayed in the top of the tile. 

3	Select one of:

>> Emulation key, go to step 4.
>> String, go to step 5.
>> Global string, go to step 5.

4	Emulation key: Click on the emulation key, in the bottom half of the tile, you want to assign to the selected 
physical key. 

5	String or Global string: You can assign an ASCII data string, an escape sequence or a macro to the physical 
key. Enter the string or macro in either the String or Global string field. 

6	To save the mapping, click on the Map button. Emulation mappings are saved in a key definition file. By 
default this is the file DEFAULT.KEY. 

7	Repeat the above steps for all the physical keys you need to map. 

1	To save session settings and global mappings, you must also save the .TWC file by selecting Save configu-
ration (default.twc) or Save configuration as... from the File menu.

For example, to map the ANSI BOLD escape sequence (ESC[1m) to [CTRL_F6] for the current emulation, 
follow these steps:

1	Click on the [CTRL] key and the [F6] key on the PC keyboard (top of the tile).

2	Select String. 

3	 In the String field enter the string: \x1b[1m where \x1b represents the hex value for ESCAPE character. 

Hex values are prefixed by \x

4	Click on the Map button to save the mapping. 

5	To save the session settings, select Save config (default.twc) or Save configuration as... from the File 
menu.
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.

Figure 20.2 Mapping a string.

Removing a Mapping

Click on the Remove button to remove a mapping. Alternatively, re-map BOTH the physical key(s) and the 
emulation key(s).

Saving a Mapping

To save a mapping , click on the Map button. Emulation mappings are saved in a key definition file, i.e., a 
.KEY file. By default this is the file DEFAULT.KEY.

You MUST also save the .TWC file using the Save configuration (default.twc) or Save configuration as... 
option on the File menu to secure session settings and global string mappings.

Keyboards

Click on the Keyboards button to select from your customized PC keyboard and Emulation keyboards that 
have been saved on your system. 



 Figure 20.3 Selecting keyboards.

Advanced

Click on the Advanced button to set the default state of the Numeric Keypad and Caps Lock once TTWin is 
started.

Figure 20.4 Numeric Keypad and Caps lock states.
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Chapter 21: Colors

Creating and changing the color scheme.
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Color Configuration
The Color Configuration tile allows you to choose or create your preferred terminal color scheme.

To configure the terminal color scheme select Colors… from the Configure menu. The Color 
Configuration tile, as shown in Figure 21.1 appears. Scroll through the sample text list to view the chosen 
color scheme appearance.

Figure 21.1 Configure colors.

Color Scheme

The available, predefined, visual attribute color mappings are displayed by clicking on the drop-down menu. 
All listed color schemes are stored in your TTWIN.CLR file, allowing several predefined sessions to use the 
same color scheme. 

Save as... 
Select this button to save a new color scheme or make a backup copy of an existing scheme. A new color 
scheme is created using the Change button. 



Remove
Select this button to remove a listed color scheme that is no longer required.  The Remove option is disabled 
when the custom color scheme is selected.

You can not retrieve a color scheme once it has been removed! 

Show Attribute Combinations

This portion of the configuration tile enables you to tailor those attribute combinations that will be shown in 
the Sample text box. This allows for the fact that some emulations only support a subset of the available attri-
butes. Also you may not want to show attribute combinations that have invisible as one of the attributes. 

All 
Selecting All enables all combinations of attributes to be selected in the Sample text box. 

Emulation 
Selecting the Emulation button makes only those attributes which are used by the current emulation avail-
able for mapping. For example, VT220 does not support the Dim attribute while Wyse 60 does. Hence with 
the Emulation option, a color scheme created with VT220 as the current emulation will not include any user 
defined Dim attribute color mappings if later used with the Wyse 60 emulation.  

Include invis.
Checking the Include invisible box will show or hide any attribute combinations that have invisible as one of 
the attributes.

Creating and Changing a Color Scheme 
To create a new scheme, click on the drop-down menu on the Color scheme field. Then select either an 
existing color scheme to modify or simply choose the (custom) color scheme to start afresh. 

To change an existing color scheme, click on the drop-down menu on the Color scheme field. Then select 
the color scheme you wish to modify.
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Figure 21.2. Editing a color scheme.

To change the selected attribute combination, click on the Change... button. This will open the Edit 
Attribute tile, from here you can assign your preferred color mappings to the available attributes as well as the 
various features for underline, overline and/or strike-through features. 

Attributes
The Edit Attribute tile allows any aspect of the attribute combination to be added or removed.

Clicking the mouse on the checkbox adjacent to the features will include or exclude this feature from the cur-
rent selected attribute combination. The features are:

>> Blink 
>> Reverse
>> Underline 
>> Bold
>> Overline 
>> Dim
>> Strike out
>> Invisible
>> Box

Override color
The Override color option determines whether the colors used when mapping the attribute combinations are 
those used by the normal attribute or are an independent set of colors. If selected, the colors are independent. 
Any change to the color set used by the normal attribute will have no effect on this attribute combination and 
vice versa.  



Override color must be selected before you select the new color from the Color 
palette.

Color palette
The Color Palette represents those colors that are available for use in mapping attribute combinations. The 
actual number of colors in the palette display is fixed at sixteen, shown as two banks of eight. 

The foreground color of the attribute being changed, may be selected from the palette by clicking the left 
mouse button on the color required. The letter F marks the selected color as the foreground color.

Similarly, the background color may be changed by clicking the right mouse button on the color required. The 
letter B marks the color as being as the background color.

Remember, if you want to override the colors used by the normal attribute you must select Override color 
before changing the foreground or background color.

Changing the foreground or background colors will change the name of the color 
scheme to custom. If you want to change an existing color scheme you must 
specify the name of the color scheme when you save your changes.

Figure 21.3 Configure Palette tile.
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Palette Configuration

Clicking on the Palette... button activates the Configure Palette tile as shown in Figure 21.3.

The colors that make up the palette displayed on the Edit Attribute tile (Figure 21.2) may be changed 
through this tile. 

Current palette entry
A preview of the currently selected palette entry is given beside the Index: entry box.

Index
The number in the Index: field is that of the foreground color. Each color in the color palette is given an index 
number. Starting with the top left-hand color as 0 then reading left to right the numbers increase by 1.

For example, in a 16 color palette, the top row is 0 to 7 and the second row is 8 to 15. To change to a different 
color in the Color palette, click on the drop-down menu on the Index: field.

Color levels
Having selected the current palette entry, you can vary the color of that entry by varying the Color levels. By 
moving the sliders or by entering the appropriate number for Red, Green and Blue, the saturation of these 
color components in the palette color is changed. Moving the sliders to the right increases the saturation.

Red:, Green:, Blue: 
The percentage of red, green and blue saturation (respectively) in the new user configured color. The preview 
window next to the Index: field shows the new color.

When the color is as required, click on the OK button. This will move the new color into the Color palette, 
replacing the previous color. All attributes that use this color are changed.



Figure 21.4. Advanced attribute configuration

Advanced Attribute Configuration

You can set preferences for the way the screen features are shown, the way the bold and dim attributes are 
determined and also which box style to use. Clicking on the Advanced... button on the Color configuration 
tile activates the Advanced Attribute Configuration tile shown in Figure 21.4.

Preferences
Disable blink in emulation
This enables or disables blinking in an emulation. If selected, text in an emulation that has the blink attri-
bute will not blink. 

Disable blink in config window
This enables or disables blinking in the config window. If selected, text in the Color configuration tile that 
has the blink attribute will not blink. 

Disable Invisible in emulation
This enables or disables invisibility in an emulation. If selected, text in an emulation that has the invisible 
attribute will remain visible. 

Disable invisible in config window
This enables or disables invisibility in the config window. If selected, text in the Color configuration tile 
that has the invisible attribute will remain visible.
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Bold & dim emulation: 
>> Bold: Click on the drop-down menu on the Bold field, to select the method by which the Bold is deter-
mined.

>> Dim: The Dim attribute is built up in a similar way to the Bold attribute. Click on the drop-down menu on 
the Dim field and select from the list of algorithms.

The Bold and Dim attributes are generated from the normal color by means of an algorithm. The available 
methods being: 

>> Next color: Select the color with an index number one higher than the color of the text that is bold. If the 
color is the last in the palette, use the first in the palette. 

>> Previous color: Select the color with an index number one lower than the color of the text that is bold. If 
the color is the first in the palette, use the last color in the palette.

>> Next group: Select the color in the same position as that of the bold text, but in the next group. If on the 
last group, don't change.

>> Previous group: Select the color in the same position as that of the bold text, but in the previous group. If 
on the first group, don't change.

>> Toggle group: Select the color in the same position as that of the bold text, but in either the lower or upper 
bank depending on the bank the color is in.

Box style
The box style will apply to any attribute that has the box feature enabled. The available styles are:

>> Lines: This will put a single pixel box around each character whose attribute has the box feature enabled.
>> Raised: This will put a raised box around each character whose attribute has the box feature enabled.
>> Lowered: This will put a lowered box around each character whose attribute has the box feature enabled.
>> Raise (shallow): This will put a shallow raised box around each character whose attribute has the box fea-
ture enabled.

>> Lowered (shallow): This will put a shallow lowered box around each character whose attribute has the box 
feature enabled.

>> Merge vertically adjacent boxes: If checked, then any groups of vertically adjacent rows will appear as a 
single box, when unchecked each row of characters will be boxed.

Horizontally adjacent characters will not be separated by a vertical line.

Background Image
TTWin can display a bitmap graphics file (BMP) as the background of each session. The Style (default is 
(none)) setting allows the bitmap to appear in the following ways:

>> Center: Will display the bitmap centered in the TTWin window, no resizing is done to the image.
>> Tile: Will fill the background with as many copies of the bitmap as is required.
>> Stretch: Will resize the bitmap so that it fills the entire background area. 

The file option contains the full path and filename of the bitmap to be used, clicking the ... button allows you 
to browse for the required bitmap.



Figure 21.5. TTWin session with background image enabled.

Saving a Color Scheme

After creating a new color scheme or editing an existing color scheme, click on the Save As… button on the 
Color configuration tile. The Save Color Scheme tile will appear.

Enter the name for the color scheme in the Save scheme as: field and press OK.
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Chapter 22: Misc. Configuration

Other TTWin configuration options.
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Miscellaneous Configuration
To access these configuration options select Configure > General from the main menu and scroll down to 
the required section on the configuration tile.

Figure 22.1 TTWin configuration.

Capture

Compress diagnostic captures (on)
This setting determines the default state of the compression option found under Actions > Capture. Select  
this option if you wish the diagnostic capture file to be compressed by default.

Compression Level (9 (best compression))
Enter a value from 1 (fastest, minimal compression) to 9 (slowest, best compression).

User Details

LoginName ()
This information is made available for use as a Macro variable.

Password ()
This information is made available for use as a Macro variable. For information on Macros refer to Chapter 16.



Clipboard

Shortcut key for clipboard copy (None):
>> None: No shortcut key is defined.
>> Ctrl +C: The sequence [Ctrl_C] is to be used as the copy shortcut.
>> Alt + C: The sequence [Alt_C] is to be used as the copy shortcut.

Shortcut key for clipboard cut (None):
This item specifies the cut text operation for block mode terminals. On all other terminals a copy operation is 
performed. Options are:

>> None: No shortcut key is defined.
>> Ctrl +X: The sequence [Ctrl_X] is to be used as the cut shortcut.
>> Alt + X: The sequence [Alt_X] is to be used as the cut shortcut.

Shortcut key for clipboard paste (None):
>> None: No shortcut key is defined.
>> Ctrl +V: The sequence [Ctrl_V] is to be used as the paste shortcut.
>> Alt + V: The sequence [Alt_V] is to be used as the paste shortcut.

Shortcut key for clipboard paste undo (None):
This item will undo the last paste operation on block mode terminals. Options are:

>> None: No shortcut key is defined.
>> Ctrl +Z: The sequence [Ctrl_Z] is to be used as the paste undo shortcut.
>> Alt + Z: The sequence [Alt_Z] is to be used as the paste undo shortcut.

Space clears unprotected selected data (IBM3270/5250) (off)
When enabled, text selected in unprotected fields will be cleared when spacebar is pressed.

Marking/Copy:
Use shift+arrow keys for marking (off)
When selected allows shift + arrow keys to be used for marking.

Full screen copy by default (off)
When this option is set to on and a copy operation is performed while no text is selected, TTWin will copy 
the entire screen.

Trim trailing spaces on copy (on)
When selected deletes any spaces from the end of the selected text.

Include RTF format when copying to the clipboard (off)
When copying selected text to the Windows clipboard TTWin will copy data in Rich Text Format, retaining 
formatting for use in programs such as Microsoft Word.
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RTF Font Size (10)
Sets the font size in points for any pasted Rich Text Format text. This setting requires Include RTF for-
mat when copying to the clipboard to be set to on.

RTF use smaller font if line longer than (chars) (80)
When RTF copy is enabled via Include RTF format when copying to the clipboard, selections with a 
greater number of characters on a line then specified in this setting will use a small RTF font when copied.

RTF Small Font Size (10)
Sets the small font size in points for any pasted Rich Text Format text. This setting is utilized when there 
are more characters on a single line that specified in RTF use smaller font if line longer than (chars).

Shift+arrow marking mode (Rectangular marking):
Available options are:

>> Continuous marking:  This highlights a continuous line of text from the display area. The selection 
starts at the row and column location corresponding to the current cursor position when the command was 
issued and includes all partial and complete lines of text up to the location at which the keys are released.

>> Rectangular marking: This highlights a rectangular portion of the display area.

Pause when marked (on)
Places the screen into a paused stated until marking/copy is completed.

Enable internal copy format (off)
Enables the internal format for (IBM) block mode terminals. When performing a copy operation field data 
is retained for subsequent pasting within TTWin

Internal copy input fields only (off)
When using Internal copy format (as set in Enable internal copy format), only text from input fields are 
copied to clipboard.

Paste:
End-of-line text (\r)
The character that will be appended to the end of the pasted line.

End-of-field text ()
The character that will be appended to the end of the pasted field.

Field separator text ()
The character that will be appended to the end of each pasted field.

Start text ()
Text which will be prepended to the pasted text.

End text ()
Text which is appended to the pasted text.



Process key-macros in pasted text (off)
When selected any macro present in the pasted text will be executed.

Line delay (ms) (50)
The time delay in milliseconds between each pasted line.

Character delay (ms) (0) 
The time delay in milliseconds between each pasted character.
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Chapter 23: Hotspots

Enhanced mouse driven terminal events.
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Hotspots
A Hotspot is an area of the terminal screen which triggers a mouse event, enabling an otherwise keyboard 
driven host application to work with mouse interaction.

The appropriateness of hotspots for the TTWin user will very much depend upon the nature of the applica-
tions that you are running.

In particular, if your applications are menu based then you will find that hotspots allow you to design a more 
user-friendly environment.

Screen Regions

The active area for a Hotspot can be either a fixed area of the TTWin display screen or dynamically determined 
based on the screen content.

For example, the Hewlett Packard HP2392 terminals use a fixed area across the bottom of the screen to act as 
status labels for the function keys. In this case, you might choose to use a Hotspot with a permanent, fixed 
location based on the screen coordinates of the specified status label.

Figure 23.1 An example of a Hotspot in TTWin, in this instance enhancing the status labels on a Hewlett 
Packard HP2392 terminal session.

Dynamically positioned Hotspots are positioned based on the appearance of a particular word or character 
sequence displayed anywhere on the screen.

For example, the IBM3270 class of terminals are often used with host applications that use the F3 key to EXIT. 
The string ‘F3 = Exit’ may be located anywhere on the screen. In this case, you would use a string matched 
Hotspot that would look for the string “F3 = Exit”.

Hotspots can be configured to autoexecute or to be activated by clicking the mouse button on the defined 
screen region.



Configuring Hotspots
To configure a Hotspot select the Configure > Hotspots… from the program menu. The Configure 
Hotspots tile is then displayed.

Figure 23.2 TTWin Hotspots configuration.

Hotspot List

Description
This is a list of the hotspots in the Hotspot set shown in the HotSpot Set field.

Enable Hotspots 
This option allows you to turn on and off the currently displayed Hotspot set. To enable the currently dis-
played Hotspot set you must tick this box.

Definition File

HotSpot Set 
Different emulations or applications may require different configurations of hotspots. To accommodate this, 
hotspots are held as sets individually within the file. Each set can contain as many hotspots as you require for 
the particular emulation/application.

HotSpot File
TTWin keeps all the Hotspot sets in .HSP files. The Hotspot definition file can contain any number of 
Hotspot sets. By default, the file is DEFAULT.HSP (located in the CONFIG subdirectory).
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Creating, Copying and Editing Hotspots
Using the drop-down menu on the HotSpot Set field, select the required Hotspot set.

To create a new Hotspot set you must edit an existing Hotspot set by adding new 
hotspots, deleting unwanted hotspots and editing existing hotspots. Finally, sav-
ing it with a new name.

To create a new Hotspot click on the New... button.

To copy an existing Hotspot, select the Hotspot from the HotSpot List then click on the Copy button.

To edit a Hotspot, select the Hotspot from the HotSpot List then click on the Edit... button.

When you click on either the New... button to create a new Hotspot, the Copy button to copy a Hotspot or 
the Edit... button to edit an existing Hotspot, the Configure HotSpot tile is displayed.

Figure 23.3 Configure a HotSpot.

General Parameters

Description 
Enter a description for the Hotspot. The description is also used as the name of the Hotspot.



Send String (Hotspot Action)
When a Hotspot is triggered the string entered here is sent to the host. This can be either a literal string or a 
macro string for more advanced functionality. When specifying a literal string and a carriage return is required, 
append a \r to the string.

For more advanced options Hotspot actions can be used to send emulation keys, trigger program menu com-
mands and much more. The ... button opens the Macro Assistant, for further detail on macro capabilities and 
how to use the Macro Assistant refer to Chapter 16 - Macros.

Button Style 
Click on the drop-down menu of the Button Style field, then select a button style from the eight predefined 
styles. The example button immediately to the right provides a preview of the selected style

Position 
The position of the Hotspot can be either Permanent or Relative to Matched String.

Permanent 
Once configured and enabled the section of the screen will always be a Hotspot and a mouse click in this 
area will always trigger the Hotspot action.

Relative to Match String. 
This indicates that TTWin is to constantly search an area of the screen to see if it contains the text declared 
using the String to Match... option.

Area
These fields are used to define the area in which the Hotspot is to be located. The screen coordinates are 
entered in as row and column values.

If Permanent is selected, the coordinates for the Hotspot are entered.

For example, if you are using an HP2392 emulation with fixed status labels for the function keys, F1 to F8, 
then you could define permanent hotspots for each status label. The status labels appear in the bottom two 
rows and are seven columns wide, so the coordinates for the F1 status label would be Left: 0 Top: 24 Right: 7 
Bottom: 25.

If String to Match... is selected, then the coordinates of area where TTWin is to search for the string are 
entered.

For example, if you have specified a Hotspot to match the string “Menu”, but only if it occurs on row 1 or row 
2 of an 80 column wide display you need to set the Area: to Left: 0 Top: 0 Right: 80 Bottom: 2.
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Specifying the Hotspot Match String

If you select the Hotspot position to be Relative to Match String then you MUST specify a String to 
Match....

Selecting the String to Match... button displays the Configure HotSpot Match String tile 

Figure 23.4. TTWin configure a HotSpot Match String.

MatchString Parameters
String 
The exact string that you wish to match.

PreChar 
Any character that will always proceed the string. The string is only to be matched if it follows the character 
specified.

PostChar 
Any character that will always follow the string. The string is only to be matched if it is followed by the 
character specified.

Pre/Post Char options
>> Exclude pre/post chars from hotspot region.
>> Include pre/post chars in hotspot region.
>> Include pre/post chars as blanks.

Case sensitive 
If you require the match string to be case sensitive.



Wildcards 
When checked the string entered at String will match on wildcards. The following wildcards are valid:

>> An asterisk (*) will match any text for inclusion in a Hotspot. For example a String entry of A*F would 
match the following: 

- "123 ASDFGHJK" where the * matched SD  
-"123 AFTERNOON" where the * matched no characters and AF was matched on

Placing the (*) wildcard at the end of the String entry, for example an entry of AF*, will result in the 
Hotspot finishing on either the next PostChar or, if no PostChar exists, the end of the line. 

>> A period (.) will match on any single character. For example a String entry of T.E would match the fol-
lowing:

- "123 TEA CAKE" where the . matched TEA
- "123 TREE FROG" where the . matched TRE 

>> Combinations of asterisk (*) and period (.) wildcards are valid. For example:

- A String entry of .a* would match "Easter" in the text "xyz Easter" 
- A String entry of 1.3.5 would match "12345" or "1A3B5" 

Exclude spaces from wildcards
When selected spaces will not match a wildcard.

Autoexecute 
TTWin will autoexecute if it detects the string.

For example, the string “Login:” could be used to trigger the sending of a username or to launch a script 
to log the user in.

Setting the Hotspot Color

The color of the Hotspot set can be adjusted to suit your preference. It will, however, depend upon a number 
of factors, for example, the video drivers and color resolution of your Windows setup.

Hotspots can take either the screen color or you may override the screen color. Click on the Colors... button 
set the color of the selected Hotspot.

The Configure Hotspots Colors tile will appear.
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Figure 23.6 Configure Hotspot colors tile.

Colors
Use the emulation foreground color
This automatically sets the text color to the normal attribute color for text. When set the color sliders for 
Foreground will be locked.

Use the emulation background color
This automatically sets the background color to the normal attribute color for the background. When set 
the color sliders for Background will be locked.

Red:, Green: and Blue:
By moving the sliders for Red, Green and Blue, the saturation of these color components is changed. 
Moving the sliders to the right increases the saturation.

The sliders for Foreground change the color of the text. The result is displayed in the Sample box.

The foreground and background colors will affect all the hotspots in the set.



Saving the Hotspot Set

You must also save the .TWC file to ensure that the Hotspot set is saved in the 
session file

Click on the Save button to save the hotspots in the HotSpot List. The hotspots are saved in the Hotspot set 
specified in the HotSpot Set field. See Figure 23.2 for more detail

By default, the Hotspot set is saved in the DEFAULT.HSP file located in the CONFIG sub-directory.

Alternately click on the Save As... button to save the hotspots in the HotSpot List to a new Hotspot set. The 
Save HotSpot Set tile is displayed.

Figure 23.7 Save a HotSpot Action.

Save HotSpot As 
Enter a name for the Hotspot set. By default, the Hotspot set is saved in the DEFAULT.HSP file located in the 
CONFIG sub-directory.

Deleting Hotspots

To delete an existing Hotspot, select the Hotspot from the Hotspot List, then click on the Delete button.
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Appendix A

Glossary
ActiveX is a term applied set of technologies developed by Microsoft in for sharing information and function-
ality among different applications. An OCX is an ActiveX control, a module which can be accessed by other 
applications.

ANSI (American National Standards Institute) The U.S. standardization body. ANSI is a member of the 
International Standardization Organization (ISO)

API Application Program Interface.

ASCII (American Standard Code for Information Interchange) This is one of the methods of represent-
ing text characters inside a computer.

Attribute This is a way of enhancing characters on screen by adding features such as underline, bold or a 
color.

Break Signal An interrupt signal sent to the host system.

Capture A method used in TTWin, of copying to disk any incoming and outgoing information from the 
remote host.

Certificate Express Logon Also referred to as Express Logon Feature or ELF. Enables secure logon to 
hosts via tn3270e and SSL with certificates alone.

Certificate File refer to TCF File

Client Any node in a networking environment that initiates a request for a network service.

CR A carriage return (CR) is a control character used to move the cursor position to the start of a line. Often 
used in conjunction with a line feed (LF). 

DDE (Dynamic Data Exchange) A form of interprocess communication that uses shared memory to 
exchange data between applications.

DBCS Stands for Double Byte Character Set, using two-byte (16-bit) characters rather one byte (8-bit). 
Typically used to handle languages such as Japanese, Korean and Chinese.

Dialog box A window in a graphical user interface which requests information from the user. In this manual 
dialog boxes are referred to as tiles.

ELF Express Logon Feature. Enables secure logon to hosts via tn3270e and SSL with certificates alone.

Emulation When used in relation to TTWin, a program that causes the personal computer to act as if it were a 
particular terminal.

Field A defined data area.



FIPS Federal Information Processing Standard. FIPS-140-2 is a United States Government standard of crypto-
graphic accreditation. This standard applies to TTWin's SSH communications module.

Flow control A technique for ensuring that the transmitting device, such as a modem, does not overload the 
receiving device with data. This is also known as pacing.

Function keys A special set of keys which are typically labelled F1, F2 etc. on the keyboard.

GUI (Graphical User Interface) A user environment that uses icons, buttons, windows and pointers etc.

HLLAPI IBM 3270 High Level Language API.

HPNS Hewlett Packard Network Services, see also NS/VT.

Host Machine on which applications are executed. A host may be the local machine or the remote machine 
connected to via Serial Communication, TCP/IP, etc.

IRMA board The IRMA board was an early hardware card for PC's designed to provide 3270 host connectiv-
ity and emulation.

IP number A 32-bit (IPv4) or 128-bit (IPv6) address assigned to hosts using TCP/IP. This consists of a net-
work and host code. The host port is signified by an integer and is used to identify destinations within the host, 
e.g., the port reserved for electronic mail.

LAN Local Area Network.

LF A line feed (LF) is a control character used to indicate a new line. Often used in conjunction with a car-
riage return (CR) . 

Login The action by which you gain access to and establish your identity to a remote host.

Node Any device including servers and workstations that are connected to a network.

NS/VT Network Services / Virtual Terminal. A proprietary communications protocol developed by Hewlett 
Packard.

Predefined session A session defined within TTWin. See Session.

Remote host The machine which you are communicating with, via your TTWin emulation software.

RS232 A standard used for many serial interfaces. This standard was devised many years ago and many parts of 
it are not used in modern modem equipment. This has led to many different implementations of the standard.

Serial number A unique number allocated to each copy of TTWin software produced by Turbosoft.

Serial port A communications port, generally referred to as COM number. See also communications port.

Session A combination of one emulation and one communications protocol is called a session.

Shift state A sequence of simultaneous keystrokes, combining the selected PC key with any of the [SHIFT], 
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[ALT] and [CTRL] keys, to generate a unique combination. For example, [CTRL_ALT_F4].

SBCS (Single Byte Character Set) Character sets which use exactly one byte for each character. See also 
DBCS.

SSH (Secure Shell) A communications protocol that allows secure transmission of data.

SSL (Secure Sockets Layer) A protocol that provides security for communications over networks.

Telnet A protocol for providing terminal facilities using TCP/IP across a network.

Tile TTWin terminology for what is commonly known in Windows as a dialog box.

TCF file A TTWin Certificate File contain unique licensing information.

TWC file A TTWin Configuration File, storing session configuration options.

X.25 A serial base network communications protocol used for wide area networks.



Appendix B 

Support 
If you have a support question or issue you need assistance with, we recommend firstly checking the sup-
port section of our website (www.ttwin.com) for up to date downloads and documentation. We suggest these 
resources be your first stop as they provide quick answers to many common queries. 

If you are still unable to resolve your issue please feel free to contact Turbosoft's support staff. Full support is 
extended to the holders of maintenance contracts and to those users operating TTWin under an evaluation 
license. To raise an issue with Turbosoft support please visit https://www.ttwin.com/support and fill out an issue 
form.

When describing your issue be sure to include information on the exact version of the Turbosoft product 
you're are using. This information can be obtained by selecting Help > About... > Version from the program 
menu. See Chapter 8 for more information.

https://www.ttwin.com
http://www.ttwin.com/support
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Appendix C  

TTWin 4 File Types and Paths
The following table contains a list of file types used by TTWin. Of these files, those stored in the user config 
directory remain after uninstallation. Any files created as part of the original installation and located in the 
global config directory are deleted as part of the TTWin uninstall process. Any files created after and outside of 
the install process in the global config directory will not be deleted as part of the uninstall process.

With the exception of ttwin.ini which exists solely in a global config directory each of the file types listed 
below can exist in either the user or global config or both.

For more information on user and global config locations under various operating systems refer to the tables 
on the following pages.

File Description

*.cmp Character Map file. Stores language and character translation configuration.

*.clr Color configuration settings.

*.hsp Hotspot data.

*.key Keyboard Mapping data.

*.mnu Menu and Toolbar configuration

*.tcf TTWin Certificate File. Licensing information.

*.tsl TTWin Basic script file.

*.twc TTWin configuration file. Session based configuration data.

layout.ini View menu settings and window positioning.

scripts.ini A list of .tsl files displayed in scripts list. There are two scripts.ini 
files. One for the global scripts and another for user's scripts.

ttwin.ini Program wide configuration settings.



The location of program and configuration files used by TTWin varies depending on the user's operating sys-
tem.  The files used by TTWin can be broken down as follows, where {user} is replaced with the login users 
name.

File Category Typical Folder Location

Programs C:\Program Files\Turbosoft\TTWin4

Global config C:\ProgramData\Turbosoft\TTWin4

User config (roaming) C:\Users\{User}\AppData\Roaming\Turbosoft\TTWin4

User config (non-roaming) C:\Users\{User}\AppData\Local\Turbosoft\TTWin4

Locating Files in an Installation

To determine the config file locations for a specific installation, following these steps:

1	Locate TTWIN.INI. Examine the shortcut used to launch TTWin. The optional command argument -i 
{IniPathName} can be used to specify the exact full path name for TTWIN.INI. 

If there is no -i argument then ttwin.ini will be in the 'Global config' directory. 

1	Examine TTWIN.INI to determine the locations of the remaining files. In the [ConfigDirs] section 
you will find:

GlobalConfigDir=

UserConfigDir=

UserLocalConfigDir=

relating to the folder categories listed earlier. If any of these are missing or blank then the 'typical folder' listed 
in the prior tables is used.
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Pathname Macros

Pathnames entered into configuration files can optionally use pathname macros. These macros are expanded at 
program load time and allow for greater flexibility in custom installations.

For example, in TTWIN.INI the global config directory could be specified as a full path

GlobalConfigDir=f:\TTWin4\config

or as a macro

GlobalConfigDir=%RoamingAppData%\TTWin4\config

Other examples:

HelpDir=%GlobalConfigDir%\help

UserScriptsDir=%UserConfigDir%\Scripts



Appendix D

Sample Scripts
The following sample scripts are included in the standard TTWin 4 installation and can be accessed by select-
ing Scripts > Run/Edit from the program menu.

Login.bas - Sample Login Script

This sample script will connect to the configured host and present the user with a dialog box prompting for 
user and password details before sending this data to the host system. This script is suitable for use with the 
Telnet protocol.

IBM-Login.bas - Sample Login Script with ELF

A sample login script for IBM 3270 and 5250 emulations. To use this script with ELF the script variable 
UseELF needs to be set to 1. If you enable ELF the standard username and passwords are replaced with the 
ELF UserName and Password variables as shown below in Figure A1 . When using ELF you may also need 
to change the 'logon' portion of the UserName variable depending on what your host expects.

'This script is a sample login script for IBM 3270 & 5250 emulations.

'You will need to configure the login details below to suit your host.

Option Explicit

Dim UserName As String

Dim Password As String

Dim LoginScreenText As String

Dim LoginScreenTextRow As Long

Dim LoginScreenTextCol As Long

Dim PasswordScreenText As String

Dim PasswordScreenTextRow As Long

Dim PasswordScreenTextCol As Long

Dim UserNameRow As Long

Dim UserNameCol As Long

Dim PasswordRow As Long

Dim PasswordCol As Long

Dim PostScreenText As String

Dim PostScreenTextRow As Long

Dim PostScreenTextCol As Long

Dim Count As Long

Dim Result As Long

Dim Failed As Boolean

Dim DebugMsg As Boolean

Dim UseELF As Boolean

Dim UsePasswordScreen As Boolean
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Sub Main

	'*****************************************************************

	'***************** Enter your login details here *****************

	'*****************************************************************

	'Enter User name and password

	UserName="username"

	Password="userpassword"

	'If you are using IBM3270 ELF set UseELF=True and set your login command »

	UseELF=False

	If UseELF Then

	  UserName="logon )USR.ID("

	  Password=")PSS.WD("

	 End If

	'Enter a unique text that identifies the login screen, along with the Row » 
& Col of the first character

	LoginScreenText="USERID"

	LoginScreenTextRow=20

	LoginScreenTextCol=2

	'Enter the Row & Col for the start of the UserName field

	UserNameRow=20

	UserNameCol=16

	'If the password is on next screen set UsePasswordScreen=True and set » 
password screen text

	UsePasswordScreen=False

	'Enter a unique text that identifies the Password screen, along with »   
the Row & Col of the first character

	PasswordScreenText="PASSWORD"

	PasswordScreenTextRow=21

	PasswordScreenTextCol=2

	'Enter the Row & Col for the start of the Password field

	PasswordRow=21

	PasswordCol=16

	'Enter a unique text that identifies the post login screen, along with » 
the Row & Col of the first character

	PostScreenText="WELCOME"

	PostScreenTextRow=7

	PostScreenTextCol=7



	'Setting debug to true will display additional error messages for a » 
failed login.

	'This can help when first setting up to identify the first point of »  
failure.

	DebugMsg = True

	'*****************************************************************

	'************************ End user config ************************

	'*****************************************************************

	Failed = True

	' Make sure we are connected

	If Not TTWin.IsConnected Then

	 TTWin.DispClear(1)

	 TTWin.CommConnect

	 End If

	Count = 0

	'Wait for slow connections

	While Not TTWin.IsConnected And Count < 6

	  Wait 2

	  Count = Count + 1

	 Wend

	If TTWin.IsConnected Then

	  'Check for login screen, CheckScreen(scrText,Row,Col)

	  Result = CheckScreen(LoginScreenText,LoginScreenTextRow,» 
LoginScreenTextCol)

	  If Result Then

	    If UseELF Then TTWin.ELFLogon ""

	    'Make sure the cursor is at the correct location for user name

	    Result = TTWin.EmSetCursorPos(UserNameRow,UserNameCol)

	    Wait 0.1

	    If Result = 0 Then

	      If UsePasswordScreen Then

	        TTWin.KbdMacro UserName+"{Enter}"

	        'Check for password screen, CheckScreen(scrText,Row,Col)

	        Result = 
CheckScreen(PasswordScreenText,PasswordScreenTextRow,PasswordScreenTextCol)

	        If Not Result Then

	          If DebugMsg Then MsgBox "Password screen didn't display"

	          GoTo Quit

	        End If

	      Else

	        TTWin.KbdMacro UserName+"{Return}"

	      End If

	      'Make sure the cursor is at the correct location for password, » 
SetCursor(Row,Col)

	      Wait 0.1
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	      Result = TTWin.EmSetCursorPos(PasswordRow,PasswordCol)

	      If Result = 0 Then

	        TTWin.KbdMacro Password+"{Enter}"

	        'Check for successful login, CheckScreen(scrText,Row,Col)

	        Result = CheckScreen(PostScreenText,PostScreenTextRow, » 
PostScreenTextCol)

	        If Result Then

	          Failed = False

	        Else

	          If DebugMsg Then MsgBox "Post login screen didn't display"

	        End If

	      Else

	        If DebugMsg Then MsgBox "Could not set cursor to start of »   
password field"

	      End If

	    Else

	      If DebugMsg Then MsgBox "Could not set cursor to start of user field"

	    End If

	   Else

	    If DebugMsg Then MsgBox "Could not find sign in screen"

	  End If

	 End If

	 Quit:

	If Failed Then MsgBox "Login failed"

End Sub

Function CheckScreen(screen As String, Row As Integer, Col As Integer) »  
As Integer

  Dim scrText As String

  Dim Length As Integer

  Length = Len(screen)

  Count=0

  CheckScreen=0

  Do

    TTWin.DispReadText  Row-1,Col-1,scrText,Length

     Wait 0.1

    Count=Count+1

  Loop Until scrText=screen Or Count=100

  If scrText=screen Then CheckScreen=1

End Function

Figure A1 IBM-Login.bas source

Operation
The script will connect to the configured host and wait for the login screen to display, before setting the cursor 
to  the beginning of the User ID field. It will then enter the user details and move the cursor to the Password 
field. It then enters the password and returns the data to the host.



As a final check to confirm that login was successful, it then checks for the post login screen. If any of the 
above steps fail the user receives an error message.

Setting the debug variable in the script to True will give more detail of the step that failed.

There is also an option to configure a Password screen, this is only used if your password is on the next 
screen. When this option is selected the user login is entered and transmitted to the host, the script then checks 
for the next screen before continuing.

This script contains an option to use ELF (Express Login Feature) for IBM hosts. To use this option you must 
first configure the TTWin communications setting to use ELF (refer to Chapter 17 - Communications). 

The script initially looks for something that uniquely identifies the login page. The example shown in Figure 
A2 uses “USERID” to determine this. In the screen shot below this is located at Row 20, Column 2.

Next the script sets the coordinates for the beginning of the UserID field. In Figure A2 the cursor is at this 
position as noted in the co-ordinates listed in the program status bar: Row 20, Column 16. 

The Password field is one row down at, Row 21, Column 16.

Figure A2 - Sample login screen.

To confirm a successful login, the script checks that the next or post login screen is displayed. In Figure A3 the 
“cicsv” string is found at Row 7, Col 7.

At this point the script could be extended to execute the command to go into the menu system or to handle a 
failed login.
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Figure A3 - Post login screen.

Recvfile.bas - Sample File Transfer Script (receive)

This script is intended for use with XModem, YModem, ZModem and Kermit file transfer protocols. It 
prompts the user for a remote filename and a name to save that file to locally. The script with then attempt to 
download the named file from the host using the currently selected file transfer settings. Note that the script 
expects the host connection to be established prior to it's execution.  For information on selecting and config-
uring File Transfer Protocols refer to Chapter 19 - File Transfer.

Sendfile.bas - Sample File Transfer Script (send)

This script is intended for use with XModem, YModem, ZModem and Kermit file transfer protocols and per-
forms the reverse operation of the Recvfile.bas script. The user is prompted for a local file name and a 
name which it will write that file to on the remote host.  Note that the script expects the host connection to be 
established prior to it's execution. For information on selecting and configuring File Transfer Protocols refer to 
Chapter 19 - File Transfer.  



Appendix E

APIs and External Controls
TTWin provides a number of application programming interfaces which enable control of TTWin and its data 
stream. This appendix briefly covers each API as full details and specifications are beyond the scope of this user 
manual. For more information please contact your Turbosoft representative or seek further documentation 
available from our website, www.ttwin.com.

ActiveX (OCX)

TTWin 4's ActiveX control offers full control over TTWin 4 and the host data stream. ActiveX controls are 
available in native 32 bit and 64 bit versions.

If you are evaluating a demonstration copy of TTWin 4 the ActiveX control will be limited to a maximum of 
four (4) concurrent sessions.

Dynamic Data Exchange (DDE)

Although largely superseded as a technology, a DDE interface is supported in TTWin.

HLLAPI

High Level Language Application Programming Interface (HLLAPI) is used to provide access to terminal ses-
sions, particularly IBM 3270 and 5250 sessions. 

The dynamic link libraries for HLLAPI are located in the TTWin program directory; HLLAPI32.DLL for the 
32 bit version of TTWin and HLLAPI64.DLL for the 64 bit version. Refer to Appendix C for information on 
program directory locations.

The following functions are supported by TTWin 4.

Function Number Symbolic Name

Connect Presentation Space 1 HLL_CONNECTPS 

Disconnect Presentation Space 2 HLL_DISCONNECTPS 

Send Key 3 HLL_SENDKEY

Wait 4 HLL_WAIT 

Copy Presentation Space 5 HLL_COPYPS

Search Presentation Space 6 HLL_SEARCHPS

Query Cursor Location 7 HLL_QUERYCURSORLOC 

https://www.ttwin.com
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Function Number Symbolic Name

Copy Presentation Space to String 8 HLL_COPYPSTOSTR

Set Session Parameters 9 HLL_SETSESSIONPARAMETERS

Query Sessions 10 HLL_QUERYSESSIONS

Reserve 11 HLL_RESERVE  

Release 12 HLL_RELEASE 

Copy OIA 13 HLL_COPYOIA  

Query Field Attribute 14 HLL_QUERYFIELDATTRIBUTE

Copy String to Presentation Space 15 HLL_COPYSTRTOPS

Pause 18 HLL_PAUSE    

Query System 20 HLL_QUERYSYSTEM 

Reset System 21 HLL_RESETSYSTEM 

Query Session Status 22 HLL_QUERYSESSIONSTATUS

Start Host Notification 23 HLL_STARTHOSTNOTIFICATION

Query Host Update 24 HLL_QUERYHOSTUPDATE

Stop Host Notification 25 HLL_STOPHOSTNOTIFICATION

Search Field 30 HLL_SEARCHFIELD  

Find Field Position 31 HLL_FINDFIELDPOSITION

Find Field Length 32 HLL_FINDFIELDLENGTH

Copy String to Field 33 HLL_COPYSTRINGTOFIELD

Copy Field to String 34 HLL_COPYFIELDTOSTRING 

Display Cursor 37 HLL_DISPLAYCURSOR

Set Cursor 40 HLL_SETCURSOR  

Start Close Intercept 41 HLL_STARTCLOSEINTERCEPT

Query Close Intercept 42 HLL_QUERYCLOSEINTERCEPT



Function Number Symbolic Name

Stop Close Intercept 43 HLL_STOPCLOSEINTERCEPT 

Start Keystroke Intercept 50 HLL_STARTKSINTERCEPT

Get Key 51 HLL_GETKEY     

Post Intercept Status 52 HLL_POSTINTERCEPTSTATUS 

Stop Key Stroke Intercept 53 HLL_STOPKSINTERCEPT  

Send File 90 HLL_SENDFILE

Receive File 91 HLL_RECEIVEFILE 

Convert Position or Convert RowCol 99 HLL_CONVERT 

Connect Window Services 101 HLL_CONNECTWINDOWSERVICES

Disconnect Window Service 102 HLL_DISCONNECTWINDOWSERVICES

Query Window Coordinates 103 HLL_QUERYWINDOWCOORDINATES

Window Status 104 HLL_WINDOWSTATUS 

Change PS Window Name 106 HLL_CHANGEPSNAME  

Emkeys 200 HLL_EMKEYS   

Java API

TTWins Java Host-Console-Control API contains a number of controls which allows a Java Applet to manage 
and control a Host Terminal Window (a running instance of TTWin). The API provides methods that initi-
ate and monitor connection events, manipulate text, perform searches, send keystrokes, provide notification 
events, access terminal fields and more.

The Java Host-Console-Control API is not included in the standard installation of TTWin. Please contact a 
Turbosoft representative for further information and to request evaluation versions of Java enabled TTWin.
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